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Notice 26 

While reasonable efforts have been made to ensure that the information in this 27 
document is complete and accurate at the time of printing, Avaya assumes no 28 
liability for any errors. Avaya reserves the right to make changes and 29 
corrections to the information in this document without the obligation to notify 30 
any person or organization of such changes. 31 

Documentation disclaimer 32 

“Documentation” means information published by Avaya in varying mediums 33 
which may include product information, operating instructions and performance 34 
specifications that Avaya generally makes available to users of its products. 35 
Documentation does not include marketing materials. Avaya shall not be 36 
responsible for any modifications, additions, or deletions to the original 37 
published version of documentation unless such modifications, additions, or 38 
deletions were performed by Avaya. End User agrees to indemnify and hold 39 
harmless Avaya, Avaya's agents, servants and employees against all claims, 40 
lawsuits, demands and judgments arising out of, or in connection with, 41 
subsequent modifications, additions or deletions to this documentation, to the 42 
extent made by End User. 43 

Link disclaimer 44 

Avaya is not responsible for the contents or reliability of any linked websites 45 
referenced within this site or documentation provided by Avaya. Avaya is not 46 
responsible for the accuracy of any information, statement or content provided 47 
on these sites and does not necessarily endorse the products, services, or 48 
information described or offered within them. Avaya does not guarantee that 49 
these links will work all the time and has no control over the availability of the 50 
linked pages. 51 

Warranty 52 

Avaya provides a limited warranty on its hardware and Software (“Product(s)”). 53 
Refer to your sales agreement to establish the terms of the limited warranty. In 54 
addition, Avaya’s standard warranty language, as well as information regarding 55 
support for this Product while under warranty is available to Avaya customers 56 
and other parties through the Avaya Support website: http://support.avaya.com 57 

Please note that if you acquired the Product(s) from an authorized Avaya 58 
reseller outside of the United States and Canada, the warranty is provided to 59 
you by said Avaya reseller and not by Avaya. “Software” means computer 60 
programs in object code, provided by Avaya or an Avaya Channel Partner, 61 
whether as stand-alone products or pre-installed on hardware products, and any 62 
upgrades, updates, bug fixes, or modified versions thereto. 63 

Licenses 64 

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA 65 
WEBSITE, http://support.avaya.com/LicenseInfo/ ARE APPLICABLE TO 66 
ANYONE WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA 67 
SOFTWARE, PURCHASED FROM AVAYA INC., ANY AVAYA 68 
AFFILIATE, OR AN AUTHORIZED AVAYA RESELLER (AS 69 
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH AVAYA 70 
OR AN AUTHORIZED AVAYA RESELLER. UNLESS OTHERWISE 71 
AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND 72 
THIS LICENSE IF THE SOFTWARE WAS OBTAINED FROM ANYONE 73 
OTHER THAN AVAYA, AN AVAYA AFFILIATE OR AN AVAYA 74 
AUTHORIZED RESELLER; AVAYA RESERVES THE RIGHT TO TAKE 75 
LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING OR 76 
SELLING THE SOFTWARE WITHOUT A LICENSE. BY INSTALLING, 77 
DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING 78 
OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE 79 
ENTITY FOR WHOM YOU ARE INSTALLING, DOWNLOADING OR 80 

USING THE SOFTWARE (HEREINAFTER REFERRED TO 81 
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO 82 
THESE TERMS AND CONDITIONS AND CREATE A BINDING 83 
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE APPLICABLE 84 
AVAYA AFFILIATE ( “AVAYA”). 85 

Avaya grants you a license within the scope of the license types described 86 
below, with the exception of Heritage Nortel Software, for which the scope of 87 
the license is detailed below. Where the order documentation does not expressly 88 
identify a license type, the applicable license will be a Designated System 89 
License. The applicable number of licenses and units of capacity for which the 90 
license is granted will be one (1), unless a different number of licenses or units 91 
of capacity is specified in the documentation or other materials available to you. 92 
“Designated Processor” means a single stand-alone computing device. “Server” 93 
means a Designated Processor that hosts a software application to be accessed 94 
by multiple users. 95 

License type(s) 96 

Designated System(s) License (DS). End User may install and use each 97 
copy of the Software only on a number of Designated Processors up to the 98 
number indicated in the order. Avaya may require the Designated Processor(s) 99 
to be identified in the order by type, serial number, feature key, location or 100 
other specific designation, or to be provided by End User to Avaya through 101 
electronic means established by Avaya specifically for this purpose. 102 

Concurrent User License (CU). End User may install and use the Software 103 
on multiple Designated Processors or one or more servers, so long as only the 104 
licensed number of Units are accessing and using the Software at any given 105 
time. A “Unit” means the unit on which Avaya, at its sole discretion, bases the 106 
pricing of its licenses and can be, without limitation, an agent, port or user, an 107 
e-mail or voice mail account in the name of a person or corporate function (e.g., 108 
webmaster or helpdesk), or a directory entry in the administrative database 109 
utilized by the Software that permits one user to interface with the Software. 110 
Units may be linked to a specific, identified Server. 111 

Heritage Nortel Software 112 

“Heritage Nortel Software” means the software that was acquired by Avaya as 113 
part of its purchase of the Nortel Enterprise Solutions Business in December 114 
2009. The Heritage Nortel Software currently available for license from Avaya 115 
is the software contained within the list of Heritage Nortel Products located at 116 
http://support.avaya.com/LicenseInfo/ under the link “Heritage Nortel 117 
Products”. For Heritage Nortel Software, Avaya grants Customer a license to 118 
use Heritage Nortel Software provided hereunder solely to the extent of the 119 
authorized activation or authorized usage level, solely for the purpose specified 120 
in the Documentation, and solely as embedded in, for execution on, or (in the 121 
event the applicable Documentation permits installation on non-Avaya 122 
equipment) for communication with Avaya equipment. Charges for Heritage 123 
Nortel Software may be based on extent of activation or use authorized as 124 
specified in an order or invoice. 125 

Copyright 126 

Except where expressly stated otherwise, no use should be made of materials on 127 
this site, the Documentation, Software, or hardware provided by Avaya. All 128 
content on this site, the documentation and the Product provided by Avaya 129 
including the selection, arrangement and design of the content is owned either 130 
by Avaya or its licensors and is protected by copyright and other intellectual 131 
property laws including the sui generis rights relating to the protection of 132 
databases. You may not modify, copy, reproduce, republish, upload, post, 133 
transmit or distribute in any way any content, in whole or in part, including any 134 
code and software unless expressly authorized by Avaya. Unauthorized 135 
reproduction, transmission, dissemination, storage, and or use without the 136 
express written consent of Avaya can be a criminal, as well as a civil offense 137 
under the applicable law 138 

. 139 

 140 

 141 

Preventing Toll Fraud 142 "Toll fraud" is the unauthorized use of your telecommunications system by an 143 
unauthorized party (for example, a person who is not a corporate employee, 144 
agent, subcontractor, or is not working on your company's behalf). Be aware 145 

http://support.avaya.com/


  

that there can be a risk of Toll Fraud associated with your system and that, if 146 
Toll Fraud occurs, it can result in substantial additional charges for your 147 
telecommunications services. 148 

Avaya Toll Fraud intervention 149 

If you suspect that you are being victimized by Toll Fraud and you need 150 
technical assistance or support, call Technical Service Center Toll Fraud 151 
Intervention Hotline at +1-800-643-2353 for the United States and Canada. For 152 
additional support telephone numbers, see the Avaya Support website:  153 
http://support.avaya.com. Suspected security vulnerabilities with Avaya 154 
products should be reported to Avaya by sending mail to: 155 
securityalerts@avaya.com. 156 

Trademarks 157 

The trademarks, logos and service marks (“Marks”) displayed in this site, the 158 
Documentation and Product(s) provided by Avaya are the registered or 159 
unregistered Marks of Avaya, its affiliates, or other third parties. Users are not 160 
permitted to use such Marks without prior written consent from Avaya or such 161 
third party which may own the Mark. Nothing contained in this site, the 162 
Documentation and Product(s) should be construed as granting, by implication, 163 

estoppel, or otherwise, any license or right in and to the Marks without the 164 
express written permission of Avaya or the applicable third party. 165 

Avaya is a registered trademark of Avaya Inc. 166 

All non-Avaya trademarks are the property of their respective owners, and 167 
“Linux” is a registered trademark of Linus Torvalds. 168 

All other trademarks are the property of their respective owners. 169 

Downloading documents 170 

For the most current versions of documentation, see the Avaya Support website: 171 

 http://support.avaya.com 172 

Contact Avaya Support 173 

See the Avaya Support website: http://support.avaya.com for product notices 174 
and articles, or to report a problem with your Avaya product 175 

For a list of support telephone numbers and contact addresses, go to the Avaya 176 
Support website: http://support.avaya.com, scroll to the bottom of the page, and 177 
select Contact Avaya Support 178 

 179 

 180 

 181 

 182 

 183 
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Introduction 261 

The Avaya Interaction Center 7.3.2 Release Notes provides information on installation, configuration, and 262 
uninstallation. 263 

This document provides the latest information to supplement Interaction Center software and documentation. 264 
For updated documentation, product support notices, and service pack information, visit the Avaya Support 265 
Center website at http://support.avaya.com. 266 

http://support.avaya.com/
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Overview 267 

The Avaya Interaction Center (IC) software updates are distributed in service packs. The Avaya Interaction 268 
Center (IC) 7.3.2 Feature Pack (IC Scripts customization merges) is the second release on top of IC 7.3. 269 
This FP is cumulative release which also includes all the fixes from IC 7.3.1 Service Pack. These software 270 
updates correct issues and add features not included in the original release of the IC 7.3 system. 271 

Avaya recommends that all IC 7.3 customers update to the 7.3.2 FP level to ensure you have a complete set 272 
of fixes. IC 7.3.2 does not include a redelivery of the entire IC product. The IC 7.3.2 FP can be installed on IC 273 
7.3. Follow the instructions in the Release Notes when installing and configuring the IC 7.3.2 Service Pack. 274 
Information, such as known defects and defects fixed in this release, and solutions for some known issues, 275 
which may not necessarily be included in the standard IC 7.3 documentation, are included in a separate 276 
document named List of Fixed Issues, Improvements, Known Issues, and Troubleshooting for Avaya 277 
Interaction Center 7.3. Similarly, the files shipped with SPs and their versions are included in the document 278 
titled: FP file list with modification time stamp and version numbers for Avaya Interaction Center 7.3. All these 279 
documents are available for download at http://support.avaya.com. 280 

The existing features in IC 7.3 continue to be in use, unless mentioned otherwise in the Release Notes. 281 

Refer to the section, Product Support Information, in this Release Notes for information that was published as 282 
PSNs. 283 

The Release Notes provides detailed installation and configuration information. The Installation Tool provided 284 
with this FP easily installs all the fixes in the IC 7.3.2 FP. 285 

For additional IC 7.3 documentation information, refer to: 286 

 Interaction Center (IC) 7.3 Product Documentation 287 

 Interaction Center (IC) 7.3 Release Notes 288 

 Avaya IC for Siebel 7 and 8 Integration Guide 289 

Supported new features and configurations 290 

IC supports the following software features and configurations: 291 

Feature/Configurations IC 7.3 IC 7.3.1 IC 7.3.2 

HTML Editor Replacement for Rich 
Client. 

Time in Email Template enhanced to 
support 24-hour or 12-hour format. 

Support for Siebel 7.8.2.13. 

SNMP-MIB Enhancement for different 
OIDs in Traps based on priority. 

Ability to enter Email display name in IC 
Manager. 

http://support.avaya.com/
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Feature/Configurations IC 7.3 IC 7.3.1 IC 7.3.2 

Options to set column width, size and 
location of chat task list in IC agent. 

Service Class OWT data in OA reports. 

Workflow Server enhanced to handle 
large number of Workflow channel 
assignments. 

Chat Typing Status Support. 

Workflow Server Modification for 
Dynamic Queue Contact Entry. 

Synchronization between Siebel toolbar 
and Hard phone. 

WebAdmin Page Cancel Task with 
Specified Status. 

TSA Server enhanced for Extended UUI 
Data Support. 

Support for IE8 on AAWC. 

Restrict the retries by WACD on 
requesting the WAA to qualify a task 
when no agent is logged into IC. 

Enhanced ASIS to read IC group 
properties without restart. 

Adding UUID and ALIAS of TS in EDU 
for IVR application. 

HttpVOX and VOX support 
TS.TransferEX method. 

VOX Server to handle extension 
numbers in excess of 2^31. 

Monitoring IVR extension using *v 
assignment. 

Indication by WACD about invalid email 
requalification attempts. 
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Feature/Configurations IC 7.3 IC 7.3.1 IC 7.3.2 

Disable 'Ready/NotReady' button if agent 
has not logged into any channel for IC-
Siebel. 

LDAP integration with Avaya Interaction 
Center. 

SSL Enabled communication between 
HTTPConnector Server and Dialog 
Designer 5.1. 

Windows 7 support for Avaya Agents and 
Admin. 

Deploying Avaya Rich Client on Citrix 
XenApp 6.0 on Windows 2008 R2. 

Performance gains in SDK WebServices 
using DS Authentication-Only API over 
full DS Login. 

Support for Microsoft Windows 2008 
Server R2 (x64) (Enterprise Edition*)**. 

Support for Microsoft SQL Server 2008 
(v10.50.1600.1*)**. 

Support for hosting IC website using IIS 
7.0 on Windows 2008 R2. 

Support for hosting IC website using IBM 
HTTP Server 7.x on AIX 6.1. 

Support for deployment of IC on VMWare 
4.0. 

Oracle Database 11g Client Release 
11.2.0.1.0*. 

Added Hyperlink button in the HTML 
toolbar for HTML Editor (only) in Rich 
Client. 

Windows 7, 32-bit Support. 

Windows 7, 64-bit Support**. 
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Feature/Configurations IC 7.3 IC 7.3.1 IC 7.3.2 

Siebel CRM 8.1.1.x support. 

Support for Oracle Database Client 
Release 11.0.2.1.0 on Windows 2008, 
64-bit. 

Web chat UI and API 

Security Enhancements  

LDAP authentication support for Admin 
Website and RL Manager 

 

Selective download of Templates based 
on Admin configuration  

Secured authentication using ASG 
(Access Security Gateway) 

IE 9/10 Support for AAWC, AARC and 
admin components  

 

JRE and Tomcat Upgrade 

JRE: 

Windows/Solaris: 1.6.0_10 to 1.6.0_45 

AIX: 1.6.0 SR3 to 1.6.0 SR15 

Tomcat: 6.0.14 to 6.0.37  

 

SIP end point support 

WebLM 6.3.4 Upgrade  

Ephox Html Editor upgrade 

Editor Editlive is upgraded from 7.5.2.106 
to 9.0.0.98 

Enhanced Email Migration Tool*** 

Password encryption when login request 
is sent to RL Manager 

Support for adding multiple attachments 
into an email  
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Feature/Configurations IC 7.3 IC 7.3.1 IC 7.3.2 

Reporting provision for RONA exit 
reason: 

For RONAed calls exit_reason field in the 
routingevent table(repository database) is 
populated with the value 'rona' 

Configuration for the Aux rona reason 
code. 

Automatic public chat disconnect when 
caller inactivity crosses the disconnect 
interval set in ICM 

* Product has been tested with the specified minor versions. 292 

** There are limitations in using Advocate Admin and Workflow Designer. Refer to the Known Issues section. 293 

*** IC 7.3.2 FP obsoletes PSN004146 294 

Features not supported 295 

 Same Time Feature 296 

The Same Time feature from Webagent is no longer supported from IC 7.3 release.  297 

Note: The Web agent's toolbar shows the Same Time button but the button does not work as the 298 
functionality is not supported. 299 

 Using Drop button on Hard phone 300 

CM does not support using the Drop button on the hard phone for releasing a contact. Agents must use 301 
the Release button for releasing the contact. The purpose of the Drop button is to drop the last party 302 
added to the conference. Using the Drop button on the hard phone for releasing a call with only two 303 
parties involved might lead to unpredictable behavior in IC. 304 

IC Agents must use soft phone buttons to perform call operations. 305 

Web browsers tested in IC 7.3.2 Feature Pack  306 

Avaya IC includes support for several Web browsers for End-Customer Chat Escalations in IC 7.3.x Service 307 
Pack. The following list includes latest browser versions tested at the time of release of this FP: 308 

Web browser 

Chrome 33 

Safari 7.0.2  

Opera 20  

Mozilla Firefox 28 
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Web browser 

Microsoft Internet Explorer 8, 9 and 10 

Important: Internet Voice (IV) Chat and Collaboration features are supported in Microsoft Internet Explorer 309 
only. 310 

IC 7.3.x interoperability with OA 7.3.x 311 

 OA 7.3 OA 7.3.1 OA 7.3.2 

IC 7.3  
IC 7.3.1 

IC 7.3.2 

 312 

Note: For information about the OA 7.3.2 release, see the Operational Analyst 7.3.2 Release Notes. 313 

IC 7.3.x interoperability with Communication 314 

Manager and AES 315 

This section describes the compatibility of IC 7.3.2 with Communication Manager and AES versions. 316 

Communication Manager Compatibility matrix: 317 

Communication Manager / 

Avaya Aura® Communication Manager 

Telephony Server running on the operating system 

5.x, 6.0, 6.2 and 6.3 Windows 2008 R2, Solaris 10 and AIX 6.1 

Communication Manager / 

Avaya Aura® Communication Manager 

Telephony Server running on the operating system 

5.x, 6.0, 6.2 and 6.3 Windows 2008 R2, Solaris 10 and AIX 6.1 

 318 

Avaya Application Enablement Services (AES) / Avaya Aura® AES compatibility matrix: 319 

AES 6.1 with CVLAN client 6.1 on Windows 2008 R2 

AES 6.1 with CVLAN client 3.1 on Solaris and AIX 

Certified 
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AES 6.2 with CVLAN client 6.2 on Windows 2008 R2 

AES 6.2 with CVLAN client 3.1 on Solaris and AIX 

Certified 

AES 6.3 with CVLAN client 6.3 on Windows 2008 R2 

AES 6.3 with CVLAN client 3.1 on Solaris and AIX 

Certified 

Feature comparison of Avaya Agent Clients 320 

The following table shows the feature comparisons between various Agent clients supported by IC 7.3.x: 321 

Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Voice Answer 

Blind Transfer 

Consult 

Conference 

Hold/Reconnect 

Wrap 

 Transfer to Virtual 
Queue 

Switch to caller 

Transfer to Agent 

Email Reply / Reply All 

Forward 

Defer 

Use local/global 
resource for 
responses 

Dismiss 

Transfer to Agent 
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Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Transfer to Virtual 
Queue 

*

Wrapup Codes 

HTML Editor 
HyperLink toolbar 
button 

Ability to download 
and use pre-
configured email 
templates  

Chat Answer 

Transfer to Agent 

Conference 

Wrap 

Co-browse 

Emoticons 

Chat Typing status 

Join Us     

Transfer to Virtual 
Queue 

Contact History View 

Filter 

Supervisor Monitor/Un-Monitor 

                                                      

*
 This feature is supported for Avaya Siebel Native Client. However, it has been tested only on IC BA 
(Business Advocate) setup on Windows. 
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Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Visible / Invisible 

Multimedia 
Support 

 

Selective After 
Call Work 

 

Product updates and patches 322 

For the latest list of all the product updates and patches, visit the Avaya Support Web site 323 
http://support.avaya.com. 324 

You can download the latest patches and installation instructions. 325 

IC 7.3.2 Feature Pack installation and configuration 326 

guidelines 327 

Perform the following steps to install IC 7.3.2: 328 

Note: Skip the steps that are not applicable to your IC environment. 329 

1. Ensure your system conforms to the prerequisites (Refer to Prerequisite guide of IC 7.3). 330 

2. Ensure that you have a 7.3 License Key before proceeding. 331 

3. Ensure that you have received all the installation files for the IC components included in the IC 7.3.2 332 
FP. 333 

4. Explore the installation options for installing the IC 7.3.2 FP. 334 

5. Logout agents and stop all IC clients. 335 

6. Stop IC servers, IC services, and Administration and Design. 336 

7. Install IC Servers. 337 

8. Install the Siebel Integration Component. 338 

9. Install the Avaya Agent Web Client Connector. 339 

10. Install the Avaya Agent Web Client. 340 

11. Install Administration and Design. 341 

12. Install Avaya Agent. 342 

13. Start IC Servers, IC Services, and Administration and Design. 343 

14. Perform the following configuration procedures: 344 

a. Configure all servers.  345 

http://support.avaya.com/
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b. Configure SDK Server. 346 

c. Configure Web Services. 347 

d. Configure Design and Admin. 348 

e. Configure Avaya Agent. 349 

f. Configure Avaya Agent Web Client. 350 

g. Configure the IC - Siebel integration. 351 

15. Start Avaya Agent Web Client. 352 

 353 

IC Scripts customization merges Carefully review the installation instructions as well as the list of files 354 
being installed from every package. The files, which have been changed as a part of the SP, replace the files 355 
that exist on the system in the respective folders. If the current installation at the customer site involves 356 
configuration changes or customization in any of the files that are being replaced by the SP Installer, backup 357 
the original file in a separate folder to identify old configuration or customization content. After the installation 358 
is successful, review the content of the new file that has been installed and merge the previous configuration 359 
or customization in the new file. Do not replace the new file with the old one directly as it might result in loss of 360 
new content. 361 

 Enhancements in IC7.3.2 FP 362 

 Enhancements in IC7.3.1 Service Pack 363 

Enhancements in IC 7.3.2 Feature Pack 364 

New Features and Enhancements 365 

Please refer to What’s New in Interaction Center Release 7.3.x guide available at  366 

http://support.avaya.com/ 367 

Security Enhancements 368 

This section provides list of security vulnerabilities that are addressed in IC 7.3.2 FP.  369 

1. GRIP 11644: DWR object used on AIC HTML Client is subject to Vulnerability 370 

2. GRIP 11641: Cross Site Scripting fixes on the AIC Admin Website module 371 

3. GRIP 11655: HttpOnly cookie flag for HTML Client in IC 372 

4. GRIP 11643: Cross Site Scripting fixes on the AIC Agent Web Client 373 

5. wi01160342: Security scan found vulnerabilities in Admin and Public website 374 

a. Cross-Site Scripting 375 

b. Session Fixation 376 

c. Missing Cross-Frame Scripting Protection 377 

d. Parameter Based Redirection 378 

e. Server Error Response 379 

http://support.avaya.com/
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6. wi01124008: Authentication Credentials Submitted In Plaintext for Admin Website 380 

7. wi01124016: IC Website pages have inadequate URL Redirect Validation 381 

8. wi01124020: IC Admin website pages doesn't have logout option 382 

9. wi01123998: A malicious user is capable of injecting arbitrary JavaScript content into a user's 383 
browsing session of IC public website through Cross Site Scripting. 384 

10. wi01124013: A malicious user is capable of injecting arbitrary JavaScript content into a user's 385 
browsing session on Admin Website through Cross Site Scripting. 386 

11. wi01124021: A malicious user is capable of injecting arbitrary JavaScript content into a user's 387 
browsing session of AAWC through Cross Site Scripting. 388 

12. wi01132046: HTTP Connector server exposes Generic Web Server Directory Traversal Vulnerability 389 

13. wi01132047 : Man-in-the-middle attacker can force the communication to a less secure level as IC 390 
Directory server accepts sslv2 connections 391 

14. wi01158433: RLManager allows operations like add/mod/del by extracting information from existing 392 
cookies 393 

Please refer to Avaya Interaction Center Release 7.3.x Security Guide available at http://support.avaya.com/ 394 

 395 

Enhancements in IC 7.3.1 Service Pack 396 

Overview of the Simplified IC Dump feature  397 

In computing, a core dump consists of the recorded state of the working memory of a computer program at a 398 
specific time, when the program terminates abnormally or crashes. Core dumps assist in diagnosing and 399 
debugging errors in computer programs. Other key pieces of the program state including the processor 400 
registers, which may include the program counter and stack pointer, memory management information, and 401 
other processor and operating system flags and information, are also dumped at the same time. 402 

Core dumps are useful debugging aids in several situations. Core dumps allow a user to save a crash for later 403 
or off-site analysis, or for comparison with other crashes. Core dumps can be used to capture data freed 404 
during dynamic memory allocation and may thus be used to retrieve information from a program that is no 405 
longer running. In the absence of an interactive debugger, a programmer can use the core dump to determine 406 
the error from direct examination. 407 

A core dump represents the complete contents of the dumped regions of the address space of the dumped 408 
process. Depending on the operating system, the dump might contain few or no data structures to aid 409 
interpretation of the memory regions. 410 

A debugger can use a symbol table or file to help the programmer interpret dumps, identifying variables 411 
symbolically and displaying source code. If the symbol table or file is not available, it is difficult to interpret the 412 
dump. There are also special-purpose tools called Dump Analyzers to analyze dumps. 413 

If IC does not function according to the expected behavior, the reason might be incorrect implementation of 414 
business requirement or incorrect usage of coding language and OS/Library APIs in the application code. 415 
Application logs help in troubleshooting the incorrect implementation of business requirement in the 416 
application code. For the other category, where incorrect application behavior is the result of incorrect usage 417 
of coding language and OS/Library APIs, it might be difficult to resolve the problem with the help of 418 
application logs only. Unavailability of the opportunities of live debugging on customer’s production system 419 
increases the problems. In such scenarios, core dump works as a critical aid to application log in finding the 420 

http://support.avaya.com/
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root cause of the issue. Postmortem debugging of core dumps helps in analyzing various application issues 421 
such as: 422 

 Application crash analysis: 423 

 Access violation 424 

 Memory or Stack/Heap corruption 425 

 Stack overflow 426 

 Memory, Resource or Handle leak analysis 427 

 Hang analysis: 428 

 Low CPU hang 429 

 High CPU hang 430 

 Inter process communication issues 431 

The Simplified IC Dump feature helps IC processes to create core dump in various scenarios. Core dump is 432 
created automatically in application crash scenarios. In other scenarios, where a process is still running, 433 
creating a core dump is similar to selecting the server in IC Manager, and then clicking a toolbar button. 434 

Using the Simplified IC Dump feature, the IC Application can: 435 

1. Create core dump with correct bitness, that is, 32-bit core dump. 436 

2. Create full memory core dump file of the process. 437 

3. Create core dump automatically on crash of any IC processes such as toolkit server or client. 438 

4. Create core dump of a running IC Server through IC Manager without affecting the IC server process. 439 

5. Create core dump at IC installation location, in the IC logs folder. 440 

6. Create core dump with a unique name containing the time-stamp so that earlier core dumps are 441 

preserved. 442 

Note: The IC Dump feature is applicable to components that are compiled and maintained as part of the IC 443 

code. The IC Dump feature is not applicable to the components that are shipped and installed with IC but not 444 

part of IC source code, for example, Third party or Open Source components. 445 

Installation and Configuration 446 

Simplified IC Dump is installed by the installation of IC 7.3.1 or later service pack. 447 

Most of the configurations for different IC flavors such as Design and Admin, Server, WebConnector, Clients 448 
running on different platforms such as Windows, Solaris and AIX, is done automatically by the Service Pack 449 
installer. 450 

IC WebServices service configuration for Windows platform 451 

Perform the following steps on the machine where the IC WebServices service is configured for the Windows 452 
platform: 453 

1. Stop the IC WebServices service, if running. 454 

2. Remove the already deployed IC WebServices service. 455 

3. Deploy the IC WebServices service. 456 

4. Start the IC WebServices service. 457 

Detailed steps to start, stop, remove or deploy WebServices service are available in the Deploying Web 458 

Services chapter of the Installation and Configuration guide. 459 
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Note:  460 

Alternatively, you can add the -XX:+UseOSErrorReporting JVM option in a new line to the following 461 
registry key: 462 

o On a 64-bit Windows server: 463 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation\Procrun 464 

2.0\<IC WebServices Service Name>\Parameters\Java\Options 465 

o On a 32-bit Windows server: 466 

HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Procrun 2.0\<IC WebServices 467 
Service Name>\Parameters\Java\Options 468 

Restart the WebServices service after adding the previous registry entry. 469 

Enabling fullcore on AIX 470 

1. Check if the "fullcore" flag is on:  471 

# lsattr -E -l sys0 -a fullcore  472 

fullcore false Enable full CORE dump True  473 

2. Set the flag to "true": 474 

# chdev -l sys0 -a fullcore=true  475 

sys0 changed 476 

Core dump creation when IC process crashes 477 

A core dump generated in a crash scenario, with the right set of information contained within it, is useful in 478 
finding the root cause of the coding issue through the postmortem debugging. The Simplified IC Dump feature 479 
enables all IC processes such as a Toolkit server and client to create the full memory core dump file 480 
automatically at the IC install location.  481 

The Simplified IC Dump feature names the core dump file using the component name and the time when the 482 
crash occurred.  483 

Following is the core dump file naming convention in a crash scenario on different IC supported platforms: 484 

Crash dump on Windows platform 485 

The core dump for the Toolkit Server is created in <AVAYA_IC73_HOME>\logs folder with the name as 486 

<ServerAlias>(<ExecutableName>)[PID]_Crash-<TimeStamp>.dmp. For example, if an ADU Server with an 487 

alias name ADU_Voice1 and process id 1234 crashes at 11:23:45 AM on 01 March 2013, then the core dump 488 

file with name ADU_Voice1(adusrv.exe)[1234]_Crash-20130301112345.dmp is created in 489 

<AVAYA_IC73_HOME>\logs folder. 490 

The core dump for Toolkit Client is created in <AVAYA_IC73_HOME>\logs folder with the name as 491 

<UserId>(<ExecutableName>)[PID]_Crash-<TimeStamp>.dmp. For example, if the Avaya Agent Rich Client 492 
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application with process id 2345 crashes at 10:39:56 AM on 01 March 2013 when Agent with login id agent1 493 

was logged in, then the core dump file with name agent1(qui.exe)[2345]_Crash-20130301103956.dmp  is 494 

created in <AVAYA_IC73_HOME>\logs folder. 495 

Note:  496 

1. The TimeStamp is calculated using localtime_s API and will be in the format of YYYYMMDDHHMMSS. 497 

2. The core dump file is created by the IC implemented unhandled exception filter hook code. The core 498 

dump is created only for the scenario where the reason of crash is an unhandled exception in the 499 

code. This feature does not handle other reasons of crash. In other crash scenarios, Windows Error 500 

Reporting or other similar methods and utilities can be used for core dump creation. 501 

3. To create a crash dump for Toolkit dependent IC components, running as snap-in within Microsoft 502 

Management Console (mmc.exe), the following dialog box is displayed in case of crash within MMC. 503 

 504 

Select the ‘Continue running and ignore errors with this snap-in for the rest of the session’ option in 505 

the dialog box. 506 

Crash dump on Solaris platform 507 

The core dump of both, Toolkit Server and Toolkit Client, will be created at <AVAYA_IC73_HOME>/logs 508 

folder with the name as <Executable Name>[PID]_Crash-<TimeStamp>.core. For example, if ADU Server with 509 

an alias name ADU_Voice1 and process ID 1234 crashes at 11:23:45 AM on 01 March 2013, then the core 510 

dump file with the name adusrv.exe[1234]_Crash-1362137025.core  is created in 511 

<AVAYA_IC73_HOME>/logs folder. If Configuration Tool with process id 2345 crashes at 10:39:56 AM on 01 512 

March 2013 when Administrator with the login id Admin was logged in, then the core dump file with the 513 

name java[2345]_Crash-1362134396.core is created in <AVAYA_IC73_HOME>/logs folder. 514 

Note: The TimeStamp is a decimal value of ‘time(2)’ function. The ‘time()’ function returns the value of time in 515 
seconds since 00:00:00 UTC, January 1, 1970. The core dump file will be created by Solaris OS. 516 

Crash dump on AIX platform 517 

http://msdn.microsoft.com/en-us/library/a442x3ye(v=vs.80).aspx
http://docs.oracle.com/cd/E19082-01/819-2241/time-2/index.html
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The core dump of both Toolkit Server and Toolkit Client is created in the current working directory of the 518 
process. Most of the current working directory of the IC process is either <AVAYA_IC73_HOME>/etc or 519 
<AVAYA_IC73_HOME>/bin folder. 520 

The name of the core dump file is core.PID.<TimeStamp> if there is no JVM loaded in the process memory 521 
irrespective of whether JVM is loaded explicitly or implicitly. In such a case, the core dump file is created by 522 
AIX OS. For example, if ADU Server with an alias name ADU_Voice1 and process ID 1234 crashes at 523 
11:23:45 AM on 01 March 2013, then the core dump file with name core.1234.01112345  is created in the 524 
<AVAYA_IC73_HOME>/etc folder. 525 

Note:  526 

The TimeStamp is in the format of DDHHMMSS in the previous example. 527 

The name of the core dump file is core.<TimeStamp>.PID.<SequenceNo>.dmp if there is JVM loaded in the 528 
process memory. In such a case, the core dump creation for the process is controlled by JVM. For example, if 529 
Configuration Tool with process ID 2345 crashes at 10:39:56 AM on 01 March 2013 when the Administrator 530 
with login ID Admin was logged in, then core dump file with name core.20130301.103956.2345.0001.dmp  is 531 
created in <AVAYA_IC73_HOME>/bin folder. 532 

Note:  533 

If the core dump creation is controlled by JVM, the TimeStamp is in the format of YYYYMMDD.HHMMSS. If 534 
JVM controls the core dump creation, JVM provides the SequenceNo. 535 

Core dump creation of a running IC server 536 

It is easier to troubleshoot some problems through core dump of the process even though the process does 537 
not crash and is in a running state. You can rectify scenarios like application hang, thread deadlock, memory 538 
or handle leak through postmortem debugging of core dump of the running application along with analyzing 539 
the application log. 540 

Using the Simplified IC Dump feature, IC administrators can create core dump of any running IC server 541 
configured in IC Manager. The core dump of a running IC server can be created through IC Manager by 542 
selecting single or multiple servers and clicking the ‘Create server dump’ button on the Toolbar. 543 

The core dump file of a running server is created in the <AVAYA_IC73_HOME>/logs directory on all three 544 
platforms. Following are the names of core dump files on different platforms created through IC Manager: 545 

1. Windows: <ServerAlias> [PID]_Dump-<TimeStamp>.dmp 546 

2. Solaris: <ServerAlias> [PID]_Dump-<TimeStamp>.core.PID 547 

3. AIX: <ServerAlias> [PID]_Dump-<TimeStamp>.core 548 

Note: The TimeStamp is calculated using localtime_s API on Windows and localtime API on Solaris and AIX. 549 
The TimeStamp is in the format of YYYYMMDDHHMMSS. 550 

Perform the following steps to create dump of a running IC server configured in IC Manager: 551 

1. Log in to IC Manager using an account with Administrator privileges. 552 

2. Select the server for creating the core dump. 553 

Note: You can select multiple servers in IC Manager for creating core dump. 554 

3. Select the ‘Create server dump’ button on the Toolbar as shown in the following image: 555 

http://msdn.microsoft.com/en-us/library/a442x3ye(v=vs.80).aspx
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 556 

Alternatively, you can also use, the ‘Dump’ popup menu by right-clicking the selected servers.  557 

Another method of creating a dump is to select Server  Dump. 558 

4. Select ‘Yes’ on the confirmation dialog box. 559 

The info alarm is displayed confirming successful creation of core dump of the selected servers. In case a 560 

core dump is not generated successfully, the system displays a warning alarm. 561 

IC Manager performs the following steps to internally create the core dump of selected servers: 562 

1. IC Manager first pings the selected server by sending a Ping VESP request. 563 

2. If the response to ping is successful, then IC Manager calls the selected server‘s Dump VESP 564 

method. 565 

3. If Server.Ping or Server.Dump VESP request fails, then IC Manager sends request to corresponding 566 

ORB server to create the selected servers core dump. 567 

4. If the ORB is the parent process of the selected servers, then ORB creates core dump for that server. 568 

This is a backup mechanism for creating core dump. 569 

5. IC Manager raises an alarm notifying the success or failure of the core dump creation. 570 

Note:  571 

1. By launching a separate utility as a separate process and providing a process ID of the selected 572 

server as an argument to that utility process, you can create dump of a running server. The Simplified 573 

IC Dump feature uses <AVAYA_IC73_HOME>\bin\avayadmp.exe, gcore and gencore utilities for 574 

core dump creation on Windows, Solaris and AIX platforms respectively. Avayadmp.exe utility is a 575 

part of the IC 7.3.1 Service Pack. On Solaris and AIX, Avayadmp.exe is required to ensure that 576 

respective utilities, that is, gcore and gencore are installed and their paths are resolved correctly. 577 

2. The size of the Core dump is equivalent to the virtual memory size of the process at the time of dump 578 

creation. This size of core dump can vary from few hundred MBs up to 2-GB which is the user mode 579 

address space limit of any 32-bit process. Dump of a running process should not be created 580 

unnecessarily as it may consume disk space. An issue scenario must be considered and thought of. 581 

Contact Avaya support with the issue and the support team can advise you on how to take core dump 582 

for that particular issue and how many core dumps are required to take with what interval. Core dump 583 

of a running IC server must not be created without consulting Avaya support. 584 

3. In case of automatic Core dump creation due to an application crash, the issue, along with core dump 585 

and application log file, must be reported to Avaya support. To speed up the resolution of the issue, 586 

provide the crash scenario and steps along with the dump and log file. 587 
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Dump VESP request timeout setting 588 

Timeout for Dump VESP request is configurable in server configuration through the ‘DumpTimeout’ server 589 
configuration parameter. The minimum value of this parameter is 20 seconds, the maximum value is 160 590 
seconds, and default value is 64 seconds. You can add the DumpTimeout parameter to the configuration tab 591 
of any server in IC Manager in the form of a new seqCouple. 592 

 593 

After adding or changing the DumpTimeout parameter in IC Manager, select Server -> Update to activate the 594 
added parameter or updated value. 595 

Note: This configuration parameter does not play any role in creating core dump due to application crash. In 596 
most of the cases, you would not be required to change the default DumpTimeout value for creating dump of 597 
a running IC server through IC manager. You must add or change this configuration Avaya support 598 
recommends. 599 

Creating dump with avayadmp application 600 

If the dump of a running process cannot be created through IC Manager on the Windows platform, then the 601 
new avayadmp.exe application present in <AVAYA_IC73_HOME>\bin folder can be directly used for dump 602 
creation through the command prompt. Avayadmp.exe can be be used with the following command line 603 
arguments: 604 

avayadmp.exe -p <Process Id> -t [Dump Type] -l [Dump Location] -n [Application Name] -d [DbgHelp 605 
Library Path] 606 

 -p  607 

 Mandatory Parameter. Process ID of the application to be dumped. 608 

 -t  609 

 Optional Parameter. Type of dump. Values could be (tiny, mini, midi or full). 610 
 If not provided, then full dump will be created.  611 
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 -l 612 

 Optional Parameter. A valid dump location or directory where dump will be saved. 613 

 If the location or directory is not provided, then dump will be saved in Windows Temp folder. 614 

 -n 615 

 Optional Parameter. Friendly application name. For example, alias name. 616 
 If not provided, then exe name will be used to name the dump file. 617 

 -d 618 

 Optional Parameter. Valid directory of dbghelp.dll library. 619 

 If not provided, then dbghelp.dll be tried first from application's directory and then from Windows 620 

System directory. 621 

Example: If the Avaya Agent Web Client process is not able to process any VESP request, then it would not 622 
be possible to create the dump of AAWC through IC Manager’s ‘Create server dump’ toolbar button. In such 623 
scenarios, the ORB server also does not help in creating the dump since the AAWC process is launched 624 
separately and it is not managed by ORB process. In this case, avaydmp.exe can be directly used to create a 625 
dump of AAWC server by performing the following steps: 626 

1. Get the process ID of AAWC, that is, javaw.exe using Windows Task Manager and note it down. 627 

2. Open command prompt cmd.exe and navigate to <AVAYA_IC73_HOME>\bin directory. 628 

3. Type the following command on the command prompt: 629 

avayadmp.exe -p <AAWC Process Id> -t full -l <AVAYA_IC73_HOME>\logs -n <AAWC server alias 630 

name> -d <AVAYA_IC73_HOME>\bin 631 

4. Note the output of avayadmp.exe on command prompt and check if the core dump file is created at 632 

the specified location with the name as <ServerAlias>[PID]_Dump-<TimeStamp>.dmp. 633 

Note: In case of other supported platforms, that is, Solaris and AIX, the respective dump creation utilities 634 
such as gcore and gencore can also be used in a similar manner from the command line to create the dump. 635 

Examples: 636 
Solaris: gcore -o <AVAYA_IC73_HOME>/logs/<core dump file name> ProcessID 637 
AIX: gencore ProcessID <AVAYA_IC73_HOME>/logs/<core dump file name> 638 

For more information on how to use gcore and gencore, refer to the respective platform manual. 639 

Replace Workgroup Functionality 640 

The Replace functionality is added to Multi Agent Edit feature of ICManager. This helps simplify the process 641 
of replacing agent’s workgroup membership with new workgroup membership. This allows moving all agents 642 
of one workgroup to another workgroup. 643 

In the Workgroup Membership window, a new button Replace>> has been added along with the add member 644 
(>>) and remove member (<<) buttons.  645 

To perform the Replace operation, the user has to select an existing workgroup membership from the 646 
Member of list on the right side and a replacement from Workgroups on the left side and click the Replace>> 647 
button as follows: 648 
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 649 

    650 

The scenarios with steps to perform the Replace operation are as follows: 651 

Scenario 1: 652 

 All the selected agents belong to only one workgroup and all agents must move to another 653 
workgroup. 654 
For example, move all agents from Passport workgroup to Siebel workgroup. 655 

Perform the following steps: 656 

1. Select the original workgroup from the Member of list on the right side of the window 657 

2. Select the new workgroup from Workgroups list on the left side of the window. 658 

3. Verify that all the three buttons Add (>>), Remove (<<) and Replace>> are activated. 659 

4. Click the Replace>> button to move the agents from the original workgroup to the new 660 

workgroup. 661 

5. Click Ok in the Workgroup Membership window.  662 

6. Click Apply in the Multi Agent Edit window to commit the changes. 663 

Since all the agents belong to only one workgroup, the workgrouporder for all the agents is zero. The 664 
database changes are shown in the following table: 665 

Before performing Replace: 666 

Agent Workgroup name Value of the workgrouporder 
field in the groupmember  

table 
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agent1 Passport 0 

agent2 Passport 0 

agent3 Passport 0 

 After performing Replace: 667 

Agent Workgroup name Value of the workgrouporder 
field in the groupmember  

table 

agent1 Siebel 0 

agent2 Siebel 0 

agent3 Siebel 0 

Scenario 2: 668 

The selected agents belong to multiple workgroups. You must replace one of the common 669 
workgroups that agents belong to with a new workgroup. 670 

For example, remove WG2 and replace WG2 with WG5 as shown in the following image: 671 

     672 

Perform the following steps: 673 
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1. Select the original workgroup from the Member of list on the right side of the window. 674 

2. Select the new workgroup from Workgroups list on the left side of the window. 675 

3. Verify that all the three buttons Add (>>), Remove (<<) and Replace>> are activated. 676 

4. Click the Replace>> button to move the agents from the original workgroup to the new 677 

workgroup. 678 

5. If some of the selected agents have the new workgroup as their primary workgroup, that is, 679 

workgrouporder for the workgroup is zero, the following message appears: 680 

 681 

a. On selecting yes, the original workgroup is replaced by the new workgroup for all the agents.  682 

The database changes after selecting the Yes option are as follows: 683 
Before performing Replace:  684 

 685 

Agent Workgroup name Value of the 
workgrouporder field in 
the groupmember  table 

agent1 Default 

WG2 

Approver 

0 

1 

2 

agent2 WG2 

Approver 

0 

1 

agent3 WG5 0 

 Approver 1 

 WG2 2 

 686 

After performing Replace: 687 

Agent Workgroup name Value of the 
workgrouporder field in 
the groupmember  table 
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agent1 Default 

WG5 

Approver 

0 

1 

2 

agent2 WG5 

Approver 

0 

1 

agent3 Approver 0 

 WG5 1 

   

 688 

b. On selecting No, the agents who have the original workgroup as their primary workgroup are 689 

skipped and the replace operation is performed for other selected agents. 690 

The database changes after selecting the No option are as follows: 691 

Agent Workgroup name Value of the 
workgrouporder field in 
the groupmember  table 

agent1 Default 

WG5 

Approver 

0 

1 

2 

agent2 WG5 

Approver 

0 

1 

agent3 WG5 0 

 Approver 1 

 WG2 2 

 692 

c. On selecting Cancel, the Replace operation is canceled. 693 

 694 

 695 

 696 
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Other changes in the Agent Multi-Edit operation:  697 

1. Only one operation at a time: 698 

Only one operation out of add, remove or replace is allowed at a time. Before performing the next 699 

operation, the user must commit the changes by clicking Apply on the Agent Editor dialog box. 700 

Committing ensures that workgroup membership has been updated with proper ordering before the 701 

next operation, and avoids database corruption. 702 

2. Display common members only:  703 

As the MultiEdit window displays common values across all the agents being edited; only the 704 

common workgroups across all the agents are displayed in the member of field. 705 

3. Adding new workgroup: 706 

If a new workgroup is added in the member of list, the workgroup is added at the last position in the 707 

member of list for each individual agent. 708 

4. Removing workgroup from common member’s list:  709 

If any workgroup is removed from the member of list, the workgroup is removed from all the agents 710 

being edited. The order of the workgroups that is present after the workgroup being removed is 711 

pushed up by 1. 712 

5. Workgroup re-ordering: 713 

Member re-ordering, that is, the member move-up and move-down arrow buttons are not available 714 

for MultiEdit, as the order of common groups might vary for all the agents being edited. 715 

Internet Explorer 10 support for chat escalation 716 

Customers can use Internet Explorer 10 for chat and collaboration from SP 7.3.1 onwards. Use of IE 10 on 717 
the Agent side is not supported.  718 

The following functionality is supported for end customers using IE 10: 719 

1. Escalate a chat contact 720 

2. Co-browse  721 

3. Collaborative Form filling  722 

Note: IE 10 in IE 9 Mode, IE 10 in IE 8 mode and IE 10 in Quirk mode are not supported. 723 

 724 
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Installation 725 

This section describes the FP Installer that updates the existing Avaya IC 7.3 systems with the Avaya IC 7.3.2 726 
FP to provide fixes and enhancements for Avaya IC 7.3 727 

The Installation Tool performs the following steps: 728 

1. Creates a backup of each file that is replaced by the installer with new files. 729 

2. Copies the new IC 7.3.2 files into the appropriate directories on your system. 730 

3. Creates the Uninstaller program. 731 

4. Displays a screen that confirms a successful installation with the following text: 732 

Installation was successful. 

No errors or warnings were generated. 

Complete log messages are available at: 

.../IC73/ICServicePacks/7.3.2/<FolderNameOfComponent>/Log/install.log 

Where <FolderNameOfComponent> is the folder name of each component where the respective 733 

component files reside. 734 

The Installation Tool provides a separate installation program for each IC component. The Installation 735 
Tool helps you to upgrade your machines based on the component they run. The following table lists the 736 
name of the component and its respective folder name: 737 

Component/machine Folder Name 

Administration and Design DesignAdmin 

Avaya Agent client AvayaAgent 

Avaya Agent Web Client WebClient 

Avaya Agent Web Client Connector WebConnector 

IC Servers Server 

Siebel Integration component (IC side) ICSideSiebel 

Siebel Integration component (Siebel side) SiebelSideIC 

For Windows installations, the Installation Tool also: 738 

 Un-registers the necessary files on your system. 739 

 Registers the new files on your system. 740 
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Before you install 741 

You must have separate machines for each IC component. Avaya does not support multiple IC components 742 
installed on the same machine. The following is a list of all IC components: 743 

 IC Servers 744 

 Avaya Agent 745 

 Avaya Agent Web Client Connector 746 

 Administration and Design 747 

 Siebel Integration component [IC side] 748 

 Siebel Integration component [Siebel side] 749 

 SDK 750 

Also ensure that no instance of tomcat and JRE are running. 751 

Note:  752 

If an IC installation is being done on a fresh system using the RTM installer, then some error messages can 753 
popup during the installation of the FP. These error messages state that the file being copied during the FP 754 
installation is older than the file that already exists on the system. This is a valid scenario, and the customer 755 
must replace the existing files with the files being copied by the FP installer. 756 

When installing IC using the RTM installer, the installer adds data regarding the installation location of IC to 757 
some of the files being installed by the installer. Due to this, the modification time of the file changes to the 758 
current time. If the IC system was installed during the development phase or after the release of the FP, then 759 
it may happen that some of the files in the FP have a modification time that is earlier than those of the same 760 
files installed on the system. This change is due to the RTM installer modifying the files. 761 

In such cases, the message, as described earlier, pops up during the FP installation. You can ignore the error 762 
message and continue with the installation by choosing the Replace option on the dialog box that pops up. 763 

Stop Avaya Agent Web Client 764 

Before you run the IC 7.3.2 installation, you must stop the Avaya Agent Web Client. Ensure that all IC Avaya 765 
Agent Web Clients are logged off prior to stopping the Avaya Agent Web Client. 766 

On the Avaya IC 7.3 release, you can start and stop the Avaya Agent Web Client component by stopping the 767 
javaw process. 768 

To stop the javaw process 769 

1. For Windows Operating System, click Start > Run to open the command prompt. 770 

2. Change the directory to: AVAYA_IC73_HOME\IC73\bin. 771 

3. Execute the following command: 772 

Operating System Procedure 

Windows To stop: 

aawcclient.bat stop 
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Operating System Procedure 

Solaris and AIX To stop: 

./aawcclient.sh stop 

Stop IC services 773 

Before you run the IC 7.3.2 Server installation, you must stop all the IC services and ensure those services 774 
are stopped. This might take several minutes because it allows the servers to complete their current tasks 775 
before shutting down. 776 

Windows 777 

To stop the IC Services: 778 

4. Click Start > Run. 779 

5. In the Run box, type services.msc, and press Enter. 780 

6. Stop the following services. Some of these services might not exist on every IC server: 781 

 Avaya IC CIRS Service 7.3 782 

 Avaya IC Email Template Management Service 7.3 783 

 Avaya ICM Service 7.3 784 

 Avaya IC ORB Service 7.3 785 

 Avaya IC Test Service 7.3 786 

 Avaya IC Web Management Service 7.3 787 

 Avaya IC WebLM Service 7.3 788 

 Avaya Voice Media Manager 789 

 Avaya SDK Services 790 

 Avaya Business Advocate Component Manager 791 

Solaris and AIX 792 

To stop the IC Services: 793 

1. Log in with root privileges and navigate to the ../IC73/bin directory: 794 

2. For ICM, at the command prompt, type:./icm.sh stop –force, and press Enter. 795 

3. For CIRS, at the command prompt, type:./cirs.sh stop –force, and press Enter. 796 

4. To stop multiple Tomcat instances, at the command prompt, type:./ictomcat.sh stop all – 797 

force, and press Enter. 798 

5. To stop a single Web Application, at the command prompt, type:./ictomcat.sh stop 799 

<servicename> -force, and press Enter. 800 

 For oracle iplanet server 801 
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1. Go to the <Oracle-iPlanet-Web-Server_HOME>/<https-node-name>/bin/ path. 802 

2. Type ./stopserv  803 

3. Press Enter. 804 

4. Go to <Oracle-iPlanet-Web-Server_HOME>/admin-server/bin/ path 805 

5. Type ./stopserv 806 

6. Press Enter. 807 

 For IBM http Web Server  808 

1. Change the directory to: AVAYA_IC73_HOME\IC73\bin 809 

2. At the command line, type: ./httpserver.sh stop  810 

3. Press Enter.  811 

 812 

Stop the VMM service (Solaris only) 813 

If you host your Avaya IC servers on Solaris and have the VMM service configured, you must stop the VMM 814 
setup service to configure the Voice Media Manager (VMM) for Voice Chat. The VMM setup service 815 
configures the VMM to start automatically. 816 

You must only perform this step if you host your Avaya IC servers on Solaris. Do not perform this step if you 817 
host your servers on Windows machines. 818 

To stop VMM on Solaris: 819 

1. Navigate to the following directory: IC_INSTALL_DIR/IC73/bin 820 

2. Type the following at the command line: 821 

./vmm_setup stop 822 

3. Press Enter 823 

Stop IC servers 824 

Before you run the IC 7.3.2 Server installation, you must stop all the IC servers and ensure all processes are 825 
stopped. Ensure that all IC Avaya Agents and IC Avaya Agent Web Clients are logged off prior to stopping all 826 
IC servers. This may take several minutes because the servers need to complete their current tasks before 827 
shutting down. 828 

You can stop IC servers on any of the supported platforms using either IC Manager or the Avaya IC Admin 829 
Utility. 830 

Windows 831 

IC Manager 832 

To stop all the IC servers in the proper order using IC Manager: 833 

1. Start IC Manager, if it is not already running. 834 

2. Click the Server tab. 835 
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3. Select Server > Shutdown. 836 

4. Select the IP address or the name of the machine on which you want to stop servers. 837 

5. Click OK. 838 

Avaya IC Admin Utility 839 

To stop all IC servers using the Avaya IC Admin Utility on the IC server machine: 840 

1. In a command window, navigate to the ...\IC73\bin directory. 841 

2. Stop all IC servers: 842 

 To stop IC servers on all/multiple machines (multi-box setup): 843 

i. At the command prompt, enter the command: icadmin tva <username> <password>. 844 

ii. Press Enter. 845 

 To stop IC servers on one system: 846 

i. At the command prompt, enter the command: icadmin tv <username> <password>. 847 

ii. Press Enter. 848 

Note: Ensure that the login credentials used in the IC Admin Utility command have IC administrative 849 
privileges. 850 

Advocate Servers and Administration 851 

Perform the following steps on each Advocate Administration and Server machine: 852 

1. Close Advocate Administration. 853 

2. Click Start > All Programs > Administrative Tools > Component Services. 854 

3. In Component Services, click Computers > My Computer > COM+ applications > Avaya Business 855 
Advocate. 856 

4. Right-click the package and select Shutdown. 857 

Solaris and AIX 858 

IC Manager 859 

Perform the following steps to stop all the IC servers in proper order using IC Manager: 860 

1. Start IC Manager, if it is not already running. 861 

2. Click the Server tab. 862 

3. Click Server > Shutdown. 863 

4. Select the IP address or the name of the machine on which you want to stop servers. 864 

5. Click OK. 865 

Avaya IC Admin Utility 866 

Perform the following steps to stop all IC servers, including the ORB server, using the Avaya IC Admin Utility 867 
on the IC server machine: 868 
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1. In a command window, navigate to the .../IC73/bin directory. 869 

2. Stop all IC servers: 870 

 To stop IC servers on all/multiple machines (multi-box setup): 871 

i. On the command line, enter the command: ./icadmin tva <username> <password>. 872 

ii. Press Enter. 873 

 To stop IC servers on one machine: 874 

i. On the command line, enter the command: ./icadmin tv <username> <password>. 875 

ii. Press Enter. 876 

Note: Ensure that the login credentials used in the IC Admin Utility command have IC administrative 877 
privileges. 878 

Ensuring all IC servers and services are stopped 879 

Windows 880 

1. Go to the Task Manager dialog box. 881 

2. Click the Process tab to view a list of the processes on your machine. 882 

3. Check to ensure the IC servers are not running. 883 

Solaris and AIX 884 

1. At the command line, type the following command: 885 

ps -ef | grep <AVAYA_IC73_HOME>/bin | grep -v grep 886 

2. Press Enter. 887 

This command displays a list of processes related to IC servers. 888 

3. Check to ensure the IC servers are not running. 889 

If any processes related to IC servers are still running, terminate all the processes related to IC servers. 890 

4. To terminate multiple processes with one command, type the following command: 891 

kill -9 <PID> 892 

Where PID is the Process ID of each individual process that is related to IC servers. 893 

Note: Alternatively, you can type "kill -9 <PID1> <PID2>.... <PIDn>" to end all the processes 894 

with a single command. 895 

5. Press Enter. 896 

Prerequisites 897 

This section describes the prerequisites for installing the IC 7.3.2 Service Pack. 898 
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Prerequisites for installing IC 7.3.2 899 

1. Before you install IC 7.3.2, you must have IC 7.3 installed on your system. 900 

2. Cumulative Security Update for Internet Explorer 8 (KB978207) must be installed on the machines 901 
from where AAWC is launched. 902 

Note: Microsoft might have released patch superseding this and the same can be installed. 903 

Getting Started 904 

Avaya IC 7.3.2 is available on the Avaya Support Web site at: http://support.avaya.com/downloads/ 905 

To receive the IC 7.3.2 release on a CD, send an email requesting the media (CD) to 906 
icoakeyrequest@avaya.com with the following details: 907 

 Customer Name 908 

 Avaya Sold-to Number 909 

 Contact Name 910 

 Contact Address 911 

 Contact Phone Number 912 

 What CDs you are requesting 913 

Obtaining a License Key 914 

Avaya Interaction Center (IC) and Avaya Operational Analyst (OA) are enabled for run-time operation with a 915 
license key that provides features and capacity based on your specific order. The following information is 916 
supplied to assist you in requesting your license keys. 917 

If you have a valid license key and move to a newer IC and OA release from an earlier release, your license 918 
key continues to be valid. It contains the IC and OA features and capacity you are entitled to with your 919 
software licensed from Avaya. Unless you have made changes that modify your HostID on the server where 920 
the license manager is operating, you do not need a new license. For Windows deployments of WebLM, the 921 
license is keyed on the server's MAC address, not the HostID. 922 

Creating License Request 923 

Perform the following steps to create the license request: 924 

1. License Key Request (New) 925 

Send to: icoakeyrequest@avaya.com 926 

Provide the following details: 927 

 Customer Name 928 

 Customer Location (city, state, country) 929 

 Avaya SAP Order Number 930 

 MAC Address (HostID for Solaris) of all Servers running WebLM Service 931 

 System Purpose (for example, Production, Test, Lab) 932 

http://support.avaya.com/downloads/
mailto:icoakeyrequest@avaya.com
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 Return Email address 933 

 Implementer of system (Avaya PSO, Avaya Business Partner or SI, self) 934 

2. License Key Request (Addition/change) 935 

Send to: icoakeyrequest@avaya.com 936 

Provide the following details: 937 

 COPY OF CURRENT LICENSE FILE (IMPORTANT) 938 

 Customer Name 939 

 Customer Location (city, state, country) 940 

 If adding - Avaya SAP Order Number 941 

 Avaya Customer Number 942 

 If changing - MAC Address (HostID for Solaris) of all Servers running WebLM Service 943 

 System Purpose (for example, Production, Test, Lab) 944 

 Return Email address 945 

 Implementer of system (Avaya PSO, Avaya Business Partner or SI, self) 946 

Downloading the IC 7.3.2 Feature Pack 947 

You can download the IC 7.3.2 Service Pack files from the Avaya Support site: 948 
http://support.avaya.com/downloads/. 949 

To download IC 7.3.2: 950 

1. On the Avaya support site, click Downloads & Documents menu. 951 

2. In the Enter Your Product Here field, enter the product name “Interaction Center”. 952 

3. Click the Choose Release drop-down list and select 7.3.x. 953 

4. Select the Downloads option. 954 

5. Click Enter. 955 

6. Click the appropriate IC 7.3.2 file name to download the respective file. 956 

7. Move the IC 7.3.2 files to an installation directory on the system where you want to store them. 957 

Important: The name of the installation directory can contain only acceptable characters, such as A-Z, a- 958 
z, 0-9, -, and _, for the installation to run successfully. The Installation wizard does not copy files from a 959 
directory that contains any other special characters in its name. 960 

Installation files 961 

The following table indicates the machine type, operating system, and the filename for each of the IC 7.3.2 962 
components: 963 

Note: The mapped network drive installation option is not available for the Solaris and AIX platforms. 964 

Component/machine Platform Filename 

http://support.avaya.com/downloads/
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Component/machine Platform Filename 

Administration and Design  Windows IC732WinAdmin.zip. Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Avaya Agent client  Windows IC732WinAgentClient.zip. Extract the files into the 
install directory on the local machine or on the 
mapped network drive, depending on the installation 
option you want to follow.  

Avaya Agent Web Client  Windows IC732WinWebClient.zip. Extract the files into the 
install directory on the local machine or on the 
mapped network drive, depending on the installation 
option you want to follow.  

Avaya Agent Web Client 
Connector  

Windows IC732WinWebConnector.zip. Extract the files into the 
install directory on the local machine or on the 
mapped network drive, depending on the installation 
option you want to follow.  

Solaris IC732SolWebConnector.tar. Extract the files into the 
install directory on the local machine.  

AIX IC732AixWebConnector.tar. Extract the files into the 
install directory on the local machine.  

IC Servers  Windows  IC732WinServer.zip. Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  IC732SolServer.tar. Extract the files into the install 
directory on the local machine.  

AIX  IC732AixServer.tar. Extract the files into the install 
directory on the local machine.  

Siebel Integration component 
(IC side)  

Windows  ICSide732win.zip. Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  ICSide732sol.tar. Extract the files into the install 
directory on the local machine.  

AIX  ICSide732aix.tar. Extract the files into the install 
directory on the local machine.  
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Component/machine Platform Filename 

Siebel Integration component 
(Siebel side)  

Windows  SiebelSide732win.zip. Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  SiebelSide732sol.tar Extract the files into the install 
directory on the local machine.  

AIX  SiebelSide732aix.tar Extract the files into the install 
directory on the local machine.  

Installation options  965 

Avaya IC 7.3.2 provides the following installation options:  966 

Network installation with mapped drive  967 

Local installation  968 

Silent installation  969 

Console installation  970 

The IC Server components, Siebel Integration component [Siebel side], Siebel Integration component [IC 971 
side], and Avaya Agent Web Client Connector components are installed on the Windows, Solaris, and AIX 972 
platforms. All other components are installed on the Windows platform only.  973 

For information on all the supported platforms for IC, see IC 7.3 Installation Planning and Prerequisites.  974 

Network installation with mapped drive  975 

You can install IC 7.3.2 from a network (shared) computer to upgrade other machines without having to copy 976 
the IC 7.3.2 files from the central computer to those machines.  977 

To enable your local machine to access the network computer, you must map a drive from the local machine 978 
to the network computer by selecting the Tools > Map Network Drive option in Windows Explorer.  979 

Note: If Universal Naming Convention (UNC) is not supported, you must map the drive to be accessed from 980 
the installation machine. UNC specifies a common syntax for accessing network resources, such as shared 981 
folders and printers. 982 

For example, the syntax for Windows systems is as follows: \\computername\sharedfolder\resource  983 

Local installation  984 

To install on local machines, copy the component directory, for example, Server, Avaya Agent, or Avaya Web 985 
Agent Client from the central machine to the machine where you want to install the component.  986 

Silent installation  987 

When you run installation in silent mode, the user interface is not available. To run the installer in the silent 988 
mode, a response file is required. The response file can be created by running the installer in record mode. 989 
The options selected during the recoding mode will apply when running the installer in the silent mode..  990 
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Record mode 991 

In record mode, the installer runs the installation normally but records all of your inputs in a text file.  992 

To run the installer in record mode: 993 

1. Go to the package directory where the contents of the FP installer are extracted. 994 

2. At the command prompt, type: 995 

<setupfile> -options-record <AbsolutePathOfFile.ext> 996 

For example, 997 

 998 

Operating System Command 

Windows setupwin32.exe -options-record "D:\temp\SP732Silent.opt" 

Solaris ./setupsolarisSparc.bin -options-record "/tmp/SP732Silent.opt" 

AIX ./setupaix.bin -options-record "/tmp/SP732Silent.opt" 

Note: The <setupfile> is the platform-specific name of the setup executable and 999 
<AbsolutePathOfFile.ext> is the qualified file name, where "AbsolutePathOfFile" is the name of the file 1000 
and "ext" is the file extension. 1001 

3. Press Enter. 1002 

The installer creates the <AbsolutePathOfFile.ext> file containing all of your inputs. 1003 

Silent mode 1004 

In a silent mode, rerun the same installation on another system using the inputs from the text file. 1005 

To rerun the installer in silent mode: 1006 

1. Copy the <AbsolutePathOfFile.ext> file to the machine where you want to install. 1007 

2. Go to the package directory where the contents of the Feature Pack installer are extracted. 1008 

At the command line, type: 1009 

<setupfile> -options <AbsolutePathOfFile.ext> -silent 1010 

For example, 1011 

Operating System Command 

Windows setupwin32.exe -options "D:\temp\SP732Silent.opt" 

-silent 

Solaris ./setupsolarisSparc.bin -options 

"/tmp/SP732Silent.opt" -silent 

AIX ./setupaix.bin -options "/tmp/SP732Silent.opt" -

silent 
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The <setupfile> is the platform-specific name of the setup executable and <AbsolutePathOfFile.ext> is 1012 
the qualified file name, where "AbsolutePathOfFile" is the name of the file and "ext" is the file extension. 1013 

3. Press Enter. 1014 

The installer creates the <AbsolutePathOfFile.ext> file containing all of your inputs. 1015 

Console installation 1016 

When you run installation in console mode, the user interface is not available.  1017 

To run the installer in console mode: 1018 

1. Enter the following command at the command prompt: 1019 

<setupfile> -console 1020 

For example, 1021 

Operating System Command 

Windows setupwin32console.exe -console 

Solaris ./setupsolarisSparc.bin -console 

AIX ./setupaix.bin –console 

Note: The console option can be used for installation and uninstallation of all components. 1022 

Order of installation 1023 

After you complete the instructions for a network installation or a local installation, install the IC 7.3.2 1024 
components in the following order: 1025 

Server installation 1026 

Siebel Integration Component installation 1027 

Avaya Agent Web Client Connector installation 1028 

Avaya Agent Web Client installation 1029 

Administration and Design installation 1030 

Avaya Agent Rich Client installation 1031 

Server installation 1032 

This section describes the installation procedures for the IC 7.3.2 Server component. The Server component 1033 
can be installed on the Windows, Solaris, and AIX platforms.  1034 

This section includes the following topics:  1035 

Windows installation procedures  1036 

Solaris installation procedures 1037 

AIX installation procedures  1038 
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Note: The files for SDK components are currently bundled with the IC Servers installation package for the 1039 
Windows, Solaris, and AIX platforms. If you have IC setup as a multi-box setup such as, primary machine, 1040 
secondary machine, and so on, you need to install the IC Servers setup on all these machines.  1041 

Windows installation procedures  1042 

Note: The server installation instructions in this section pertain to existing IC setup on the Windows 2003 1043 
server. For installation of IC on the Windows 2008 R2 server, refer to the relevant chapter in this document. 1044 

Perform the following steps on the Windows machines running the IC servers.  1045 

1. Before you begin the FP Installation, ensure that all IC components are stopped as explained in the 1046 
sections, Stop IC servers and Stop IC services.  1047 

2. Go to the directory where you extracted the contents of the IC732WinServer.zip file.  1048 

3. Copy the IC732WinServer folder to the machine where you want to install the Server component. If 1049 
you are accessing a network computer through a mapped drive, you do not need to copy the folder. 1050 
Perform the following steps from your server.  1051 

4. Open the IC732WinServer folder and double-click setupwin32.exe to start the installation program.  1052 

5. At the Welcome screen, click Next to continue.  1053 

6. At the next screen that displays the location of the Uninstall program, click Next.  1054 

7. In the pop-up window that prompts Please stop all Avaya IC servers and services, click Continue.  1055 

8. On the next screen, which displays the installation summary, click Next to run the installation. 1056 

The Installation Tool performs the following:  1057 

1. Creates a backup directory and moves the existing server files to that directory.  1058 

2. Copies the new server files to the proper directories.  1059 

3. Registers the new .ocx and .dll files.  1060 

4. Installs the Uninstall program.  1061 

5. Displays the results of the installation.  1062 

If installation is successful, the system 
displays:  

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 
...\IC73\ICServicePacks\7.3.2\Server\Log\ins
tall.log 

If installation is unsuccessful, the system displays:  

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: ...\IC73\ICServicePacks\7.3.2\Server\Log\install.log 

LIST OF ERRORS AND WARNINGS  

6. Click Finish.  1063 

7. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1064 
Installation program.  1065 

8. If a Telephony Server is configured, take the backup of the tssrv.exe and tssrv.pdb files, and delete 1066 
the files from their current location. Make a copy of the files for your switch and rename the copies to 1067 
tssrv.exe and tssrv.pdb.  1068 
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For example: For Avaya DEFINITY/CM, create a copy of cvlansrv.exe and rename it as tssrv.exe in the 1069 
AVAYA_IC73_HOME\bin directory. Similarly, create a copy of cvlansrv.pdb and rename it as tssrv.pdb in 1070 
the AVAYA_IC73_HOME\bin directory. 1071 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  cvlansrv.exe, cvlansrv.pdb  tssrv.exe, tssrv.pdb  

Nortel Meridian  ctsrv.exe, ctsrv.pdb  tssrv.exe, tssrv.pdb  

Aspect Call Center  tsv5aspectcmi.exe, tsv5aspectcmi.pdb  tssrv.exe, tssrv.pdb 

Cisco ICM tsv5cisco.exe, tsv5cisco.pdb tssrv.exe, tssrv.pdb 

9. If a TSQS Server is configured, take a backup of the tsqssrv.exe and tsqssrv.pdb files, and delete the 1072 
files from their current location. Make a copy of the files for your switch and rename the copies to 1073 
tsqssrv.exe and tsqssrv.pdb.  1074 

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai.exe and rename it as tsqssrv.exe 1075 

in the AVAYA_IC73_HOME\bin directory. Similarly, create a copy of tsqssrv_asai.pdb and rename it 1076 

as tsqssrv.pdb in the AVAYA_IC73_HOME\bin directory. 1077 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  tsqssrv_asai.exe, tsqssrv_asai.pdb  tsqssrv.exe, tsqssrv.pdb  

Nortel Meridian  tsqssrv_rti.exe, tsqssrv_rti.pdb tsqssrv.exe, tsqssrv.pdb 

Aspect Call Center  tsqssrv_ aspctportal.exe (no .pdb file) tsqssrv.exe 

Cisco ICM tsqssrv_cisco.exe, tsqssrv_cisco.pdb  tsqssrv.exe, tsqssrv.pdb 

10. On the Web Management Services IC machine, delete the folder "localhost" from the following 1078 
location: 1079 

../IC73/tomcat/work/Catalina/. 1080 

Execute this step only on the Web Management Services IC machine.  1081 

11. If the installation is successful, reboot the machine before you restart the servers.  1082 

Note: In September 2012, Avaya has announced End of Sale (EoS) for Avaya IC’s support for third-party 1083 
switches (PABXes) vide End of Sale Notice: https://downloads.avaya.com/css/P8/documents/100166179. 1084 
As noted in the EoS notice, the End of Manufacturing Support for third-party switches will be effective 1085 
December 2013. Refer to the End of Sale Notice for more details. 1086 

Solaris installation procedures  1087 

To run the Solaris installer, you must log in with root privileges. Perform the following steps on the Solaris 1088 
machines running IC servers.  1089 

1. Before you begin the FP Installation, ensure that all IC components are stopped as explained in the 1090 
sections, Stop IC servers and Stop IC services.  1091 

2. Go to the directory where you uncompressed the contents of the IC732SolServer.tar file.  1092 

https://downloads.avaya.com/css/P8/documents/100166179
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3. At the command line, type: $AVAYA_IC73_HOME/bin/icenv ./setupsolarisSparc.bin (where 1093 
$AVAYA_IC73_HOME/bin/icenv sets the IC environment variables and ./setupsolarisSparc.bin starts 1094 
the Server installation).  1095 

4. On the Welcome screen, click Next.  1096 

5. On the next screen, which displays the location of the Uninstall program, click Next.  1097 

6. In the pop-up window that prompts Please stop all Avaya IC servers and services, click OK.  1098 

7. On the next screen, this displays the installation summary, click Next to run the installation. 1099 

The Installation Tool performs the following:  1100 

 Creates a backup directory and moves the existing server files to that directory.  1101 

 Copies the new server files to the proper directories.  1102 

 Installs the Uninstall program.  1103 

 Displays the results of the installation.  1104 

If installation is successful, the system 
displays: Installation was successful. No 
errors or warnings were generated. 
Complete log messages are available at: 
.../IC73/ICServicePacks/7.3.2/Server/Log
/install.log 

If installation is unsuccessful, the system displays:  

ALERT! Installation failed. Please fix these errors and 
rerun the installer. The following errors or warnings were 
generated. Complete log messages are available at: 
.../IC73/ICServicePacks/7.3.2/Server/Log/install.log 

LIST OF ERRORS AND WARNINGS  

8. Click Finish.  1105 

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1106 
Installation program.  1107 

10. If the tssrv file exists on the system, check to see if this file is a symbolic link to the Telephony Server 1108 
executable.  1109 

 At the command prompt, type ls -l tssrv.  1110 

11. If the tssrv is a symbolic link to the Telephony Server, the system displays: lrwxrwxrwx filenameA -> 1111 
filenameB (where filenameA is a variable for tssrv and filenameB is the absolute server name).  1112 

12. If the tssrv file is a symbolic link to the Telephony Server, use the existing file without renaming it.  1113 

Switch Use 

Avaya DEFINITY/CM cvlansrv 

Nortel Meridian Ctsrv 

13. If the tssrv file is not a symbolic link to the Telephony Server, take a backup of the tssrv file, and 1114 
delete the file from its current location. Make a copy of the file for your switch and rename the copy to 1115 
tssrv.  1116 

For example: For Avaya DEFINITY/CM, create a copy of cvlansrv and rename it as tssrv in the  1117 

AVAYA_IC73_HOME/bin directory. 1118 

Switch  Copy  Rename to  
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Switch  Copy  Rename to  

Avaya DEFINITY/CM  cvlansrv  tssrv  

Nortel Meridian  ctsrv  tssrv  

14. If a TSQS Server is configured, take the backup of the tsqssrv file, and delete the file from its current 1119 
location. Make a copy of the file for your switch and rename the copy to tsqssrv.  1120 

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai and rename it as tsqssrv in the 1121 
AVAYA_IC73_HOME\bin directory. 1122 

Switch  Copy Rename to  

Avaya DEFINITY/CM  tsqssrv_asai  tsqssrv  

15. Backup the qorasrv file from the ..\IC73\bin folder.  1123 

Note: 1124 

 If you are using an Oracle 10 DB Client, rename qora10srv as qorasrv in the ..\IC73\bin folder.  1125 

 If you are using an Oracle 11 DB Client, rename qora11srv as qorasrv in the ..\IC73\bin folder. 1126 

 On the Web Management Services IC machine, delete the folder "localhost" from the location 1127 
“.../IC73/tomcat/work/Catalina/”. Execute this step on only the Web Management Services IC system.  1128 

AIX installation procedures  1129 

Before running the FP installer on the AIX platform, you must end the processes that use the Rogue Wave 1130 
binary files installed on the system. 1131 

 AIX installation prerequisites  1132 

Perform the following steps before carrying out the installation on the AIX platform: 1133 

1. Ensure that all IC components are stopped as explained in the sections, Stop IC servers and Stop IC 1134 
services.  1135 

2. Change the directory to $AVAYA_IC73_HOME/lib.  1136 

3. At the command prompt, type: slibclean  1137 

4. At the command prompt, type: fuser -k lib*12d*.a  1138 

Note: After running the fuser -k lib*12d*.a command, type the following at the command prompt:  1139 

fuser lib*12d*.a  1140 

5. At the command line, type the command: fuser -k lib*.so  1141 

Note: After running the fuser -k lib*.so command, type the following at the command prompt:  1142 

fuser lib*.so 1143 

No process IDs should be displayed in the results after running this command. However, if any process ID 1144 
is displayed in the results, restart the AIX machine.  1145 

6. After performing the steps, proceed with the installation on the AIX platform.  1146 
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AIX installation  1147 

Perform the following steps on the AIX machines running the IC servers.  1148 

Note: To have the permissions to run the AIX installer, you must log in with root privileges.  1149 

1. Before you begin the FP Installation, ensure that all IC components are stopped as explained in the 1150 
sections, Stop IC servers and Stop IC services.  1151 

2. Go to the directory where you uncompressed the contents of the IC732AixServer.tar file.  1152 

3. At the command prompt, type:  1153 

export AVAYA_IC73_HOME=<Avaya IC Servers installation path>  1154 

For example, export AVAYA_IC73_HOME=/opt/Avaya/IC73  1155 

4. Press Enter.  1156 

5. At the command prompt, type: $ ./setupaix.bin. 1157 

6. On the Welcome screen, click Next. 1158 

7. On the next screen, which displays the location of the Uninstall program, click Next.  1159 

8. In the pop-up window that prompts Please stop all Avaya IC servers and services, click OK.  1160 

9. On the next screen, the system displays the installation summary, click Next to run the installation. 1161 
The Installation Tool performs the following:  1162 

 Creates a backup directory and moves the existing server files to that directory.  1163 

 Copies the new server files to the proper directories.  1164 

 Installs the Uninstall program.  1165 

 Displays the results of the installation.  1166 

If installation is successful, the system displays:  

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 
.../IC73/ICServicePacks/7.3.2/Server/Log/install.log 

If installation is unsuccessful, the system displays:  

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 
.../IC73/ICServicePacks/7.3.2/Server/Log/install.log 

LIST OF ERRORS AND WARNINGS  

10. Click Finish.  1167 

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1168 
Installation program.  1169 

12. If the tssrv file exists on the system, check to see if this file is a symbolic link to the Telephony Server 1170 
executable. At the command prompt, type ls -l tssrv.  1171 

13. If the tssrv is a symbolic link to the Telephony Server, the system displays: lrwxrwxrwx filenameA > 1172 
filenameB (where filenameA is a variable for tssrv and filenameB is the absolute server name).  1173 

14. If the tssrv file is a symbolic link to the TS, use the existing file without renaming it.  1174 

Switch  Use 
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Avaya DEFINITY/CM cvlansrv  

15. If the tssrv file is not a symbolic link to the Telephony Server, take a backup of the tssrv file, and 1175 
delete the file from its current location. Create a copy of the file for your switch and rename the copy 1176 
to tssrv.  1177 

For example: For Avaya DEFINITY/CM, create a copy of cvlansrv and rename it as tssrv in the 1178 

AVAYA_IC73_HOME/bin directory. 1179 

Switch  Copy  Rename to  

Avaya DEFINITY/CM  cvlansrv  tssrv  

16. If a TSQS Server is configured, take the backup of the tsqssrv file, and delete the file from its current 1180 
location. Make a copy of the file for your switch and rename the copy to tsqssrv.  1181 

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai and rename it as tsqssrv in the 1182 

AVAYA_IC73_HOME\bin directory. 1183 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  tsqssrv_asai  tsqssrv  

17. On the Web Management Services IC machine, delete the folder "localhost" from the following 1184 
location: 1185 

.../IC73/tomcat/work/Catalina/. 1186 

Execute this step on only the Web Management Services IC system.  1187 

Siebel Integration Component installation  1188 

This section describes the installation procedures for the Siebel Integration Component of the Avaya IC 7.3.2 1189 
release. The Siebel Integration component is installed on the Windows, Solaris, and AIX machines running 1190 
Siebel Services and Avaya IC servers. Install the Siebel Integration component only when your IC system is 1191 
integrated with Siebel.  1192 

The Siebel section includes the following topics: 1193 

Windows installation procedures  1194 

Solaris installation procedures  1195 

AIX installation procedures  1196 

Import the AICD.def file  1197 

Windows installation procedures  1198 

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 1199 
running IC servers. 1200 

Siebel Integration component on Siebel server  1201 

Perform the following steps on the Windows machines that are running Siebel Services.  1202 
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1. Go to the directory where you extracted the contents of the SiebelSide732win.zip file.  1203 

2. Open the SiebelSide732win folder and double-click on setupwin32.exe to start the installation 1204 
program.  1205 

3. At the Welcome screen, click Next to continue.  1206 

4. At the next screen, enter the path location for the Siebel Servers installation, click Next. 1207 

For example, C:\seaxx\siebsrvr. 1208 

5. On the next screen, which displays the location of the Uninstall program, click Next. 1209 

6. On the next screen that prompts, Please stop all Siebel Services before applying the patch, ensure 1210 
that the Siebel Service is not running, and click OK.  1211 

7. On the next screen, this displays the installation summary, click Next to run the installation. 1212 

The Installation Tool performs the following:  1213 

 Creates a backup directory and moves the existing server files to that directory.  1214 

 Copies the new server file to the proper directory.  1215 

 Installs the Uninstall program.  1216 

 Displays the results of the installation.  1217 

If installation is successful, the system displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

C:\Seaxxx\siebsrv\ICServicePack\7.3.2\S

iebelSide\Log\install.log 

If installation is unsuccessful, the system 
displays: 

ALERT! Installation failed. Please fix these 
errors and re-run the installer. The following 
errors or warnings were generated. Complete 
log messages are available at: 

C:\Seaxxx\siebsrv\ICServicePack\7.3.2\SiebelSi
de\Log\install.log 

LIST OF ERRORS AND WARNINGS  

8. Click Finish. 1218 

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1219 
Installation program.  1220 

Siebel Integration component on IC servers  1221 

Perform the following steps on the Windows machines that are running IC servers:  1222 

1. Go to the directory where you extracted the contents of the ICSide732win.zip file.  1223 

2. Open the ICSide732win folder and double-click on setupwin32.exe to start the installation program.  1224 

3. At the Welcome screen, click Next.  1225 

4. At the next screen that displays the location of the Uninstall program, click Next.  1226 

5. At the next screen that prompts, Please stop all IC Services before applying the patch, ensure that all 1227 
IC Services are stopped, and click OK.  1228 

6.  On the next screen, which displays the installation summary, click Next to run the installation. The 1229 
Installation Tool performs the following:  1230 
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 Creates a backup directory and moves the existing server files to that directory.  1231 

 Copies the new server file to the proper directory.  1232 

 Installs the Uninstall program.  1233 

  Displays the results of the installation.  1234 

If installation is successful, the system 
displays: 

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

...\IC73\ICServicePacks\7.3.2\ICSideSiebel\
Log\install.log 

If installation is unsuccessful, the system displays: 

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: 

...\IC73\ICServicePacks\7.3.2\ICSideSiebel\Log\install.lo
g 

LIST OF ERRORS AND WARNINGS  

7. Click Finish.  1235 

8. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1236 
Installation program.  1237 

Solaris installation procedures  1238 

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 1239 
running the IC servers. To have the permissions to run the Solaris installer, you must log in with root 1240 
privileges.  1241 

Siebel Integration component on Siebel server  1242 

Perform the following steps on the Solaris machines that are running Siebel Services.  1243 

1. At the command line, navigate to the directory where you uncompressed the contents of the 1244 
SiebelSide732sol.tar file. If the file is compressed, untar the file using the tar -xvpf command.  1245 

2. At the command line, type the following command:  1246 

./setupsolarisSparc.bin  1247 

3. Press Enter.  1248 

4. On the Welcome screen, click Next.  1249 

5. At the next screen, enter the path location for the Siebel Servers installation, click Next. For example, 1250 
root/seaxx/siebsrvr)  1251 

6. The next screen displays the location of the Uninstall program, click Next.  1252 

7. On the next screen, which prompts Please stop all Siebel Services before applying the patch, confirm 1253 
the Siebel Service is not running and click OK.  1254 

8. On the next screen that displays the installation summary, click Next to run the installation. 1255 

The Installation Tool performs the following:  1256 

 Creates a backup directory and moves the existing server files to that directory.  1257 

 Copies the new server file to the proper directory.  1258 
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 Installs the Uninstall program.  1259 

 Displays the results of the installation.  1260 

If installation is successful, the system displays: 

Installation was successful. No errors or warnings were 
generated. Complete log messages are available at: 

root/Seaxxx/siebsrv/ICServicePack/7.3.2/SiebelSide/Lo
g/install.log 

If installation is unsuccessful, the system 
displays: 

ALERT! Installation failed. Please fix these 
errors and re-run the installer. The following 
errors or warnings were generated. Complete 
log messages are available at: 

root/Seaxxx/siebsrv/ICServicePack/7.3.2/Sieb
elSide/Log/install.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  1261 

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 1262 
Installation program.  1263 

Siebel Integration component on IC servers  1264 

Perform the following steps on the Solaris machines that are running the IC servers.  1265 

1. At the command line, navigate to the directory where you uncompressed the contents of the 1266 
ICSide732sol.tar file.  1267 

2. At the command line, type the following command: ./setupsolarisSparc.bin. 1268 

3. Press Enter.  1269 

4. On the Welcome screen, click Next.  1270 

5. On the next screen, enter the path location for the IC Servers installation and click Next. 1271 

For example, root/IC73 1272 

6. On the next screen displays the location of the Uninstall program, click Next.  1273 

7. On the next screen that prompts, Please stop all IC Services before applying the patch, ensure that 1274 
the IC Services are not running, and click OK.  1275 

8. On the next screen that displays the installation summary, click Next to run the installation. 1276 

The Installation Tool performs the following:  1277 

 Creates a backup directory and moves the existing server files to that directory.  1278 

 Copies the new server file to the proper directory.  1279 

 Installs the Uninstall program.  1280 

 Displays the results of the installation.  1281 
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If installation is successful, the system 
displays: 

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

.../IC73/ICServicePacks/7.3.2/ICSideSiebel/L
og/install.log 

If installation is unsuccessful, the system displays: 

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: 

.../IC73/ICServicePacks/7.3.2/ICSideSiebel/Log/install.lo
g 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  1282 

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 1283 
Installation program.  1284 

AIX installation procedures  1285 

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 1286 
running IC servers.  1287 

Note:  To have the permissions to run the AIX installer, you must login with root privileges. 1288 

Siebel Integration component on Siebel server  1289 

Perform the following steps on the AIX machines that are running Siebel Services.  1290 

1. At the command line, navigate to the directory where you uncompressed the contents of the 1291 
SiebelSide732aix.tar file.  1292 

2. At the command prompt, type: ./setupaix.bin  1293 

3. Press Enter.  1294 

4. On the Welcome screen, click Next.  1295 

5. On the next screen, enter the location for the Siebel Servers installation, click Next. 1296 

For example, root/seaxx/siebsrvr 1297 

6. The next screen displays the location of the Uninstall program, click Next.  1298 

7. On the next screen that prompts, Please stop all Siebel Services before applying the patch, confirm 1299 
the Siebel Service is not running and click OK.  1300 

8. On the next screen that displays the installation summary, click Next to run the installation. 1301 

The Installation Tool performs the following:  1302 

 Creates a backup directory and moves the existing server files to that directory.  1303 

 Copies the new server file to the proper directory.  1304 

 Installs the Uninstall program.  1305 

 Displays the results of the installation. 1306 
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If installation is successful, the system displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

root/Seaxxx/siebsrv/ICServicePack/7.3.2/SiebelSi
de/Log/install.log 

If installation is unsuccessful, the system displays: 

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 
root/Seaxxx/siebsrv/ICServicePack/7.3.2/SiebelSide
/Log/install.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  1307 

10. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1308 
Installation program.  1309 

Siebel Integration component on IC servers  1310 

Perform the following steps on the Solaris machines that are running the IC servers.  1311 

1. At the command line, navigate to the directory where you uncompressed the contents of the 1312 
ICSide732aix.tar file. If the file is compressed, untar the file using the tar -xvpf command.  1313 

2. At the command line, type: ./setupaix.bin. 1314 

3. Press Enter.  1315 

4. At the Welcome screen, click Next.  1316 

5. At the next screen, enter the path location for the IC Services installation, and click Next. 1317 

For example, root/IC73. 1318 

6. The next screen displays the location of the Uninstall program, click Next.  1319 

7. At the next screen that prompts, Please stop all IC Services before applying the patch, ensure that 1320 
the IC Services are not running, and click OK.  1321 

8. On the next screen that displays the installation summary, click Next to run the installation. 1322 

The Installation Tool:  1323 

 Creates a backup directory and moves the existing server files to that directory.  1324 

 Copies the new server file to the proper directory.  1325 

 Installs the Uninstall program.  1326 

 Displays the results of the installation.  1327 
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If installation is successful, the system displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

.../IC73/ICServicePacks/7.3.2/ICSideSiebel/Log/ins
tall.log 

If installation is unsuccessful, the system 
displays: 

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log 
messages are available at: 

.../IC73/ICServicePacks/7.3.2/ICSideSiebel/Log/i
nstall.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  1328 

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 1329 
Installation program.  1330 

Import the AICD.def file  1331 

To import the AICD.def file:  1332 

1. Start the Siebel Services. 1333 

2. Log in to the Siebel Thin Client call center application from the web browser as Siebel Administrator.  1334 

3. Navigate to the AICD profile for Siebel, click Site Map > Administration - Communications > All 1335 
configurations.  1336 

4. Select the existing configuration for AICD.  1337 

5. Click Import Configuration, located on the right side of the window under the Configurations tab.  1338 

A new browser window opens with following text message:  1339 

Caution: Importing communications configuration parameters, commands, events, or drivers and profiles 1340 
will overwrite all existing definitions of those types in the selected configuration. Click Next to proceed.  1341 

6. Click Next. 1342 

7. Select the Commands check box. 1343 

8. Browse to the AICD.def file. 1344 

9. Click OK. 1345 

Avaya Agent Web Client Connector installation  1346 

This section describes the installation procedures for the Avaya Agent Web Client Connector component of 1347 
the Avaya IC 7.3.2 release. Install the Avaya Agent Web Client Connector on the machine that hosts the 1348 
Tomcat Server.  1349 

 Installation path procedures  1350 

 Windows installation procedures  1351 

 Solaris installation procedures 1352 

 AIX installation procedures  1353 
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Installation path procedures  1354 

The IC 7.3.2 installer checks for the installation path through an environment variable or the registry. The 1355 
Avaya Agent Web Client Connector installation path is not stored in an environment variable or in the registry. 1356 
Before starting the Avaya Agent Web Client Connector setup, you must declare the environment variable for 1357 
the installer to use.  1358 

Windows  1359 

To declare the Avaya Agent Web Client Connector installation environment variable on Windows:  1360 

1. Right-click My Computer, and select Properties.  1361 

2. Click the Advanced tab.  1362 

3. Click Environment Variables.  1363 

4. In the System variables section, click New.  1364 

5. In the New System Variable dialog box, enter the installation path name and value. 1365 

Field Name  Enter  

Variable Name  AVAYA_IC73_HOME 

Variable Value  The actual installation path, for example:\AvayaWebClientConnector\IC73 

6. Click OK to save the new variable.  1366 

7. On the Environment Variables dialog box, click OK.  1367 

8. On the Advanced tab, click OK.  1368 

9. Run the Avaya Agent Web Client Connector installation procedures described in Windows installation 1369 
procedures.  1370 

Solaris and AIX 1371 

To declare the Avaya Agent Web Client Connector installation environment variable on Solaris or AIX:  1372 

1. At the console, type:  1373 

export AVAYA_IC73_HOME=<Avaya Agent Web Client Connector installation path>  1374 

For example, export AVAYA_IC73_HOME=/opt/AvayaWebClientConnector/IC73  1375 

2. Press Enter.  1376 

3. Perform the Avaya Agent Web Client Connector installation procedures described in the following 1377 
section.  1378 

Windows installation procedures  1379 

Perform the following steps on the Windows machines that are running the Avaya Agent Web Client.  1380 

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as 1381 
explained in Stop Avaya Agent Web Client.  1382 

2. Go to the directory where you extracted the contents of the IC732WinWebConnector.zip file.  1383 
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3. Open the IC732WinWebConnector folder and double-click on setupwin32.exe to start the installation 1384 
program.  1385 

4. On the Welcome screen, click Next to continue.  1386 

5. On the next screen, which displays the location of the Uninstall program, click Next.  1387 

6. On the next screen, which displays the installation summary, click Next to run the installation. The 1388 
Installation Tool performs the following:  1389 

 Creates a backup directory and moves the existing web client connector files to that directory.  1390 

 Copies the web client connector files to the proper directories.  1391 

 Copies the files from the Java folder to the proper directories.  1392 

 Installs the Uninstall program.  1393 

 Displays the results of the installation.  1394 

If installation is successful, the system displays:  

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at:  

...\IC73\ICServicePacks\7.3.2\WebConnector\Log\in
stall.log 

If installation is unsuccessful, the system 
displays: 

 ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log 
messages are available at:  

...\IC73\ICServicePacks\7.3.2\WebConnector\Log
\install.log 

LIST OF ERRORS AND WARNINGS 

7. Click Finish.  1395 

8. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1396 
Installation program.  1397 

Solaris installation procedures  1398 

To have the permissions to run the Solaris installer, you must log in with root privileges.  1399 

Perform the following steps on the Solaris machines that are running the Avaya Agent Web Client.  1400 

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as 1401 
explained in Stop Avaya Agent Web Client.  1402 

2. Go to the directory where you uncompressed the contents of the IC732SolWebConnector.tar file. 1403 

3. At the command prompt, type: ./setupsolarisSparc.bin. 1404 

4. Press Enter.  1405 

5. At the Welcome screen, click Next.  1406 

6. On the next screen, which displays the location of the Uninstall program, click Next.  1407 

7. On the next screen, which displays the installation summary, click Next to run the installation. The 1408 
Installation Tool performs the following:  1409 

 Creates a backup directory and moves the existing web client connector files to that directory.  1410 

 Copies the new web client connector files to the proper directories.  1411 
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 Copies the files from the Java folder to the proper directories.  1412 

 Installs the Uninstall program.  1413 

 Displays the results of the installation.  1414 

If installation is successful, the system 
displays: Installation was successful. No 
errors or warnings were generated. 
Complete log messages are available at:  

.../IC73/ICServicePacks/7.3.2/WebConnect
or/Log/install.log 

If installation is unsuccessful, the system displays:  

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at:  

.../IC73/ICServicePacks/7.3.2/WebConnector/Log/install

.log 

LIST OF ERRORS AND WARNINGS 

8. Click Finish.  1415 

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1416 
Installation program.  1417 

AIX installation procedures  1418 

AIX installation prerequisites  1419 

Perform the following steps before carrying out the installation on the AIX platform: 1420 

1. Ensure that all IC components are stopped as explained in Stop Avaya Agent Web Client.  1421 

2. Change directory to $AVAYA_IC73_HOME/lib. 1422 

3. At the command line, type the command: slibclean. 1423 

4. At the command line, type the command: fuser -k lib*12d*.a. 1424 

Note: After running the fuser -k lib*12d*.a command, type the following at the command line:  1425 

fuser lib*12d*.a. 1426 

5. At the command line, type the command: fuser -k lib*.so. 1427 

Note: After running the fuser -k lib*.so command, type the following at the command line:  1428 

fuser lib*.so 1429 

No process IDs should be displayed in the results after running this command. However, even if one 1430 
process ID is displayed in the results, then you need to restart the AIX machine.  1431 

6. After performing the earlier steps, install AAWC on the AIX platform.  1432 

AIX installation  1433 

Perform the following steps on the AIX machines that are running the Avaya Agent Web Client.  1434 

Note: To have the permissions to run the AIX installer, you must log in with root privileges.  1435 

1. Before you begin the FP Installation, ensure that all IC components are stopped as explained in Stop 1436 
Avaya Agent Web Client.  1437 
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2. At the command line, navigate to the directory where you uncompressed the contents of the 1438 
IC732AixWebConnector.tar file.  1439 

3. At the command line, type: ./setupaix.bin  1440 

4. Press Enter.  1441 

5. On the Welcome screen, click Next. 1442 

6. The next screen displays the location of the Uninstall program, click Next.  1443 

7. On the next screen which displays the installation summary, click Next to run the installation. 1444 

The Installation Tool performs the following:  1445 

 Creates a backup directory and moves the existing web client connector files to that directory.  1446 

 Copies the new web client connector files to the proper directories. 1447 

 Copies the files from the jre folder to the proper directories. 1448 

 Installs the Uninstall program. 1449 

 Displays the results of the installation. 1450 

If installation is successful, the system displays:  

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at:  

.../IC73/ICServicePacks/7.3.21/WebConnector/Lo
g/install.log 

If installation is unsuccessful, the system displays: 
ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at:  

.../IC73/ICServicePacks/7.3.2/WebConnector/Log/in
stall.log 

LIST OF ERRORS AND WARNINGS 

8. Click Finish.  1451 

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1452 
Installation program. 1453 

Avaya Agent Web Client installation  1454 

This section describes the installation procedures for the Avaya Agent Web Client component of the Avaya IC 1455 
7.3.2 release.  1456 

This component must be installed on the machine where the Avaya Agent Web Client package is installed, 1457 
not the deployment machine.  1458 

This section includes the following topics:  1459 

 Installation path procedures  1460 

 Windows installation procedures  1461 

Installation path procedures  1462 

The IC 7.3.2 installer checks for the installation path through an environment variable or the registry. The 1463 
Avaya Agent Web Client installation path is not stored in an environment variable or in the registry. Before 1464 
starting the Avaya Agent Web Client setup, you must declare the environment variable for the installer to use.  1465 
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Windows  1466 

To declare the Avaya Agent Web Client installation environment variable on the Windows platform:  1467 

1. Right-click My Computer, and select Properties.  1468 

2. Click the Advanced tab.  1469 

3. Click Environment Variables.  1470 

4. In the System variables section, click New.  1471 

5. On the New System Variable dialog, enter the installation path name and value.  1472 

Field Name  Enter 

Variable Name  AVAYA_WEBCLIENT73_HOME  

Variable Value  The actual installation path, for example, C:\AvayaWebClient\IC73 

6. Click OK to save the new variable.  1473 

7. At the Environment Variables dialog, click OK.  1474 

8. On the Advanced tab, click OK.  1475 

9. Run the Avaya Agent Web Client installation procedures described in Windows installation 1476 
procedures.  1477 

Windows installation procedures  1478 

Perform the following steps on the Windows machines that are running the Avaya Agent Web Client.  1479 

1. Go to the directory where you extracted the contents of the IC732WinWebClient.zip file.  1480 

2. Open the IC732WinWebClient folder and double-click on setupwin32.exe to start the installation 1481 
program.  1482 

3. At the Welcome screen, click Next to continue.  1483 

4. On the next screen, which displays the location of the Uninstall program, click Next.  1484 

5. On the next screen, which displays the installation summary, click Next to run the installation. 1485 

The Installation Tool performs the following:  1486 

 Creates a backup directory and moves the existing web client files to that directory.  1487 

 Copies the web client files to the proper directories.  1488 

 Installs the Uninstall program.  1489 

 Displays the results of the installation.  1490 

If installation is successful, the system 
displays:  

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at:  

...\IC73\ICServicePacks\7.3.2\WebClient\Log

If installation is unsuccessful, the system displays: 
ALERT! Installation failed. Please fix these errors and re-
run the installer. The following errors or warnings were 
generated. Complete log messages are available at:  

...\IC73\ICServicePacks\7.3.2\WebClient\Log\install.log 

LIST OF ERRORS AND WARNINGS 



  

60 

 

\install.log 

6. Click Finish.  1491 

7. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1492 
Installation program.  1493 

8. After successful installation, manually merge the customization files, if any.  1494 

9. Generate the war file and deploy on to the webconnector machines. 1495 

Note: To generate webclient.war file and deploy on Windows/AIX/Solaris Webconnector machines, 1496 
please refer to "IC7.3 Installation and Configuration guide" in Avaya Support Site 1497 
http://support.avaya.com 1498 

Administration and Design installation  1499 

This section describes the installation procedures for the IC 7.3.2 Administration and Design component. Only 1500 
the Windows platform supports the IC 7.3.2 Administration and Design component.  1501 

Windows installation procedures  1502 

Perform the following steps on each machine where administration tools are installed.  1503 

1. Stop the IC Manager, Avaya Database Designer, and Workflow Designer applications if they are 1504 
already running.  1505 

2. Go to the directory on the central server where you extracted the contents of the IC732WinAdmin.zip 1506 
file.  1507 

3. Copy the IC732WinAdmin folder to the machine where you want to install the Admin component. If 1508 
you are accessing a network computer through a mapped drive, do not copy the folder. Perform the 1509 
following steps from your administration machine.  1510 

4. Open the IC732WinAdmin folder on the machine from which you want to install.  1511 

5. Double-click the setupwin32.exe to start the installation.  1512 

6. On the Welcome screen, click Next.  1513 

7. On the next screen, which displays the location of the Uninstall program, click Next.  1514 

8. In the pop-up window that prompts, Please log out from IC Manager, click Continue.  1515 

9. On the next screen, which displays the installation summary, click Next to run the installation. 1516 

The Installation Tool performs the following:  1517 

 Creates a backup directory and moves the existing admin files to that directory.  1518 

 Copies the new admin files to the proper directories.  1519 

 Registers the new .ocx and .dll files.  1520 

 Installs the Uninstall program.  1521 

 Displays the results of the installation.  1522 

If installation is successful, the system 
displays: 

If installation is unsuccessful, the system displays: 

ALERT! Installation failed. Please fix these errors 

http://support.avaya.com/
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Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

...\IC73\ICServicePacks\7.3.2\DesignAdmin\L
og\install.log 

and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 

...\IC73\ICServicePacks\7.3.2\DesignAdmin\Log\inst
all.log 

LIST OF ERRORS AND WARNINGS 

10. Click Finish.  1523 

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1524 
Installation program.  1525 

Importing the sc.xml file  1526 

You must import the sc.xml file to fix configuration related issues in IC Manager. The sc.xml file is located in 1527 
the folder where you unzipped the contents of IC732WinAdmin.zip file.  1528 

To import the sc.xml file: 1529 

1. Rename the existing file <AVAYA_IC73_HOME>\etc\sc.xml to  1530 
<AVAYA_IC73_HOME>\etc\sc.xml.bak  1531 

2. Copy the new sc.xml file to <AVAYA_IC73_HOME>\etc.  1532 

Note:  In case, if you have performed any customization in the existing "sc.xml" file, merge that changes 1533 
from "sc.xml.bak" to the new "sc.xml" file you copied in step 2 above.  1534 

3. Log on to IC Manager as Admin.  1535 

4. From the IC Manager, click Manager > Options > Environment tab.  1536 

5. Click the Import Configuration button.  1537 

6. From the Open dialog box, select the sc.xml file that you copied in step 2 above, and click the Open 1538 
button.  1539 

7. If the file is successfully validated, the Validate sc.xml dialog box displays a Successfully Validated 1540 
message. If the validation is unsuccessful, the system displays an xml parsing error.  1541 

Note: If you have merged any previous customization changes in the new sc.xml file, check the xml 1542 
syntax for well-formedness and import the sc.xml file again. 1543 

Avaya Agent Rich Client installation 1544 

This section describes the installation procedures for the IC 7.3.2 Avaya Agent (rich client) component. Only 1545 
the Windows platform supports the Avaya Agent installation.  1546 

Note: You can install the IC 7.3.2 Avaya Agent (rich client) component after all the other IC 7.3.2 FP 1547 
components are installed and configured. You do not require stopping the IC Servers before installing the IC 1548 
7.3.2 Avaya Agent (rich client) component.  1549 

Installation procedures  1550 

Perform the following steps on each agent workstation.  1551 

1. Stop the Avaya Agent application if it is running.  1552 
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2. Go to the directory on the machine where you extracted the contents of the IC732WinAgentClient.zip 1553 
file.  1554 

3. Copy the IC732WinAgentClient folder to the machine where you want to install the Agent component. 1555 
If you are accessing a network computer through a mapped drive, do not copy the folder. Perform the 1556 
following steps from your agent desktop machine.  1557 

4. Open the IC732WinAgentClient folder and double-click on setupwin32.exe to start the installation 1558 
program.  1559 

5. In the Welcome window, click Next.  1560 

6. The installation runs the Preinstall options that unregister the .ocx and .dll files that are patched in this 1561 
installation.  1562 

7. On the next screen, which displays the location of the Uninstall program, click Next.  1563 

8. In the pop-up window that prompts, Please logout Avaya Agent, click Continue.  1564 

9. On the next screen, which displays the installation summary, click Next to run the installation. 1565 

The Installation Tool performs the following:  1566 

 Creates a backup directory and moves the existing agent files to that directory.  1567 

 Copies the new agent files to the proper directories.  1568 

 Registers the new .ocx and .dll files.  1569 

 Installs the Uninstall program.  1570 

 Displays the results of the installation.  1571 

If installation is successful, the system displays: 
Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at:  

...\IC73\ICServicePacks\7.3.2\AvayaAgent\Log\i
nstall.log 

If installation is unsuccessful, the system displays: 
ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 

...\IC73\ICServicePacks\7.3.2\AvayaAgent\Log\insta
ll.log 

LIST OF ERRORS AND WARNINGS 

10. Click Finish.  1572 

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the 1573 
Installation program.  1574 

12. If the installation is successful, reboot the agent machine.  1575 

Avaya Agent installation in silent mode  1576 

On the Windows platform, you can also run the IC 7.3.2 Avaya Agent installation in silent mode. The silent 1577 
mode option is for Avaya Agent installations on multiple machines.  1578 

To run the installer in silent mode, run record mode followed by silent mode.  1579 

 In record mode, the installer runs the installation normally but records all of your inputs in a text file.  1580 

 In silent mode, re-run the same installation in silent mode on another machine using the inputs from 1581 
this text file.  1582 
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Record mode  1583 

To run the installer in record mode:  1584 

1. Click Start > Programs > Accessories > Command Prompt.  1585 

2. Go to the package directory where the contents of the FP installer are extracted.  1586 

3. At the command prompt, type: setupwin32.exe -options-record 1587 

<AbsolutePathOfFile.ext>. 1588 

Note: The <AbsolutePathOfFile.ext> is a placeholder for the qualified complete file name, where 1589 
"AbsolutePathOfFile" is the name of the file and "ext" is the file extension.  1590 

4. Press Enter. 1591 

5. Complete the installation using the information in Avaya Agent Rich Client installation. The installer 1592 
creates the <AbsolutePathOfFile.ext> file containing all of your inputs.  1593 

Silent mode  1594 

To re-run the installer in silent mode:  1595 

1. Copy the <AbsolutePathOfFile.ext> file to the machine where you want to install.  1596 

2. Click Start > Programs > Accessories > Command Prompt. 1597 

3. Go to the package directory where the contents of the FP installer are extracted.  1598 

4. At the command prompt, type: 1599 

setupwin32.exe -options <AbsolutePathOfFile.ext> -silent  1600 

For example, setupwin32.exe -options "D:\temp\SP732Silent.opt" -silent  1601 

5. Press Enter. 1602 

The installation runs (without a GUI) using the <AbsolutePathOfFile.ext> file for your inputs. 1603 

Start IC servers  1604 

After you complete the Avaya IC 7.3.2 Server installation program, delete all the files under the tomcat cache 1605 

path AVAYA_IC73_HOME\tomcat\\work\Catalina\localhost\rlmanager\org\apache\jsp. 1606 

Restart the IC servers by running both of these tools in the following order:  1607 

Avaya IC Admin Utility  1608 

To restart the ORB server using the Avaya IC Admin Utility on the server machine:  1609 

1. At the command prompt, navigate to the following directory:  1610 

 Windows: ...\IC73\bin  1611 

 Solaris and AIX: .../IC73/bin  1612 

2. Type the following command:  1613 

 Windows: icadmin so  1614 

 Solaris and AIX: ./icadmin so  1615 

3. Press Enter.  1616 
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IC Manager  1617 

In IC Manager, you must restart the IC servers individually and in the proper order. Before you begin, run the 1618 
procedures described in Avaya IC Admin Utility restart the ORB server.  1619 

To restart IC servers in IC Manager:  1620 

1. Click the Server tab and select the server to be restarted. The following table lists the order in which 1621 
to start the servers. 1622 

2. Click the Start Server button. 1623 

Server Category  Server Name  

Core Engine servers  Alarm server, Data server, Directory server, License server  

Reporting Services  Event Collector server, Report server  

DU (Data Unit) servers  ADU server, DUStore server, EDU server  

Web Management servers  WebACD server, Web Admin Adapter (WAA) server, Attribute server, 
ComHub server, Paging server, Web Schedule Callback  

Email Management servers  IC Email server (requires the WebACD server), CAServer server, 
CAAdmin server  

Telephony servers  Telephony and TSQS servers (all switches), Telephony Server, Adapter 
(TSA) server, Predictive Dialing Kernel (Outbound Contact) server, Soft 
Dialer server, VOX server  

Business Logic servers  Workflow server, Blender server, Notification server  

Web and Support servers  HTTP Connector server, WebQ server, WebQ Router server  

Siebel Native Integration  ASIS Server 

  

Start IC services  1624 

On the Windows platform, after you complete the Avaya IC 7.3.2 Server installation program, all the IC 1625 
Services need to be started if they are not already started.  1626 

Windows 1627 

The steps given in this section are for the Windows platform. 1628 

To start the IC Services: 1629 

1. Start the Windows Services application. 1630 

2.  Start any of the following services that are not already started (some may not exist on every server). 1631 

o Avaya IC CIRS Service 7.3 1632 

o Avaya IC Email Template Management Service 7.3 1633 
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o Avaya ICM Service 7.3 1634 

o Avaya IC ORB Service 7.3 1635 

o Avaya IC Test Service 7.3 1636 

o Avaya IC Web Management Service 7.3 1637 

o Avaya IC WebLM Service 7.3  1638 

o Avaya Voice Media Manager 1639 

o Avaya SDK Services 1640 

o Avaya Business Advocate Component Manager 1641 

o  1642 

Solaris and AIX 1643 

The steps given in this section are for the Solaris and AIX platforms. 1644 

To start the IC Services: 1645 

1. Move to the .../IC73/bin directory.  1646 

2. For ICM: 1647 

a) At the command prompt, type: ./icm.sh start. 1648 

b) Press Enter. 1649 

3. For CIRS:  1650 

a) At the command prompt, type: ./cirs.sh start  1651 

b) Press Enter.  1652 

4. To start multiple Tomcat instances:  1653 

a) At the command line, type: ./ictomcat.sh start all  1654 

b) Press Enter. 1655 

5. To start single Web application:  1656 

a) At the command line, type: ./ictomcat.sh start  <servicename> 1657 

b) Press Enter.  1658 

6. For the Oracle iPlanet Server: 1659 

a) Start Oracle iPlanet Web server,  1660 

b) Go to <Oracle-iPlanet-Web-Server_HOME>/admin-server/bin/ path 1661 

c) Type ./startserv 1662 

d) Press Enter. 1663 

e) Go to <Oracle-iPlanet-Web-Server_HOME>/<https-node-name>/bin/ path 1664 

f) Type command ./startserv 1665 

g) Press Enter 1666 

7. For IBM http Web Server  1667 



  

66 

 

a) Change the directory to: AVAYA_IC73_HOME\IC73\bin 1668 

b) At the command line, type: ./httpserver.sh start  1669 

c) Press Enter.  1670 

Start the VMM service (Solaris only)  1671 

If you host your Avaya IC servers on Solaris and have the VMM service configured, you must restart the VMM 1672 
setup service for Voice Chat. The VMM setup service configures the VMM to start automatically.  1673 

You only must perform this step if you host your Avaya IC servers on Solaris. Do not perform this step if you 1674 
host your servers on Windows machines.  1675 

To run the VMM setup script and start the VMM on Solaris:  1676 

1. Navigate to the following directory: IC_INSTALL_DIR/IC73/bin. 1677 

2. At the command line, type: ./vmm_setup start. 1678 

3. Press Enter.  1679 

Start Avaya Agent Web Client 1680 

After you run the IC 7.3.2 installation, you can start the Avaya Agent Web Client component by handling the 1681 
javaw process. 1682 

To start the javaw process 1683 

1. Click Start > Run to open the command prompt. 1684 

2. Change the directory to: AVAYA_IC73_HOME \bin. 1685 

3. Execute the following commands: 1686 

Operating System Procedure 

Windows To start:  

aawcclient.bat start 

Solaris and AIX To start: 

./aawcclient.sh start 

 1687 
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Configurations 1688 

IC 7.3.2 Feature Pack Configuration 1689 

Configuration for WebLM 1690 

Perform the following steps on the machine where WebLM server is installed.  1691 

1. Stop Tomcat server (Stop the WebLM service)  1692 

2. Before upgrading the WebLM server, backup the set of files as described in the table above.  1693 

File/Folder File Location Required Description 

Users.xml – File 

<AVAYA_IC73_HOME>/tomcat/weba
pps/WebLM/admin 

 
 

Yes, if any 
users are 
added that 
are to be 
retained.  

 

This file contains 
the list of users.  

 

 

Product_folder – 
Folder  

 

 

<AVAYA_IC73_HOME>/tomcat/webap
ps/WebLM/data/ 

 

Yes 

The product 
folder that 
contains the 
configuration 
files. E.g aic  

 

 

License file (.xml) 
– File  

 

 

<AVAYA_IC73_HOME>/tomcat/webap
ps/WebLM/licenses 

 

Yes 

 

The installed 
license file  

 

usagehistory.pro
perties – File  

 

<AVAYA_IC73_HOME>/tomcat/webapps/

WebLM/data 
Yes 

 

The Usage 
History 
Information  

 

weblmserver.pro
perties – File  

 

<AVAYA_IC73_HOME>/tomcat/weba
pps/WebLM/data 

 

Yes, if 
WebLM 
configuration 
properties 
have been 
modified  

 

 

The server 
properties file.  

 

 1694 

3. Delete the <AVAYA_IC73_HOME>/tomcat/webapps/WebLM folder.  1695 

4. Start the tomcat server.  1696 

This will extract the new WebLM.war file from the IC732 server installer of respective platforms (AIX, 1697 
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Solaris, and Windows)  1698 
 1699 
5. Stop the tomcat server.  1700 

6. Restore/Overwrite the above set of files in the respective file/folder location.  1701 

7. Locate the server.weblm.xml file normally located under the <AVAYA_IC73_HOME>/tomcat/conf folder. 1702 

8. Open this file using any editor (e.g. Notepad, Textpad, vi – based on OS used). 1703 

9. Go to end of file and add Connector tag for port 52233 which will be used as the HTTPS port for WebLM. 1704 
The following element should be added before the element "</Service>": 1705 

Note:  As per the Licensing Conformance Requirements [125163-M-850], licensed products shall 1706 
utilize port 52233 for HTTPS communication with WebLM server. 1707 

 1708 

Configuration for Tomcat Installation without APR **: 1709 

<Connector acceptCount="100" clientAuth="false" disableUploadTimeout="true" 1710 
enableLookups="false" keystoreFile="${catalina.base}/webapps/WebLM/WEB-INF/weblmserver.p12" 1711 
keystorePass="password" SSLEnabled="true" keystoreType="PKCS12" maxHttpHeaderSize="8192" 1712 
maxSpareThreads="75" maxThreads="150" minSpareThreads="25" port="52233" scheme="https" 1713 
secure="true" sslProtocol="TLS" 1714 
ciphers="SSL_DH_DSS_WITH_3DES_EDE_CBC_SHA,SSL_DH_RSA_WITH_3DES_EDE_CBC_S 1715 
HA,SSL_DHE_DSS_WITH_3DES_EDE_CBC_SHA,SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA, 1716 
SSL_RSA_WITH_3DES_EDE_CBC_SHA,SSL_RSA_FIPS_WITH_3DES_EDE_CBC_SHA,TLS_KR 1717 
B5_WITH_3DES_EDE_CBC_MD5,TLS_KRB5_WITH_3DES_EDE_CBC_SHA,TLS_ECDH_ECDSA_ 1718 
WITH_3DES_EDE_CBC_SHA,TLS_ECDH_RSA_WITH_3DES_EDE_CBC_SHA,TLS_ECDHE_ECD 1719 
SA_WITH_3DES_EDE_CBC_SHA,TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA,TLS_DHE_D 1720 
SS_WITH_AES_128_CBC_SHA,TLS_DHE_DSS_WITH_AES_256_CBC_SHA,TLS_DHE_RSA_WIT 1721 
H_AES_128_CBC_SHA,TLS_DHE_RSA_WITH_AES_256_CBC_SHA,TLS_RSA_WITH_AES_128_ 1722 
CBC_SHA,TLS_RSA_WITH_AES_256_CBC_SHA,TLS_ECDH_ECDSA_WITH_AES_128_CBC_SH 1723 
A,TLS_ECDH_ECDSA_WITH_AES_256_CBC_SHA,TLS_ECDH_RSA_WITH_AES_128_CBC_SHA, 1724 
TLS_ECDH_RSA_WITH_AES_256_CBC_SHA,TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA, 1725 
TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA,TLS_ECDHE_RSA_WITH_AES_128_CBC_SH 1726 
A,TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA"/> 1727 

 1728 

Configuration for Tomcat Installation with APR**: 1729 

<Connector acceptCount="100" clientAuth="false" disableUploadTimeout="true" 1730 
enableLookups="false" SSLPassword="password" SSLEnabled="true" maxHttpHeaderSize="8192" 1731 
maxSpareThreads="75" maxThreads="150" minSpareThreads="25" port="52233" scheme="https" 1732 
secure="true" sslProtocol="TLS" SSLCipherSuite="ALL:!ADH!RC4 - 1733 
IDEA:!LOW:!SSLv2:!EXPORT40!EXPORT56" 1734 
SSLCertificateFile="${catalina.base}/webapps/WebLM/WEB-INF/weblm.crt" 1735 
SSLCertificateKeyFile="${catalina.base}/webapps/WebLM/WEB-INF/weblm.key"/> 1736 

 1737 

Note:  1738 

This is assuming that WebLM is deployed in <tomcat_installation_dir>/webapps folder. Be careful 1739 
while doing a copy paste from this document into the server.xml file. Ensure that the valid quotes are 1740 
copy pasted in the server.xml file. 1741 

 1742 
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10. For the Connectors on port 8080 and 8009, update the value of attribute “redirectPort” from (default) 8443 1743 
to 52233. 1744 

11. Start Tomcat/WebLM service and access WebLM  1745 

12. In the Web browser, enter the URL of the WebLM server in the following format: 1746 

Error! Hyperlink reference not valid. 1747 

Database Configuration for IC 7.3.2 Feature Pack 1748 

Note: This section is mandatory for IC 7.3.2 FP even if Email Template feature is not used. 1749 

Pre-requisites: 1750 

Install IC 732 FP before applying the following configuration changes. 1751 

Database Configuration 1752 

Summary of Configuration changes: 1753 

This service pack ships ccq_732.adl and repository_732.adl  file in 1754 

$AVAYA_IC73_HOME/design/CallCenterQ and $AVAYA_IC73_HOME/design/repository folders respectively. 1755 
If you have made any customizations in these files present with 7.3 RTM installer, you need to manually 1756 
merge your customizations with ccq_732.adl and repository_732.adl before performing database 1757 
administration. 1758 

 The database can be re-configured with the following steps 1759 

 Import new properties TemplateDownload and StatusDownload 1760 

 Update database schema 1761 

o repository.adl Database table changes 1762 

o ccq.adl Database table changes 1763 

o Reconfigure the Database 1764 

Import new properties TemplateDownload and StatusDownload 1765 

a. Log on to the IC732 Database Design machine  1766 

b. Go to command prompt 1767 

c. Change directory to repository data 1768 

> cd /D %AVAYA_IC73_HOME%\design\repository\data 

 1769 

d. Execute the import_properties.bat command by passing arguments <Admin_Name> & 1770 
<Admin_Password>  1771 

for example: 1772 

D:\Avaya\IC73\design\repository\data>import_properties.bat Admin admin1 

IcImportTool 

Version: 7.3.1.3 

--------------------------------------------------- 

javascript:openFileVersion(10965,'O',626,1)
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Converting CSV files to XML 

 

Adding PropSection entries to Intermidiate XML 

... 

Adding Property entries to Intermidiate XML 

... 

Adding PropertyValue entries to Intermidiate XML 

... 

Adding PropertyInstance entries to Intermidiate XML 

... 

Saving Intermidiate XML to Disk 

Done creating D:\Avaya\IC73\etc\prop.xml 

Vesp login in progress 

Vesp login successful 

... 

End property import 

 1773 

e. For more details about success or failure please check the 1774 

<AVAYA_IC73_HOME>\logs\General_Admin.log file. Below is the log snippet of above command 1775 

from General_Admin.log file. 1776 

    17:28:46     Info: main Unknown- Section 'Agent/Desktop/Resources' already 
exists 

    17:28:46     Info: main Unknown- Property: MyResourcesEnabled alreadt exists 

in Section 'Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- PropInstance 1 Already exists for Property 

MyResourcesEnabled Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Property: TemplateDownload created in 

Section 'Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Value All, Description Agent is able 

to view and use templates from all email template folders. Added to property 

TemplateDownload Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Value Selective, Description Agent is 

able to view and use only the email templates from the folders mapped to agent's 

workgroup. However, agent can switch the view to use templates from all the 

folders. Added to property TemplateDownload Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Value Restrictive, Description Agent 

is able to view and use only the email templates from the folders mapped to 

agent's workgroup. The agent cannot switch to any other view. Added to property 

TemplateDownload Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: PropInstance All Added for property 

TemplateDownload in Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Property: StatusDownload created in 

Section 'Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Value All, Description Agent will be 

able to view and use resolve status from all the folders. Added to property 
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StatusDownload Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: Value Restrictive, Description Agent 

will be able to view and use only the resolve statuses from the folders mapped 

to the agent's workgroup. Added to property StatusDownload Section 

Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- NEW: PropInstance All Added for property 

StatusDownload in Section Agent/Desktop/Resources 

    17:28:46     Info: main Unknown- Section 'Agent/Desktop/Spelling' already 

exists 

 

Update Database Schema 1777 

Changes in repository.adl 1778 

 Added a new table qem_folderworkgroup in q_qem tableset. 1779 

The database ccq.adl has following schema changes  1780 

i. Added new COLUMNS in qem_folder, qem_resolvestatus, and qem_template 1781 

(Existing Table Name) {Newly Added Columns} 1782 

(qem_folder) {disabled, lastmodifiedby, inherit} 1783 

(qem_resolvestatus) {lastmodifiedby, lastmodified} 1784 

(qem_template) {lastmodifiedby, lastmodified} 1785 

 1786 

ii. Added new TABLE qem_folderworkgroup 1787 

(New table Name) {Columns} 1788 

(qem_folderworkgroup) {pkey, folder_id, workgroup_id} 1789 

 1790 

iii. Defined TABLESET q_qem by adding tables to it 1791 

(Newly added Table Names to TABLESET q_qem) 1792 

(qem_folderworkgroup, workgroup, employee) 1793 

 1794 

iv. Defined MODULE q_tr_qem by adding new RELATION to it.  1795 

(Newly added RELATION) {TYPE} {FROM TABLES} 1796 

NEW RELATION NAME TYPE TABLES  

qem_template_employee 1: 
Many 

qem_template, employee 

qem_resolvestatus_employee 1: 
Many 

qem_resolvestatus, employee 
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qem_folder_employee 1: 
Many 

qem_folder, employee 

qem_folder_qem_folderworkgroup 1: 
Many 

qem_folder, qem_folderworkgroup 

workgroup_qem_folderworkgroup 1: 
Many 

Workgroup, qem_folderworkgroup 

qem_folderworkgroup Many: 
Many 

NODES:  

qem_folder, qem_folderworkgroup, 

workgroup 

 

EDGES: 

qem_folder_qem_folderworkgroup, 

workgroup_qem_folderworkgroup 

Reconfigure the database 1797 

 1798 

If you have made any customizations in these files present with 7.3 RTM installer, you need to 1799 

manually merge your customizations with ccq_732.adl and repository_732.adl before performing the 1800 

following steps. 1801 

1. Log on to the IC732 Database Design machine. 1802 

2. Launch the Database Designer application. 1803 

3. Using File -> Open menu option select the file 1804 

"...\<AVAYA_IC73_HOME>\design\repository\repository.adl 1805 

4. Reconfigure the database and Generate Windows Application using the normal reconfiguration 1806 

procedure (Please refer Admin guide for detailed steps). 1807 

5. Close the ADL file using File -> Close menu option.  1808 

6. Using File -> Open menu option select the file 1809 

"...\<AVAYA_IC73_HOME>\design\CallCenterQ\ccq.adl 1810 

7. Reconfigure the database and Generate Windows Application using the normal reconfiguration 1811 

procedure (Please refer Admin guide for detailed steps). 1812 

Creating or Reconfiguring RL Manager service 1813 

Perform the only if RLManager is configured or you wish to configure a new RLManager service. 1814 

a. Import <AVAYA_IC73_HOME>\etc\sc.xml in ICManager 1815 

b. Ensure that RL Manager service (Avaya IC Email Template Management Service 7.3) is not 1816 

running 1817 

c. Open the IC Config Tool on the server where RL Manager is deployed (or needs to be 1818 

deployed) 1819 

d. Enable “Configure Email Template Administration” if it is not already enabled. 1820 

e. If “Configure Email Template Administration” is already enabled, disable it and click on “Apply 1821 

Settings”. This will remove the Email Template Administration Service. You will be prompted to 1822 

restart the server. Please do so and start configuration from step ‘b’. 1823 

javascript:openFileVersion(10968,'O',626,1)
javascript:openFileVersion(10968,'O',626,1)
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f. Enter the username of DCOBridge user against “Email Template Administrator Login” 1824 

(example: “dcobridge1”). 1825 

g. Enter the password of DCOBridge user by clicking the “…” button in front of “Email Template 1826 

Administrator Password” (example: “dcobridge1”). 1827 

h. Click on “Apply Settings”.  1828 

i. Wait for a message confirming successful deployment of RL Manager Service. 1829 

j. Click on “Exit” 1830 

 1831 

Web.xml configuration parameters 1832 

Table below describes additional parameters to control message delivery to ICEmail servers. 1833 

Sr. 
No. 

Configuration parameter Default 
value 

Mandatory? Description 

1 rlmanager.vesp.request.rejectch
angerecordcounter 

5 No Controls how many times 
particular change record should 
be resent to ICEmail server in 
case of an error.  

In case ICEmail server faces DB 
error, RLManager will retry to 
send same record. This could 
end up in a loop if ICEmail server 
doesn’t recover from Database 
error. Use this configuration 
parameter to control how many 
times RLManager should try to 
send a particular record to 
ICEmail server. 

2 rlmanager.vesp.request.retrycou
nt 

3 No Controls how many times 
RLManager can retry to send 
VESP command to ICEmail 
server in case of CTI exceptions 
of type CtiCommException, 
CtiDomainException, 
CtiObjectDoesNotExistException, 
CtiResourceException. 

In case of network failure 
between RLManager and 
ICEmail server, RLManager will 
receive CTI exceptions. 

3 rlmanager.vesp.request.retrytime 180000 
milliseconds 

No RLManager uses a queue to 
deliver change record to ICEmail 
server. In case RLManager has 
to retry sending a change record, 
this record is pushed in this 
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queue. 

This configuration parameter 
controls on how frequently retry 
of such change records are to be 
sent. 

4 rlmanager.recreateapi.requestco
unt 

15 No Controls on when to invoke 
ICEmail.RecreateRLManager() 
VESP API when there are 
numerous change records yet to 
be delivered to ICEmail server. 

If there are multiple unsent 
change records in RLManager’s 
queue then this parameter 
decides when to discard those 
change records and call 
ICEmail.RecreateRLManager() 
VESP API (which refresh 
everything in ICEmail server). 

ICEmail configuration (optional) 1834 

Not to recreate Template data on GenericUpdate 1835 

ICEmail clears it’s cached template trees and recreates its in-memory data on a Generic Update.This the 1836 
default behavior.  1837 

To turn off recreating in-memory data on a Generic Update, set TemplRecreateGenUpdas 0 on the 1838 
configuration tab on ICEmail from ICManager. 1839 

A value of 1 will retain the default behavior. 1840 

Enable logging of JSON tree sent to agent (optional) 1841 

The JSON tree that is sent to agent by ICEmail is logged when TemplWriteToFile is set to 1 on the 1842 
configuration tab in ICEMail.  1843 

The JSON tree logs are written to <AVAYA_IC73_HOME>/logs/EmailTemplateEncode.log 1844 

Setting TemplWriteToFile to 0, will be like the default behavior of not logging the JSON tree. 1845 

Both TemplRecreateGenUpd and TemplWriteToFile, can be set through Generic Update. 1846 

Configuration for Security Fixes 1847 

Security configurations for Website: 1848 

 1849 

The security fixes contain changes to the website configuration. Hence, reconfiguration is required on servers 1850 
which host the website application. There are two ways in which this can be achieved: 1851 

 Rerun the configtool for website 1852 
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 Manual changes in the web.xml file 1853 

  1854 

Although it may be better to rerun the configtool for website, customers may follow a manual approach to the 1855 
same in case there are configuration changes done in web.xml file.  1856 

 1857 

When Config Tool is run, it makes necessary changes the web.xml.  For manual changes, following steps can 1858 
be followed: 1859 

1) Add and map the new security filter: 1860 
a) Navigate to <AVAYA_IC73_HOME>\comp\website\WEB_INF 1861 
b) Edit web.xml file 1862 
c) Add the following lines after the SQL injection filter definition (refer to the template file in 1863 

<AVAYA_IC73_HOME>\bin\config\template folder): 1864 

 <filter> 1865 

  <description>This filter will validate the Request and Response. It will 1866 
also set HTTPOnly and secure cookies 1867 

  </description> 1868 

  <display-name>securityFilter</display-name> 1869 

  <filter-name>securityFilter</filter-name> 1870 

  <filter-class>com.quintus.security.SecurityFilter</filter-class> 1871 

  <init-param> 1872 

   <param-name>httponly</param-name> 1873 

   <param-value>true</param-value> 1874 

  </init-param> 1875 

  <init-param> 1876 

   <param-name>redirectParams</param-name> 1877 

   <param-value>aicRedirectURL</param-value> 1878 

  </init-param> 1879 

  <init-param> 1880 

   <param-name>redirectOverride</param-name> 1881 

   <param-value>true</param-value> 1882 

  </init-param> 1883 

  <init-param> 1884 

   <param-name>validateParams</param-name> 1885 

   <param- 1886 
value>aicEscRequestedMedia=chat,email,fax,callback,pvchat,ivchat</param-value> 1887 

  </init-param> 1888 

  <init-param> 1889 

   <param-name>exceptions</param-name> 1890 

   <param-value>chat_escalate</param-value> 1891 

  </init-param> 1892 
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 </filter> 1893 

 <filter-mapping> 1894 

  <filter-name>securityFilter</filter-name> 1895 

  <url-pattern>/*</url-pattern> 1896 

 </filter-mapping> 1897 

2) If making changes on the server hosting the Admin site, also enable the SQL Injection filter by 1898 
removing the surrounding comment tags. 1899 

3) Add Valve configuration 1900 
a) Navigate to <AVAYA_IC73_HOME>\tomcat\conf folder 1901 
b) Edit the server.website.xml file 1902 
c) Add the following lines after the "Context" definition (refer to the template file in 1903 

<AVAYA_IC73_HOME>\bin\config\template folder): 1904 

    <Valve className="org.tomcat.valves.sessionFixationValve" /> 1905 

      1906 

Other security recommendations for Website: 1907 

The following configurations/changes are recommended for improving the security of  Avaya IC application. 1908 

 Always deploy Public and Administration website on separate servers 1909 

 Keep the server hosting the Administration website inside of the firewall 1910 

 Always enable HTTPS and disable HTTP for webserver and the tomcat application Turn off directory 1911 
browsing for the website on the webserver 1912 

 Turn off Anonymous access to website related files/folders by the webserver application        1913 

 1914 

Note: Recommendations #1 & 2 would help secure IC website against the following vulnerability 1915 

(wi01123999): 1916 

A malicious user that can guess the path to the web interfaces can potentially guess or brute force a 1917 

password to gain administrative control of the application. 1918 

Deployment of AAWC: 1919 

1. Generate the webclient.war file by running the "wargenerater.bat" file available in the  1920 
<AVAYA_IC73_HOME> folder. 1921 

2. Copy the generated war file to the AAWC Connector machine. 1922 
3. Stop the AAWC application. 1923 
4. Deploy the newly generated war file on tomcat, by copying the war file to  1924 

  <AVAYA_IC73_HOME>\tomcat\Avaya\war folder 1925 
5. Delete the “avaya” or “avaya#agent” present at location  1926 

<AVAYA_IC73_HOME>\tomcat\webapps\ 1927 
6. Delete the “avaya_agent” folder present at  1928 
7. <AVAYA_IC73_HOME>\tomcat\work\Catalina\localhost\ 1929 
8. Start the AAWC application 1930 

 1931 
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Configuration for the IIS to deny requests containing sensitive 1932 

URLs 1933 

The changes are related to have IIS deny requests containing sensitive URLs. For 1934 
example, by default IIS restricts all requests trying to serve content from the 1935 
'bin' folder. However, as WEB-INF is a tomcat thingy, we will need to 1936 
specifically tell IIS to not to serve these URLs. Here are screenshots for the 1937 
same: 1938 

 1939 

 1940 

 1941 
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 1942 

 1943 

 1944 
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 1945 

Again, some JS (static) and css files are served by IIS, and hence the tomcat 1946 
filter does not come into effect, therefore the headers are not present. 1947 

However, we don’t really need this header in case of content without frames, so 1948 
this should not really be an issue. 1949 

Configuration for AUX Reason code for RONA: 1950 

TS does not use any specific reason code for a RONA call with Advocate.  TS uses the default AUX reason 1951 
code configured in the TS configuration. This might create issues for reporting, since the default AUX reason 1952 
code might not be desired for RONA calls. 1953 

 1954 

The new feature would enable TS to use a configured “AUX reason code for RONA” in the RONA scenario. 1955 
This would help in isolating the calls that RONAed based on the reason code. 1956 

This feature is supported with AARC, AAWC, SDK and not supported with Siebel hybrid and native client. 1957 

Steps to configure AUX reason code to be used in case of RONA: 1958 

1) In IC Manager, open TS configuration and navigate to the TS server tab 1959 
2) Right click and enable the advanced properties 1960 
3) In the Rona Reason code, select a reason code.  The reason code selected here should be pre- 1961 

configured under codes, in the IC manager. 1962 
4) Ensure that the value set in Agent/Desktop/AuxRonaReasonCode is in sync with the Rona code 1963 

entered in TS configuration.   1964 

5) Restart the TS server. 1965 

 1966 
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Note: This is applicable to IC Business Advocate configuration. In case of non-BA systems, these 1967 
configurations would not be used.  System should not be set to use CM RONA as well as IC RONA. 1968 

 1969 

Exit_reason for RONA calls: 1970 

TS sets the container exit_reason to either “rerouted” or “normal” for RONA calls and this makes it difficult to 1971 
report RONA calls in IC reporting 1972 

 1973 

The change would be consistent with other media (email and chat) and the exit_reason would be “RONA” for 1974 
both Advocate and Non-Advocate systems. Customers can now query the exit_reason to determine the 1975 
RONA calls.   There are no configuration changes needed for this feature to work. 1976 

Configuration for Inactivity timeout for Chat Disconnect: 1977 

A provision has been added to the  OOTB IC public website wherein the ongoing live chat between the 1978 
customer and the Agent will get automatically disconnected in case the customer inactivity crosses the 1979 
disconnect time set. This functionality is applicable for “Chat” as well as for “Chat and Callback” of IC public 1980 
website 1981 

Procedure to add the metadata properties for the above feature. 1982 

1. In a Web browser, navigate to the IC Website Administration page.  1983 

http://<server_name>/website/admin/login.jsp.  1984 

2. Enter the user name and password and click Next to log in to the IC Website administration page.  1985 

3. Access the add metadata page.  1986 

http://<server_name>/website/admin/tenancy/addmd.jsp  1987 

 1988 

4. Add the following metadata properties:  1989 

 Metadata name = chat.htmlclient.customer.inactivitytimer.enabled  1990 

 Default value = false.  1991 

 Description = This flag determines whether chat inactivity timer is enabled or is disabled. Valid values 1992 
are true/false. 1993 

 Tenant Property(checked) 1994 

 1995 

5. Click Add Metadata.  1996 

6. Add the following metadata properties:  1997 

 Metadata name = chat.htmlclient.customer.inactivity.totaltime  1998 

 Default value = 10 1999 

 Description = Total time (in minutes) that an active ongoing chat can continue without getting 2000 
disconnected owing to customer inactivity. Minimum value can be 1 minute. 2001 

 Tenant Property(checked) 2002 
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 2003 

7. Click Add Metadata.  2004 

8. Add the following metadata properties:  2005 

 Metadata name = chat.htmlclient.customer.inactivity.countdowntime 2006 

 Default value = 60,10  2007 

 Description = The first value (in secs) determines the time duration for which a inactivity warning 2008 
messsage would be displayed to the customer.Default is 60 secs. 2009 

 The second value (in secs) determines the duration for which the countdown timer changes color to 2010 
signify that chat disconnection time is closing upon.Default is 10 secs. 2011 

 Tenant Property(checked) 2012 

 2013 

9. The following property is optional and is only used if Chat Inactivity feature needs to be enabled for "Join 2014 
Us" customers as well. 2015 

 Click Add Metadata.  2016 

 Add the following metadata properties:  2017 

Metadata name = chat.htmlclient.customerjs.inactivitytimer.enabled 2018 

Default value = false 2019 

Description = This flag determines whether chat inactivity timer is enabled or is disabled for 2020 
JoinUS customer.Valid values are true/false. 2021 

Tenant Property(checked) 2022 

 2023 

10. In case the above tenant values requires to be changed , then it can be changed from the IC Multitenant 2024 
administration page. 2025 

 Traverse to http://<server_name>/website/admin/index.jsp page and select "IC website Multi Tenant 2026 
Administration" 2027 

 Click Tenant Properties and select the appropriate tenant. 2028 

 Click "chat". 2029 

 Search for following meta data chat property and make appropriate changes to their values. 2030 

a. chat.htmlclient.customer.inactivitytimer.enabled  2031 

b. chat.htmlclient.customer.inactivity.totaltime 2032 

c. chat.htmlclient.customer.inactivity.countdowntime 2033 

d. chat.htmlclient.customerjs.inactivitytimer.enabled 2034 

 2035 

Note: if "chat.htmlclient.customerjs.inactivitytimer.enabled" is set to true then 2036 
"chat.htmlclient.customer.inactivitytimer.enabled" has to be "true" as well. 2037 

 2038 

14. Click "Update Data" set the above tenant property values. 2039 
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Note :  2040 

 Even if the agent is actively chatting but the customer is not typing in anything, then such a chat would be 2041 
disconnected after the customer inactivity time crosses the disconnect interval 2042 

 This feature is only available for chat only and doesn't support the case where the customer is 2043 
simultaneously using cobrowse/collaboration. In such a scenario the customer still has to press in any key 2044 
to keep the chat active. 2045 

 The above feature is useful only in case where customer wants a disconnection feature on the customer 2046 
end and customer doesn't use the collaboration/cobrowse feature. 2047 

The ResetScriptIteration setting for WACD 2048 

Please refer to IC 7.3.1 Service pack configuration section.  2049 

Note: 2050 

This is applicable if IC is upgraded from IC 7.3 or IC 7.3.1 SP. 2051 

IIS-Tomcat Redirector configuration  2052 

When you host a customer website on Internet Information Services (IIS), a third-party ISAPI filter is used to 2053 
redirect requests for the IC website to the Tomcat server that hosts the Web Management Service. This filter 2054 
(isapi_redirect.dll) is also known as Tomcat Redirector. The Tomcat Redirector has been upgraded in this 2055 
service pack 2056 

IC ships Tomcat Redirector with the RTM installer for customers to use the filter, if required. When you deploy 2057 
the IC website, the configuration tool installs the ISAPI filter to be used with IIS on Windows. 2058 

For the Tomcat Redirector to function properly, certain configurations are required on the IIS side: 2059 

The application pool, under which the website runs, must have worker recycling disabled. 2060 

1. To determine the application pool under which the website runs, click the website, and select 2061 
Advanced Settings in the Actions panel. The Application Pool used for the website can be read or 2062 
set from the dialog box that the system displays. Note the application pool used. 2063 

2.  Click the Application Pool Node. Select the application pool noted in the previous step, and click 2064 
Advanced Settings from the Action panel. 2065 

3. Make the following changes to the settings:  2066 
a. Set Limit Interval under CPU to 0. 2067 
b. Set Idle Time-out under Process Model to 0.  2068 
c. Set Regular Time Interval under Recycling to 0.  2069 
d. Set Disable Recycling for configuration changes under Recycling to true. 2070 

Typically, the Tomcat Redirector is installed on a customer facing website, and the Tomcat server resides in 2071 
the local LAN across a firewall. Problems can occur with idle connections due to firewalls that are often 2072 
deployed between the web server layer and the backend. Depending on the configuration, the firewall can 2073 
silently drop connections from their status table after the configuration. The Tomcat Redirector and the 2074 
Tomcat server will treat this situation as when the other side is not answering any traffic.  2075 

However, since TCP is a reliable protocol, it detects the missing TCP ACKs and tries to resend the packets 2076 
for a relatively long time, typically several minutes. Therefore, the Tomcat Redirector or Tomcat server will not 2077 
be able to detect connection loss until after some time.  2078 
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Firewall related configurations are provided to minimize issues due to connection drops due to firewall 2079 
timeouts: 2080 

1. You must always use connection_pool_timeout and connection_pool_minsize on the Tomcat 2081 
Redirector side and connectionTimeout on the Tomcat side to prevent idle connection drop. 2082 

2. The recommended value for the connection_pool_timeout parameter is approximately 10 minutes. 2083 
Therefore, set the value for the connection_pool_timeout parameter to 600 seconds. If you use this 2084 
attribute, also set the attribute connectionTimeout in the AJP Connector element of your Tomcat 2085 
website.server.xml configuration file to an analogous value. 2086 
Note: The connectionTimeout parameter is in milliseconds. Therefore, if you set Tomcat Redirector 2087 
connection_pool_timeout to 600, you should set the Tomcat connectionTimeout parameter to 2088 
600000.  2089 

The Tomcat Redirector has been upgraded in this service pack and consequently some of the directives used 2090 
in the Tomcat Redirector configuration files have changed. For details on deprecated directives, refer to: 2091 
http://tomcat.apache.org/ connectors-doc/reference/workers.html 2092 

Allowing non-RFC compliant emails to be processed by AIC 2093 

From IC 7.3 onwards, the Poller server checks email headers, From/Sender/ReplyTo, for RFC compliance. 2094 
By default, if none of these headers are compliant to RFC then such an email will remain on the email server 2095 
and the Poller server will alarm every polling interval about this email until it is cleared from the mailbox. To 2096 
disable or enable RFC compliance, a new configuration value for the Poller server has been provided. For 2097 
more information, refer to wi00845454. 2098 

Allowing Poller Server to download NON-RFC compliant emails to into the system:  2099 

(NON-RFC compliance is based on invalid from/sender/reply-to addresses) 2100 

4. Log in to ICManager using admin account. 2101 

5. Click the Server tab. 2102 

6. Double-click the Poller server.    2103 

7. Click the Configuration tab. 2104 

8. Add a new Couple with name: DisableEmailAddressRFCCheck. 2105 

9. Values are: 2106 

 1 - Turn OFF RFC compliant checking. 2107 

 0 - Turn ON RFC compliant checking. 2108 

Note: Not adding this value or adding any value apart from 1 will enable this feature.  2109 

Such emails with invalid from/sender/reply-to addresses will be bounced by the Poller server's SPAM 2110 
plugin through the email server to the bounce address of the respective Mail Account from which the 2111 
email was polled. Unless the flag “DisableRFCCheckInSpamPlugin”, mentioned in following point, 2 is 2112 
used. 2113 

10. Click OK. 2114 

11. Restart the Poller server. 2115 

http://tomcat.apache.org/%20connectors-doc/reference/workers.html
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Configuring the Poller server to allow NON-RFC compliant 2116 

emails to be delivered to agent:  2117 

1. Click the Server tab. 2118 

2. Double-click the Poller server. 2119 

3. Click the Configuration tab. 2120 

4. Add a new Couple with name: DisableRFCCheckInSpamPlugin.  2121 

Values are: 2122 

 1 - Turn OFF SPAM RFC checking 2123 

 0 - Turn ON SPAM RFC checking 2124 

Note: Not adding this value or adding any value apart from 1 will enable this feature. 2125 

5. Click OK. 2126 

6. Restart the Poller Server. 2127 

Non-RFC compliance is based on invalid from/sender/reply-to addresses. 2128 

Configuring a substitute email address which will be shown 2129 

to the agent: 2130 

Substitute email address will be used in place of FROM address of the incoming email in case the email 2131 
MIME does not contain FROM address or contains an invalid one. 2132 

1. Click the Server tab. 2133 

2. Double-click the Poller server. 2134 

3. Click the Configuration tab. 2135 

4. Add a new Couple with name: SubstitueFromAddress. 2136 

5. Value: Any valid email address. 2137 

Note: If email address is not provided or an invalid email address is provided, the respective polling 2138 
account’s bounce email address will be used as a substitute address. 2139 

6. Click OK. 2140 

7. Restart the Poller Server. 2141 

New Connection properties for SDK login issue 2142 

SDK agents cannot login after network issue. To resolve this issue, following properties can be configured in 2143 
web.xml 2144 

 2145 

basicservices.cacherefreshattempt:  2146 

Specifies the maximum number of attempts to retrieve the data from DB if there are 2147 

problems while retrieving data. The default value is 60 attempts. 2148 

 2149 

basicservices.cacherefreshinterval:  2150 

Specifies the interval in milliseconds between two attempts. The default value is 1000 milliseconds. 2151 
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IC 7.3.1 Service Pack Configuration 2152 

Avaya Agent Web Client (AAWC) Configuration 2153 

Perform the following steps on the windows machine where AAWC is installed: 2154 

1. Create the new webclient.war file using wargenerator.bat on WebClient machine.  2155 

2. Redeploy the newly created webclient.war file on WebClient Connector machine. For more information, 2156 
refer IC 7.3 Installation and Configuration.pdf. 2157 

Note: To generate webclient.war file and deploy on Windows/AIX/Solaris Webconnector machines, refer to 2158 
"IC7.3 Installation and Configuration guide" in Avaya Support Site http://support.avaya.com 2159 

Avaya Agent Rich Client (AARC) Configuration 2160 

Perform the following steps if WACEngine_PerformConsoleAction.qsc file is not updated as per below steps 2161 
on the Design and Admin machine for Windows: 2162 

1. Exit the Avaya Agent if it is running. 2163 

2. Backup the following files: 2164 

   ...\IC73\design\QConsole\WACEngine_PerformConsoleAction.qsc 2165 

3. Locate the following in the script. 2166 

   Else 2167 

    If Len(sHTTPExecutable) = 0 Then 2168 

     lReturn = ShellExecuteA(0, "open", sParameter, "", "", 1) 2169 

    Else 2170 

     lReturn = Shell(sHTTPExecutable, ebNormalFocus)   2171 

     lReturn = ShellExecuteA(0, "open", sParameter, "", "", 1) 2172 

    End If     2173 

   End If 2174 

4. Replace the middle IF-Else-End If statements with a single line so that it looks like as shown. 2175 

                        Else 2176 

                                lReturn = ShellExecuteA(0, "open", sParameter, "", "", 1) 2177 

   End If 2178 

  2179 

5. Start the Avaya Database Designer. 2180 

6. Push the scripts to the database. 2181 

 2182 

SDK Server Configuration 2183 

You need to manually replace the IC SDK Server files installed on the Windows, Solaris, and AIX platforms if 2184 

http://support.avaya.com/
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IC SDK Server is installed and configured. 2185 

Perform the following configuration steps to replace the files: 2186 

Stop the IC SDK Service, if running, on the applicable platforms using following: 2187 

Windows: 2188 

Start the Windows Services application. 2189 

Stop the IC SDK Service. 2190 

Solaris/AIX: 2191 

At the command line, type: ./ictomcat.sh stop SDK -force 2192 

Press Enter. 2193 

Backup the following files from the ..\IC73\sdk\server\icsdk\WEB-INF\lib\ location and Manually copy the following 2194 
files from the IC 7.3.2 Service Pack to the ..\IC73\sdk\server\icsdk\WEBINF\ lib folder: 2195 

 avaya-ic-services.jar 2196 

 avaya-ic-webui.jar 2197 

 avaya-ic-sdk-common.jar 2198 

 avaya-ic-sdk-server.jar 2199 

 avaya-common.jar 2200 

 avayai ccommon.j ar  2201 

 avayaaut h.j ar  2202 

 avaya-i c-sdk-sampl e.j ar  2203 

 avaya-i c-appl i cat i on.j ar  2204 

 WebAgent .j ar  2205 

 2206 

Backup following files from ..\IC73\sdk\design\dotnet\lib folder and manually copy the following files from 2207 

sdk folder of IC 7.3.2 Service Pack to the ..\IC73\sdk\design\dotnet\lib folder: 2208 

 AvayaICSDKClient.dll 2209 

 AvayaICSDKClient.pdb 2210 

 AvayaICSDKClient.xml 2211 

 Com.Avaya.Util.dll 2212 

 Com.Avaya.Util.Messaging.dll 2213 

 Com.Avaya.Util.Messaging.pdb 2214 

 Com.Avaya.Util.pdb 2215 

 CSharptester.pdb 2216 

Backup following files from sdk\design\dotnet\sample\bin folder and manually copy the following files from 2217 

sdk folder of IC 7.3.1 Service Pack to the ..\IC73\sdk\design\dotnet\sample\bin folder: 2218 
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 AvayaICSDKClient.dll 2219 

 AvayaICSDKClient.pdb 2220 

 AvayaICSDKClient.xml 2221 

 Com.Avaya.Util.dll 2222 

 Com.Avaya.Util.Messaging.dll 2223 

 Com.Avaya.Util.Messaging.pdb 2224 

 Com.Avaya.Util.pdb 2225 

 CSharptester.exe 2226 

 CSharptester.pdb 2227 

Backup the following folders from the specified folder location and manually copy the following from the IC 7.3.1 2228 
Service Pack to the specified folder location: 2229 

 The Controller and UI folders from sdk\design\dotnet\sample\src\Com.Avaya.Ic.Sdk.Sampleclient. 2230 

 The MSDN folder from sdk\design\dotnet\doc. 2231 

 The Doc folder from sdk\design\java\doc. 2232 

 The src folder from sdk\design\java\sample. 2233 

Ensure that the newly copied files have the same read/execute permissions as the backed-up files. 2234 

Start IC SDK Service on the applicable platforms: 2235 

Windows: 2236 

i. Start the Windows Services application. 2237 

ii. Start Avaya SDK Services 2238 

Solaris/AIX: 2239 

i. At the command line, type: ./ictomcat.sh start SDK. 2240 

ii. Press Enter. 2241 

Optional Security Configuration for IC Public Website for 2242 

Modern day browsers 2243 

Note: These changes are not applicable to IC 7.3.2 SP and onwards. 2244 

Modern day browsers like IE8, IE9, Chrome 21, and so on have implemented security enhancements 2245 
including Clickjacking Defense. This implementation can result in the website not being accessible when 2246 
frames are used. IC website can be secured against such attacks by adding a new element in web.xml file. 2247 

Perform the following steps on the machines where website is installed. This is applicable for all platforms. If 2248 
the admin and public websites are configured on separate machines, perform this for the public website. 2249 

1. Stop website service. 2250 

2. Browse to the following folder on the machine where the website is installed: 2251 
<AVAYA_IC73_HOME>/comp/website/WEB-INF and backup the web.xml file.  2252 

3. Open the web.xml file for editing.  2253 
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4. Add the element as highlighted: 2254 

<servlet> 2255 

        <servlet-name> 2256 

            InitServlet 2257 

        </servlet-name> 2258 

        <servlet-class>com.quintus.servlet.InitServlet</servlet-class> 2259 

………… 2260 

………… 2261 

     <init-param> 2262 

     <param-name>xFrame</param-name> 2263 

     <param-value>SAMEORIGIN</param-value> 2264 

 </init-param> 2265 

<load-on-startup>1</load-on-startup>  2266 

 </servlet>  2267 

5. Delete the folder "<AVAYA_IC73_HOME>/tomcat/work/Catalina/localhost/website" for cleaning 2268 
tomcat cache. 2269 

6. Start the website service. 2270 

Optional Security Configuration to prevent SQL Injection attack 2271 

on IC Admin Website 2272 

A new filter, sqlAttackFilter, must be activated as part of the website configuration. This activation guards 2273 

against any SQL injection attacks on the Admin website.  2274 

This attribute represents a group of SQL keywords. If these attributes are encountered in the http request 2275 

stream, they would be blocked from being executed on the server.  2276 

<param-name>sqlAttackPattern</param-name> 2277 

By default, all the admin websites pages other than the ones mentioned as part of sqliByPassURLPattern init 2278 

parameter would be checked against these key words for possible SQLI attacks. If a potential SQL Injection 2279 

attack is detected the session is invalidated and error page is displayed. 2280 

There are two parameters: 2281 

 <param-name>sqliByPassURLPattern</param-name> 2282 

This parameter indicates which all URL patterns of the admin website needs to be bypassed for detection of 2283 

SQLI attacks. These admin pages URL with the listed patterns, when detected, would only be checked 2284 

against the "sqlHTTPAttackString" parameter values. 2285 

 <param-name>sqlHTTPAttackString</param-name> 2286 

The URLs, which are mentioned as part of the “sqliByPassURLPattern” init parameter, would only be tested 2287 

for these HTTP SQL attack strings. 2288 

Perform the following steps on the machines where website is installed. This is applicable for all platforms. If 2289 
the admin and public websites are configured on separate machines, perform this for the admin website. 2290 
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1. Stop website service. 2291 

2. Browse to the following folder on the machine where website is installed: 2292 
<AVAYA_IC73_HOME>/comp/website/WEB-INF and backup the web.xml file.  2293 

3. Open the web.xml file for editing.  2294 

4. Add the element as highlighted: 2295 

<filter> 2296 

  <description>This filter is used to detect SQLI.</description> 2297 

  <display-name>sqlAttackFilter</display-name> 2298 

  <filter-name>sqlAttackFilter</filter-name> 2299 

  <filter-class>com.quintus.security.sqlAttackFilter</filter- 2300 
class>   2301 

  <init-param> 2302 

  <param-name>sqlAttackPattern</param-name> 2303 

  <param-value> create, alter, drop, rename, select, insert, 2304 
update, delete, grant, revoke,@@version, exec, union, waitfor, order by, 2305 
case when, utl_,  winhttp</param-value> 2306 

  </init-param>   2307 

  <init-param> 2308 

  <param-name>sqlHTTPAttackString</param-name> 2309 

  <param-value> utl_, winhttp</param-value> 2310 

  </init-param> 2311 

  <init-param> 2312 

  <param-name>sqliByPassURLPattern</param-name> 2313 

  <param- 2314 
value>category=account,category=escalate,category=website</param-value> 2315 

  </init-param> 2316 

 </filter> 2317 

 <filter-mapping> 2318 

  <filter-name>sqlAttackFilter</filter-name> 2319 

  <url-pattern>/admin/*</url-pattern> 2320 

 </filter-mapping> 2321 

5. Delete folder "<AVAYA_IC73_HOME>/tomcat/work/Catalina/localhost/website" for cleaning tomcat 2322 
cache. 2323 

6. Start website service. 2324 



  

90 

 

UTF-8 Encoding for outgoing emails from WebAgent 2325 

The current behavior is an agent can select a character set of an outgoing email. If the agent does not select 2326 
any character set exclusively, a default character set that is usually the top character set in the list, gets 2327 
selected which can cause issues with email rendering at the end customer. 2328 

To address such issues, the WebAgent behavior has been changed in SP 7.3.1 to check if an email body can 2329 
be encoded using UTF-8 encoding irrespective of the character set selected by the agent. 2330 

An email will be sent with UTF-8 encoding when the following conditions are met: 2331 

1. The email body of the outgoing email cannot be completely encoded in the selected character set 2332 
either explicitly selected by the agent or by default selection. 2333 

AND 2334 

2. Either one or both of the following conditions: 2335 

 Attribute ‘email.charsetdetection.coverttoutf8’ is set to true.  2336 

 If an email body can be completely encoded using UTF-8.  2337 

In all other cases, an email is sent in the selected character set. 2338 

Note: The default value of the parameter email.charsetdetection.coverttoutf8 is ‘true’.  It can be set to ‘false’ 2339 
using the steps below 2340 

1. On the AARC machine, open <AVAYA_IC73_HOME>\Webagent\Application.properties file using a 2341 
text editor. 2342 

2. Search if the email.charsetdetection.coverttoutf8’ parameter is present or add if it is not present. 2343 

3. Change or add the following: 2344 

Email.charsetdetection.converttoutf8 = false 2345 

Note: If the parameter email.charsetdetection.coverttoutf8 is not present in Application.properties file, the 2346 
behavior is same as when the value is ‘true’. 2347 

Log Collector Configuration 2348 

1. Perform these steps only if your setup had Log Collector configured to collect the log files prior to the 2349 
installation of SP 7.3.1. Close all instances of LogCollectorClient that may be running on your Design 2350 
and Admin machine. 2351 

2. Deleting existing LogCollector instances: 2352 

a. Log in to IC Manager as Admin. 2353 

b. Stop all instances of LogCollector server. 2354 

c. Delete all instances of LogCollector server. 2355 

3. Importing the sc.xml file 2356 

Perform the following steps on Design and Admin machines: 2357 

a. Log in to IC Manager as Admin. 2358 

b. From the IC Manager, click Manager > Options > Environment tab. 2359 

c. Click the Import Configuration button. 2360 

d. From the Open dialog box, select the sc.xml file and click the Open button. 2361 
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e. If the file is successfully validated, the validate sc.xml dialog box displays a Successfully 2362 
Validated message.  2363 

f. If the validation is unsuccessful you will get an xml parsing error. In this case, address the issues 2364 
causing the error and perform the steps from 3.c again. 2365 

 Note: If you have merged any previous customization changes in the new sc.xml file, check the 2366 
xml syntax for well-formedness and import the sc.xml file again. 2367 

Siebel AICD Server Logging 2368 

Siebel AICD logging is enhanced to allow configuring file count and file size. These parameters are 2369 
configured in the AICD.ini file. Follow the steps below for increasing the log file size or log file count. 2370 

Steps to increase log file size and log file count:  2371 

1. Shutdown the Communications Session Manager component from the Siebel Server Administration 2372 
screen, if it is already running. 2373 

2. Open the AICD.ini file from Siebel Server's bin directory or the location of the AICD installation in any 2374 
text editor like Notepad. 2375 

3. Add the section following the "Version" section in the AICD.ini file. The values specified below are 2376 
given as examples. You can replace them with any other numeric values according to your 2377 
requirements. The file size is measured in bytes here.   2378 

[SiebelAICDLog] 2379 

FileCount = 5 2380 

FileSize = 25000000 2381 

Save and close the AICD.ini file. 2382 

4. Start the Communications Session Manager component from the Siebel Server Administration 2383 
screen. 2384 

The default values used when these parameters are not configured are: 2385 

 FileCount = 2 2386 

 FileSize = 2000000 2387 

Website Logging 2388 

Prior to SP 7.3.1, the MTT logging and Tomcat webserver logging for website were captured in the 2389 
website.log (default) log file. This behavior has changed from SP 7.3.1 onwards. 2390 

Following is the summary of changes: 2391 

1. The MTT logging will continue to be captured in the “website.log”, whereas the Tomcat webserver logging 2392 
for website will now be captured in the “website_debug.log” file.  2393 

2. If the website global name is other than Website, then the log file name is according to the global name , 2394 
i.e. <website_context_global_name>_debug.log. Refer to the IC 73 Installation and Configuration guide 2395 
on how the website_context_global_name is specified. It must be the same as dsObject Name as 2396 
specified in web.xml file of website. 2397 

3. The maximum log file size specified as part of the ICManager website configuration applies to the 2398 
website_debug.log. If there is no size specified, then the default website_debug.log size is 25-MB. 2399 
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After website_debug.log crosses the maximum size, it rolls over into website_debug.log.bak and a new 2400 
website_debug.log file is created to continue the logging. 2401 

Viewing Chat Transcript 2402 

View Transcript functionality in WACD Admin pages under IC Web Self Service -> View Transcripts has been 2403 
modified from SP 7.3.1 onwards.  2404 

Following is the summary of changes: 2405 

1. A new search functionality has been added. You can now type or paste a Chat ID (EDU ID) in the “Call 2406 
ID” text box and click the ‘Submit Query’ button below the search box to see the transcript for that Chat 2407 
ID. 2408 

2. The existing Select a Task-ID drop-down continues to be present. However, the maximum number of 2409 
Chat IDs fetched from the database (DB) to populate in the drop-down list is restricted. 2410 

3. Click the ‘Submit Query’ button after selecting a Task ID from the Select a Task-ID drop-down list to 2411 
display the transcript for the Chat ID selected for the first time. Thereafter, upon selection, the drop-down 2412 
will display the transcript for the selected Chat ID. 2413 

4. The number of records populated in the “Select a Task-ID” drop-down is based on the following 2414 
parameters that can be customized in <AVAYA_IC73_HOME>\comp\website\admin\wtc\transcript.jsp. 2415 
This parameter is configured in “<AVAYA_IC73_HOME>\comp\website\admin\wtc\ transcript.jsp” file 2416 

a. DefaultNTaskID: The value of this parameter defines the number of Records to be fetched from 2417 
DB. This is the value used to query the DB when the Select a Task-ID drop-down list is 2418 
populated. 2419 

i. The default value is 200. This is can be customized to a different value between 1 and 2420 
1000. 2421 

ii. Any value less than 1 will be treated as 200 (default) 2422 

iii. Any value more than 1000 will be treated as 1000 2423 

b. LastNTaskID: Last N No. Records to be fetched from DB. This is configured in 2424 
“<AVAYA_IC73_HOME>\comp\website\admin\wtc\ transcript.jsp” via DefaultNTaskID parameter. 2425 

i. Default value is 200 which is set via DefaultNTaskID 2426 

ii. If LastNTaskID <=0 set LastNTaskID=DefaultNTaskID and if LastNTaskID>MaxRecord 2427 
then set LastNTaskID=MaxRecord 2428 

iii. If NTaskID is less than or equal to 0 , that is, invalid value that this value will be set to 2429 
DefaultNTaskID 2430 

iv. If admin set LastNTaskID which is greater than 1000, which is also invalid than 2431 
LastNTaskID will be set to 1000 2432 

c. To make the changes follow the given instructions: 2433 

i. Stop the IC Website service on the IC server where website is deployed. 2434 

ii. Navigate to the <AVAYA_IC73_HOME>\tomcat\work\Catalina\localhost\ directory and 2435 
delete the folder ‘website’ 2436 

iii. Browse to “<AVAYA_IC73_HOME>\comp\website\admin\wtc\ and open transcript.jsp 2437 

iv. Locate the following statement: 2438 

int defaultNTaskID = 200; 2439 
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v. Change the value from 200 to any value between 1 and 1000. 2440 

vi. Save and close transcript.jsp. 2441 

vii. Start the IC Website service on the IC server where website is deployed.   2442 

Enhance the logging information of the WSCallback server 2443 

After applying the Service Pack: 2444 

1. Go to the <Avaya_IC_Home>\logs folder and delete the wscallback.log 2445 

2. Start the WSCallBack Server via the IC Manager. 2446 

3. For getting higher level debug logs change the log level to "4" via the IC Manager and editing the 2447 
properties of the WSCallback server.(Debug tab). 2448 

Preventing duplicate chat 2449 

Majority of the IC customers using the chat channel use the out-of-the-box (OOTB) website core engine to 2450 
escalate chat into the IC system.  2451 

The OOB chat gathers user inputs using the escalate.jsp page .Thereafter, the customer is directed to the 2452 
htmlcclient.jsp page where the actual chat begins with an agent. All the requisite parameters required for 2453 
successful chat escalation are in the form of request parameters appended to the htmlclcient.jsp URL.  2454 

There is a possibility that a chat might be re-escalated within the IC system in following scenarios:  2455 

 Some browsers provide the facility of storing and reopening the last browsed-session pages. 2456 
Therefore, if the user closes the browser after the chat ends, there is a possibility that the chat might 2457 
get re-escalated within the IC system unintentionally. 2458 

 The user unintentionally refreshes the page after the chat ends.  2459 

The expected behavior is that the user must fill in the details and the initial question for every attempt to 2460 
escalate a live chat to an Agent. 2461 

Note: Only Avaya APS or Avaya channel partners must perform the following procedure: 2462 

To enable the prevention of redundant chat for the customized chat solution, perform the following steps:. 2463 

1. Add specific Metadata properties. 2464 
2. Set/Unset specific browser cookie attributes. 2465 
3. Set specific attributes as part of the Java HttpSession Object.  2466 
4. Change the Warning text messages of the redirected URL, if  required. 2467 

Add the following metadata properties 2468 

1. In a Web browser, navigate to the IC Website administration page. 2469 

Error! Hyperlink reference not valid.. 2470 

2. Enter the user name and password and click Next to log in to the IC Website administration page. 2471 

3. Access the add metadata page. 2472 

Error! Hyperlink reference not valid. 2473 

4. Add the following metadata properties: 2474 

● Metadata name = chat.htmlclient.redundant.action 2475 
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● Default value = none. Change this value to one of the other values as specified in the Description. 2476 

● Description = Determines what action must be taken after redundant chat is detected. Valid values 2477 
are redirect, alert, custom or none. 2478 

Note: The “custom” value must be used only if Avaya APS or channel partners who deploy the SP provide 2479 
some other custom solution. 2480 

5. Click Add Metadata. 2481 

6. Add the following metadata properties: 2482 

● Metadata name = chat.htmlclient.undocked.sessionexpirepage 2483 

● Default value = htmlclient/chatsessionexpire.jsp 2484 

● Description = For undocked chat, determines which page must be shown if the customer tries to 2485 
escalate a chat by refreshing the undocked chat page, chatFrame.jsp. 2486 

 This particular page must be at the following directory location: 2487 
%AVAYA_IC73_HOME%\comp\website\public folder. 2488 

9. Close the browser. 2489 

Note: Clear off the Tomcat work folder contents of public IC Website application 2490 
(%AVAYA_IC73_HOME%\tomcat\work\Catalina\localhost\website\org\apache\jsp\public) and restart the 2491 
website. 2492 

Setting specific browser cookie attributes 2493 

1. The chat_escalate cookie is set to true as part of the escalate.jsp page. 2494 
This cookie is set to false when the customer escalates a successful chat for the first time. 2495 

2. The aicEscStartURL cookie is set to wru.jsp and remains set in the browser page of the customer. 2496 
This URL is the page that the customer sees in the docked window when the chat is escalated. 2497 

3.  (Optional Step): Set the Domain attribute as part of the cookie initialization. 2498 
The OOTB website has the cookie setting code where the Domain attribute must be set and this is 2499 
based on the customer configuration of the chat pages. 2500 

 escalate.jsp. (%AVAYA_IC73_HOME%\comp\website\public folder). 2501 

 htmlchatrcc.jsp (%AVAYA_IC73_HOME%\comp\website\public\htmlclient folder). 2502 

 chathandler.js.jsp (%AVAYA_IC73_HOME%\comp\website\public\htmlclient folder). 2503 

The first two attributes must be set as part of the browser cookie of the customer before the customer can 2504 
escalate a chat.  2505 

Setting specific attributes as part of the Java HttpSession Object  2506 

1. role: Customer for a authenticated customer or guest otherwise. 2507 
2. tenant: The tenant name. 2508 
3. sessionUser: Type com.quintus.usermanager.User, which further sets the attribute role as one of its 2509 

Map parameters. See OOTB account.jsp for more information. 2510 

The first two parameters must be part of the HttpSession Object before a successful chat escalation. 2511 

Changing the Warning text messages of the redirected URL  2512 

This is applicable for chat.htmlclient.redundant.action = redirect case only. 2513 

 On detecting that a duplicate chat is being escalated, for a docked/undocked chat, the customer is 2514 
redirected to an escalate.jsp page where a warning is shown to the customer. 2515 
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This warning message can be customized for each customer upon redirection. Look for “warningText” 2516 
attribute of the escalate.jsp page. 2517 

OOB Chat Behavior for various chat.htmlclient.redundant.action attributes 2518 

The following tables show the OOTB chat behavior for various chat.htmlclient.redundant.action attributes: 2519 

 2520 

2521 

chat.htmlclient. 

redundant.action 

First valid 
chat 
escalation 

Successive chat 
escalation , 
accessing the 
htmlclclient.jsp 
page directly 
[DOCKED/VALID 
USER SESSION] 

Successive chat 
escalation , 
accessing the 
htmlclclient.jsp 
page directly 
[UNDOCKED/VALID 
USER SESSION] 

Successive chat 
escalation , 
accessing the 
htmlclclient.jsp 
page directly 
[DOCKED/INVALID 
USER SESSION] 

none Chat would 
be 
escalated.  

Allow the chat to be 
escalated. 

Allow the chat to be 
escalated. 

The user would be 
redirected to escalate 
and hence 
account.jsp page. 

redirect Chat would 
be 
escalated. 

User would be 
redirected to 
escalate.jsp page. 

The popup 
chatframe.jsp would be 
closed and the user 
would be redirected to 
escalate.jsp page. 

The user would be 
redirected to escalate 
and hence 
account.jsp page. 

alert Chat would 
be 
escalated. 

A popup option 
would be displayed 
asking the user if 
he wants to 
escalate the chat  

OK : Will escalate 
the chat again. 

Cancel : Will 
prevent the chat 
escalation. 

A popup option would 
be displayed asking 
the user if he needs to 
escalate the chat. 

OK : Will escalate the 
chat again. 

Cancel : Will prevent 
the chat escalation. 

If the user clicks the 
Ok button after the 
session expires then 
the chat escalation 
would fail eventually. 

Also accessing the 
htmlclient.jsp page 
directly after the user 
session has expired 
would redirect him to 
escalate and hence 
account.jsp 
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 2522 

chat.htmlclient. 

redundant.action 

Successive chat 
escalation , 
accessing the 
htmlclclient.jsp page 
directly 
[UNDOCKED/INVALID 
USER SESSION] 

Successive chat 
escalation , 
refreshing the 
chatframe.jsp page 
directly 
[UNDOCKED/VALID 
USER SESSION] 

Successive chat 
escalation , 
refreshing the 
chatframe.jsp page 
directly 
[UNDOCKED/INVALID 
USER SESSION] 

none Closing and opening the 
browser by waiting for 
session to expire, the 
user would be redirected 
to escalate and hence 
account.jsp page.  

Allow the chat to be 
escalated. 

Closing and opening the 
browser by waiting for 
session to expire , the 
user would be redirected 
to escalate and hence 
account.jsp page. 

redirect Closing and opening the 
browser by waiting for 
session to expire , the 
user would be redirected 
to escalate and hence 
account.jsp page. 

User would be 
redirected to 
chatsessionexpire.jsp 
page. 

Closing and opening the 
browser by waiting for 
session to expire , the 
user would be redirected 
to escalate and hence 
account.jsp page. 

alert If the user presses the Ok 
button after the session 
expires then the chat 
escalation would fail 
eventually. 

 

Also accessing the 
htmlclient.jsp page 
directly after the user 
session has expired 
would redirect him to 
escalate and hence 
account.jsp 

 

A popup option would 
be displayed asking 
the user if he needs to 
escalate the chat. 

 

OK : Will escalate the 
chat again. 

 

Cancel : Will prevent 
the chat escalation. 

If the user presses the Ok 
button after the session 
expires then the chat 
escalation would fail. 

 

Upon refreshing the 
chatframe.jsp page 
thereafter would redirect 
the user to 
chatsessionexpire.jsp 
page. 

Note: For a CIRS case and when action = redirect, after the htmlclient.jsp is refreshed, the page is redirected 2523 
to a JSP page specified by website.pages.login metadata attribute. This attribute points to account.jsp in 2524 
OOTB website. 2525 

Web Form Design for Collaborative Form Filling 2526 

The Collaborative Form Filling feature enables the customer and the agent to collaborate and fill forms on the 2527 
web pages that are pushed by either the customer or the agent.  2528 
The web page forms for the Collaboration feature must meet the following design guidelines: 2529 

1) HTML <!DOCTYPE> declaration should be present in the HTML document in which the form is 2530 
present.  2531 

2) The form must be inside an HTML body tag.  2532 

3) It is mandatory to have the elements inside an HTML Form tag. 2533 



  

97 

 

4) Every element must have a unique ID except radio button. 2534 

5) In case of a radio button, every sub-element must have unique name. 2535 

Note: These guidelines are not specific to SP 7.3.2 and apply to all version of IC. 2536 

The earlier design guidelines are as follows: 2537 

<!DOCTYPE html>  2538 

<html>  2539 

<head>  2540 

<!--  This is example only. Consult your web designer for designing web page -->  2541 

</head> 2542 

<body>  2543 

<form action="back-end script" method="posting method">  2544 

  <!--   Form must be encapsulated within begin and end of body tag --> 2545 
  <!--   Input elements must be encapsulated within begin and end of form tag --> 2546 
  <!--   Every element must have unique id --> 2547 
  <!--   Radio button sub-element must have unique name --> 2548 

</form>  2549 

</body> 2550 

</html>  2551 

Enabling Refresh AddressBook button for the ASIS server 2552 

When using native Siebel integration, if a new agent is added or an agent is deleted from ICManager, the 2553 
ASIS server is not updated. Because of this, the changed agent information is not available until after restart 2554 
of the ASIS server. To refresh the changed agent information without the ASIS server restart, a new button 2555 
‘Refresh AddressBook’ has been added in the ASIS server configuration.  2556 

From SP 7.3.1 onwards, when using native Siebel integration, if a new agent is added or an agent is deleted 2557 
from ICManager, you can click the ‘Refresh AddressBook’ button in the ASIS server configuration to make the 2558 
changed agent information available. 2559 

To activate the newly added ‘Refresh AddressBook’ button for the ASIS server, import the sc.xml file shipped 2560 
with SP 7.3.1 or later by following the steps mentioned in ‘Importing the sc.xml file’ section in this document. 2561 

Changes to ICM Server and CIRS Log files  2562 

The ICM server log file name has been changed from icmlog.txt to icmserver.log in SP 7.3.1. The name of the 2563 
backup log file created upon rollover of ICM log is changed to icmserver.bak. The CIRS log file name has 2564 
been changed from cirslog.txt to cirslog.log in SP 7.3.1. The name of the backup log file created upon rollover 2565 
of CIRS log has been changed to cirslog.bak. 2566 

The name of the property ‘Maximum Property Management Log Size (KB)’ has been changed to ‘Maximum 2567 
ICM Log size (KB)’ in SP 7.3.1.  2568 

The ‘Maximum ICM Log size (KB)’ parameter defines the maximum size of <globalicmname>_website.log file.  2569 
The ‘Maximum ICM Log size (KB)’ parameter also defines maximum size of the icmserver.log if the value is 2570 
greater than 10240-KB (i.e. 10-MB).  2571 
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The minimum size of icmserver.log is 10240-KB.  If the value of ‘Maximum ICM Log size (KB)’ parameter is 2572 
set to lower than 10240-KB in IC Manager, the ICM server treats the maximum size of icmserver.log as 2573 
10240-KB. 2574 

Perform the following steps to set the maximum log file size for the ICM server, that is, for icmserver.log: 2575 

1) Log in to the IC Manager and go to the Configuration tab. 2576 
2) Select Chat. After the tree expands, select ICM under Chat. 2577 
3) Select New to define a new ICM configuration or select an existing ICM to edit. 2578 
4) Right-click the configuration page and select Show Advanced properties. 2579 
5) Change the value of ‘Maximum ICM Log Size (in KB)’ parameter to desired value greater than 10240. 2580 

 2581 
Note: Ensure that the ICM global name specified here is the same as the dsObjectName of the 2582 
“SystemParms.txt” file. Refer to the IC 7.3 Installation and Configuration guide for more information. If you 2583 
need to specify a different ICM value for the ‘Maximum ICM Log size (KB)’ parameter for different servers, 2584 
then create a separate ICM configuration in IC Manager with unique global name. 2585 

ChannelWeightFactor for Business Advocate 2586 

Introduction 2587 

The Least Occupied Agent (LOA) or Most Idle Agent (MIA) algorithms of IC Business Advocate are enhanced 2588 
to use additional attribute of ChannelWeightFactor. ChannelWeightFactor has been part of IC from IC 7.1 2589 
onwards. ChannelWeightFactor allows assigning a weight factor for each channel, allowing for additional 2590 
channel priority selection. 2591 

As documented in the Administration Guide, you can configure the weight factor for every channel by setting 2592 
the ResourceManager Server configuration attributes: 2593 

1) ChannelWeightFactorVoice – for voice calls. 2594 
2) ChannelWeightFactorChat – for chat contacts. 2595 
3) ChannelWeightFactorEmail – for email contacts. 2596 

Each of these attributes can be set to an integer. When the attribute is not configured, the default value is 1. 2597 

Description of the ChannelWeightFactor 2598 

Resource Manager multiplies the ChannelWeightFactor for each channel by the number of contacts that are 2599 
currently serviced by the agent for that channel. The resulting value is called the Weighted Contact Value of 2600 
the agent. The Weighted Contact Value is calculated for every channel of every agent.  2601 

RM selects the next available agent that has the lowest value of Weighted Contact Value.  2602 

Example: 2603 

Two agents are configured to handle maximum two contacts at a time – with two voice or two chats or one 2604 
voice and one chat at the same time. Both of these agents have the voice and chat channels enabled. 2605 

When ChannelWeightFactor is not specified, the behavior is as follows 2606 

1) Agent1 and Agent2 are available. 2607 
2) A new call arrives and is matched to Agent1. 2608 
3) A new chat arrives and is matched to Agent2. 2609 
4) Another new chat arrives and is matched to Agent1. 2610 

RM using the LOA and MIA algorithms can select agent1 to deliver the second chat. 2611 
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There might be a requirement to send the second chat to Agent2 although this agent may not be the selected 2612 
agent using LOA or MIA algorithm. The reason for this selection is that preference is given to voice channel 2613 
over chat channel. Therefore, one agent handling two chats simultaneously may be preferred over one agent 2614 
handling one voice and one chat at the same time.  2615 

This can be achieved by setting the configuration attributes: 2616 

 ChannelWeightFactorVoice = 2  2617 

 ChannelWeightFactorChat = 1  2618 

With this configuration, the behavior changes as follows: 2619 

1) Agent1 and Agent2 are available. 2620 
2) A new call arrives and is matched to Agent1. 2621 

Weighted Contact Value = ChannelWeightFactorVoice * Number of voice calls currently serviced by 2622 
the agent.  2623 
Therefore, Weighted Contact Value for Agent1 = 2 * 1 = 2. 2624 

3) A new chat arrives and matches to Agent2. 2625 
Weighted Contact Value = ChannelWeightFactorChat * Number of chat contacts currently serviced by 2626 
the agent  2627 
Therefore, Weighted Contact Value for Agent2 = 1 * 1 = 1. 2628 

4) A new chat arrives. This chat matches with Agent1 or Agent2 as both are enabled for the chat 2629 
channel. 2630 
However, Weighted Contact Value for Agent2  is lesser than Weighted Contact Value for Agent1 2631 
Hence, the chat is delivered to Agent2. 2632 

Logging for Business Advocate Agent Watcher 2633 

Logging support is added for Business Advocate Agent Watcher from SP 7.3.1 onwards. Agent Watcher 2634 
creates a log file in <AVAYA_IC73_HOME>\logs folder with the name AgentWatcher.log.  2635 
The AdvocateSetup.log file is used to capture the log messages from the Business Advocate Config Tool. 2636 
The following configuration parameter is applicable to the AdvocateSetup.log file as well. 2637 

To configure the log file size, add the following section in the mosaix.ini file located in the nethome folder: 2638 

[Debug] 2639 
LogFileSize=10 2640 

When this parameter is not configured, the default log file size is 10-MB. One backup file is created when the 2641 

log file rolls over. 2642 

Using Lower case for Agent ID in custom SDK clients 2643 

From SP 7.3.1 onwards, the SDK server does not convert the Agent ID from the incoming login request to 2644 
lowercase as it results into unexpected behavior subsequently. The SDK now passes the login request for 2645 
authentication as it receives. The SDK sample clients have been changed to convert the Agent ID from the 2646 
login request into lower case before sending to SDK Server for authentication.  2647 
The custom SDK clients must have logic to convert the Agent ID to lower case before sending the login 2648 
request to the SDK server. 2649 

Escaping Account creation / modification page of Admin 2650 

website from SQL Injection Filter 2651 

Note: These changes are not applicable to IC 7.3.2 SP and onwards. 2652 

 2653 

javascript:openFileVersion(7360,'O',498,0)
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This configuration is required if: 2654 

 you use the IC database to store information about registered chat customers. 2655 

 you use the Create Account webpage of the Admin Website.  2656 

Perform these steps on the IC server where the website is deployed. The following procedure is for the 2657 
Windows platform. The steps are the same for Solaris and AIX platforms except for the file and directory 2658 
naming conventions and difference of method of starting and stopping the Tomcat web server. 2659 

1. Stop the IC Website. Refer to the IC Install and Configuration guide for the platform specific start and 2660 
stop procedure. 2661 

2. Go to the %AVAYA_IC_HOME%\IC73\comp\website\WEB-INF location. Backup the web.xml file. 2662 
3. Open the web.xml file using a Text Editor. 2663 
4. Locate the filter by name, sqlAttackFilter, shown as <display-name>sqlAttackFilter</display-name>.  2664 
5. Within the same filter definition section, locate the element: <param- 2665 

name>sqliByPassURLPattern</paramname>.  In the parameter value, append aictuthaction=create 2666 
and aicauthaction=edit to ByPass list as illustrated below:   2667 

a. Old Value: <param-value>category=account,category=escalate,category=website</param- 2668 
value> 2669 

b. New Value: 2670 
<paramvalue>category=account,category=escalate,category=website,aicauthaction=create, 2671 
aicauthaction=edit</param-value>. The values must be in all lower case. 2672 

6. Change the parameter value irrespective of whether SqlAttackFilter is enabled or disabled. 2673 
7. Save and close this file. 2674 
8. Start the IC Website. Refer to the IC Install and Configuration guide for the platform specific start and 2675 

stop procedure. 2676 

TwoStep Blind Transfer 2677 

Agent does a twostep blind transfer to an unmonitored VDN and the transfer does not get completed. Where 2678 
the hold response is delayed and TS sends a TS.Transferinit response, before processing the hold event from 2679 
CM fully. Hence, the call state is not yet updated fully in TS. In that time, the client sends a 2680 
TS.TransferComplete request; TS seeing that primary call is not yet on hold, does not act on the 2681 
Transfercomplete request and does not send the call merge request to CM. This leads to failure of blind 2682 
transfer. 2683 

For Rich Client: 2684 

To fix this, the new parameter “TCDelay” is added in vtel.ini for Avaya Agent Rich Client. 2685 

TCDelay 0 #By default set it to 0  2686 

For AAWC/SDK: 2687 

Steps to Configure TCDelay: 2688 

1. Login to ICManager 2689 
2. Open the Group Manager window. 2690 
3. In IC Properties, navigate to Agent\Desktop\WebClient. 2691 
4. Provide appropriate value for TCDelay (default value is 0).  2692 

Note: The TCDelay property is used for TransferCancel delay as well. For more information, see IC 2693 
Administration guide. 2694 
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The ResetScriptIteration setting for WACD 2695 

With this feature, when the WACD server is restarted, WACD will maintain the same priority and same 2696 
workgroup for email contacts that it had prior to the restart, rather than resetting the priority of tasks. 2697 

However, enabling of this new behavior depends on the parameter ‘ResetScriptIteration’ and pushing the new 2698 
script to the database. 2699 

Note: The parameter “ResetScriptIteration” is applicable only for the email contacts. If email channel is not 2700 
being used, then the following configurations can be skipped. 2701 

The following steps must be performed, only if the new behavior is required. Otherwise, skip steps 1 to 6. 2702 

Configuration steps to be performed after installing IC 7.3.1 SP: 2703 

5. If the new behavior of WACD server is required, perform the following steps for all WACD servers: 2704 

 Login to ICManager 2705 

6. Go to the ‘Server’ tab and double click on a WACD server to edit its configuration. 2706 

7. Go to the configuration tab and add a new configuration parameter 2707 

 Name: ResetScriptIteration 2708 

 Value: 0 2709 

8. Click OK to save the WACD configuration 2710 

9. Gathering database information. 2711 

 Log in to ICManager. 2712 

 Open Tools menu and click on "IC Data Sources...". 2713 

 Once "IC Data Sources..." dialog opens expand "interaction_center". 2714 

 Click on ccqDBConnection. 2715 

 Note down Database Name and Database Server Values. 2716 

10. Update the w_script_details table 2717 

 If the CCQ DB is of type SQL Server or DB2, execute the SQLDB2 Script given below 2718 

11. If the CCQ DB is of type Oracle execute the ORACLEDB script given below 2719 

12. After executing the query, from ICManager restart the WACD server. 2720 

If the parameter is set to 1, WACD will behave as it used to, before the fix i.e. queue scripts will start from 2721 
iteration zero. Priorities of tasks will be reset. 2722 

If the parameter is set to 0, WACD will recreate tasks at the same priority and workgroup that it had prior 2723 

 to the restart provided the new script is uploaded by following steps 1 to 6. Priorities will be maintained 2724 
as prior to restart. 2725 

13. By default, the WACD server considers the value of ‘ResetScriptIteration’ parameter to be 0 unless the 2726 
value is explicitly set to 1 in the WACD configuration in IC Manager. 2727 

Note: Copy the text of the following script into a Rich Text Editor like MS Word to preserve the formatting. 2728 
Copying the text directly into SQL Query Admin tool may lead to functional issues if the content gets 2729 
modified including extra space or removal of space unintentionally. 2730 

SQLDB2 Script 2731 
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update w_scripts_detail set script_text =''' This is the default script 

'' 

'' It looks for the following key-values 

'' 

'' Expectedqueuetime 

'' - If present, it will display the expected 

'' hold time 

'' 

'' Workgroup 

'' - The value should be a Workgroup to enqueue 

'' to 

'' 

'' Agent 

'' - The value should be an agent name to 

'' enqueue to 

'' 

'' Priority 

'' - The priority of an enqueue (team or 

'' agent) 

'' 

'' Say 

'' - A string message to say to the customer 

'' 

'' PushURL 

'' - A URL to push to the customer 

'' 

'' Wait 

'' - A value (in secs) to wait before 

'' processing the next set of keys 

'' 

'' If Expectedqueuetime is defined, get 

'' the expected hold time 

if acd.GetValue("Expectedqueuetime") <> "0" then 

acd.sv("time", ACD.ExpectedQueueTime(10)) 
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if acd.gv("time") = 0 then 

say("An agent will be with you shortly.") 

endif 

if acd.gv("time") <> -1 then 

say("Your approximate wait time is " & acd.gv("time") & " minutes.") 

endif 

endif 

'' First check if pacAgentName is provided. If so, this will be 

'' used first, and the main loop only entered if the requested 

'' agent does not become available within 30 seconds 

if acd.GetValue("pacAgentName") <> "0" then 

acd.GetAgent(acd.GetValue("pacAgentName")).Enqueue() 

Say("Agent " & acd.GetValue("pacAgentName") & " will be with you shortly.") 

Sleep(30) 

endif 

acd.sv("exit", 0) 

'' 

'' Start the loop 

'' 

while (acd.gv("exit") = 0) 

acd.sv("exit", 1) 

'' 

'' Check to see if a team is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Workgroup" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(high) 
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endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetTeam(Cstr(acd.getvalue("Workgroup" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' Check to see if an agent is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Agent" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetAgent(Cstr(acd.getvalue("Agent" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' check for a say value 

'' 
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if acd.GetValue("Say" & acd.gv("cnt")) <> "0" then 

say(acd.getvalue("Say" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a push url value 

'' 

if acd.GetValue("PushURL" & acd.gv("cnt")) <> "0" then 

pushurl(acd.getvalue("PushURL" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a wait value 

'' 

if acd.GetValue("Wait" & acd.gv("cnt")) <> "0" then 

acd.setvalue("sleep", acd.getvalue("Wait" & acd.gv("cnt"))) 

sleep(Int(CDbl(acd.getvalue("sleep")))) 

acd.sv("exit",0) 

endif 

'' 

'' If this was the 1st time through and 

'' no values were set, then we need to do 

'' a normal routing. 

'' 

'' 

if acd.gv("exit") = 1 AND acd.gv("cnt") = 0 then 

say("Please wait for the next available eContact agent.") 

while(true) 

''ACD.GetTeam("Default").Enqueue() 

Sleep(30) 

Say("Please continue to wait...") 

wend 

endif 

'' 

'' 
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'' If any values were set for this count 

'' then up the counter and continue, 

'' otherwise, set the counter back to zero 

'' and start over. 

'' 

if acd.gv("exit") = 0 then 

acd.sv("cnt", acd.gv("cnt") + 1 ) 

else 

acd.sv("cnt", 0) 

endif 

acd.sv("exit", 0) 

wend' 

where script_name='DefaultQueueScript'; 

ORACLEDB Script 2732 

set scan off; 

declare sScriptVar varchar2(32767) := ''' This is the default script 

'' 

'' It looks for the following key-values 

'' 

'' Expectedqueuetime 

'' - If present, it will display the expected 

'' hold time 

'' 

'' Workgroup 

'' - The value should be a Workgroup to enqueue 

'' to 

'' 

'' Agent 

'' - The value should be an agent name to 

'' enqueue to 

'' 

'' Priority 

'' - The priority of an enqueue (team or 

'' agent) 
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'' 

'' Say 

'' - A string message to say to the customer 

'' 

'' PushURL 

'' - A URL to push to the customer 

'' 

'' Wait 

'' - A value (in secs) to wait before 

'' processing the next set of keys 

'' 

'' If Expectedqueuetime is defined, get 

'' the expected hold time 

if acd.GetValue("Expectedqueuetime") <> "0" then 

acd.sv("time", ACD.ExpectedQueueTime(10)) 

if acd.gv("time") = 0 then 

say("An agent will be with you shortly.") 

endif 

if acd.gv("time") <> -1 then 

say("Your approximate wait time is " & acd.gv("time") & " minutes.") 

endif 

endif 

'' First check if pacAgentName is provided. If so, this will be 

'' used first, and the main loop only entered if the requested 

'' agent does not become available within 30 seconds 

if acd.GetValue("pacAgentName") <> "0" then 

acd.GetAgent(acd.GetValue("pacAgentName")).Enqueue() 

Say("Agent " & acd.GetValue("pacAgentName") & " will be with you shortly.") 

Sleep(30) 

endif 

acd.sv("exit", 0) 

'' 

'' Start the loop 

'' 

while (acd.gv("exit") = 0) 
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acd.sv("exit", 1) 

'' 

'' Check to see if a team is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Workgroup" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetTeam(Cstr(acd.getvalue("Workgroup" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' Check to see if an agent is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Agent" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(normal) 
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endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetAgent(Cstr(acd.getvalue("Agent" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' check for a say value 

'' 

if acd.GetValue("Say" & acd.gv("cnt")) <> "0" then 

say(acd.getvalue("Say" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a push url value 

'' 

if acd.GetValue("PushURL" & acd.gv("cnt")) <> "0" then 

pushurl(acd.getvalue("PushURL" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a wait value 

'' 

if acd.GetValue("Wait" & acd.gv("cnt")) <> "0" then 

acd.setvalue("sleep", acd.getvalue("Wait" & acd.gv("cnt"))) 

sleep(Int(CDbl(acd.getvalue("sleep")))) 

acd.sv("exit",0) 

endif 

'' 
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'' If this was the 1st time through and 

'' no values were set, then we need to do 

'' a normal routing. 

'' 

'' 

if acd.gv("exit") = 1 AND acd.gv("cnt") = 0 then 

say("Please wait for the next available eContact agent.") 

while(true) 

''ACD.GetTeam("Default").Enqueue() 

Sleep(30) 

Say("Please continue to wait...") 

wend 

endif 

'' 

'' 

'' If any values were set for this count 

'' then up the counter and continue, 

'' otherwise, set the counter back to zero 

'' and start over. 

'' 

if acd.gv("exit") = 0 then 

acd.sv("cnt", acd.gv("cnt") + 1 ) 

else 

acd.sv("cnt", 0) 

endif 

acd.sv("exit", 0) 

wend'; 

begin 

update qw_text set text=sScriptVar where qwkey=1; 

end; 

 2733 

 2734 
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Uninstall program  2735 

The Avaya IC 7.3.2 installation program installs an uninstall program that can uninstall the files from the IC 2736 
7.3.2 installation and returns your system to its previous state. If the installation fails, you must run the 2737 
uninstall program before attempting to rerun the Installation program. Running the uninstall program 2738 
preserves the files.  2739 

When the FP installer fails to complete the installation, any one of the following events might occur based on 2740 
the progress achieved during installation:  2741 

 The uninstaller is created: 2742 

You need to run the uninstaller to remove the FP to restore the system to its original state.  2743 

 The uninstaller is not created: 2744 

When the uninstaller is not created, it implies that the FP installer has already rolled back all the changes 2745 
made to the system during installation. In this case, no action is required from the user.  2746 

Before running the Uninstall program 2747 

Before uninstalling IC 7.3.2 FP, ensure that no instance of IC Java or Tomcat is running. 2748 

1. For uninstalling servers, stop all of the servers using the procedures described in Stop IC services 2749 
and Stop IC servers.  2750 

2. Exit the Agent and IC Manager applications on the system.  2751 

Note: On the AIX platform, you must end the processes that use the Rogue Wave binary files installed on 2752 
the system.  2753 

Perform the following steps before uninstalling the AIX platform:  2754 

 Change directory to $AVAYA_IC73_HOME/lib.  2755 

 At the command line, type the following command: slibclean  2756 

 At the command line, type the following command:  2757 

 fuser -k lib*12d*.a  2758 

 fuser -k lib*.so 2759 

 After running the fuser -k lib*12d*.a and fuser –k lib*.so commands, type the following at the 2760 
command line:  2761 

 fuser lib*12d*.a  2762 

 fuser lib*.so 2763 

No process IDs must be displayed in the results after running this command. However, even if one 2764 
process ID is displayed in the results, you must to restart the AIX machine.  2765 

Uninstalling IC 7.3.2 2766 

Perform the following steps on a system from where you want to uninstall IC 7.3.2 files: 2767 

1. Navigate to the following directory:  2768 
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Windows: ...\IC73\ICServicePacks\7.3.2\<FolderNameOfComponent>\Record\  2769 

Solaris and AIX: .../IC73/ICServicePacks/7.3.2/<FolderNameOfComponent>/Record/  2770 

1. Start the Uninstall program: 2771 

Windows 2772 

 Double-click the uninstall7.3.2.bat file. 2773 

Solaris and AIX (server only) 2774 

1. At the command prompt, type: ./uninstall7.3.2.sh. 2775 

2. Press Enter. 2776 

3. On the Welcome screen, click Next. 2777 

4. The next screen indicates the directory from which the files are uninstalled.  2778 

5. Click Next to start the Uninstall program which:  2779 

Restores the component to its previous state and displays confirmation of a successful uninstallation with 2780 
a list of uninstallation warnings and errors that were encountered. 2781 

6. Click Finish if the uninstallation is successful. 2782 

On the Windows platform, restart the machine for the system to be restored to its previous state. Solaris and 2783 
AIX systems do not require restarting the machine.  2784 

Note: After the un-installation is complete, sometimes the uninstall program does not delete the 7.3.x, where 2785 
x is the SP number for which the uninstall program is executed. In such a case, you need to manually delete 2786 
the 7.3.x subfolder from the .../IC73/ICServicePacks folder. 2787 

Un-Installation using the Silent command line 2788 

option  2789 

The IC 7.3.2 Service Pack components can be uninstalled using the Silent command line option. When you 2790 
run un-installation in silent mode, the user interface is not available. 2791 

Silent mode  2792 

In a silent mode, rerun the same uninstallation in silent mode on another machine using the inputs from this 2793 
text file. 2794 

To re-run the uninstaller in silent mode: 2795 

1. From the command prompt, go to the following directory: 2796 

Windows:  2797 

...\IC73\ICServicePacks\7.3.2\<FolderNameOfComponent>\Record where <FolderNameOfComponent> 2798 
is the folder name of each component where the respective component files reside. 2799 

Solaris and AIX: 2800 
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.../IC73/ICServicePacks/7.3.2/<FolderNameOfComponent>/Record where <FolderNameOfComponent> 2801 
is the folder name of each component where the respective component files reside. 2802 

2. At the command prompt, type the following command: 2803 

<uninstallscriptname> -silent 2804 

Note: The <uninstallscriptname> is the uninstaller script. For example, 2805 

For example: 2806 

Operating System Command 

Windows uninstall7.3.2.bat -silent 

Solaris and AIX ./uninstall7.3.2.sh –silent 

3. Press Enter. 2807 

Note: After the un-installation is complete, sometimes the uninstall program does not delete the 7.3.x (where 2808 
x is SP number for which uninstall program is executed.For example, 7.3.2 for SP 2) subfolder or some of the 2809 
sub-folders in it. In such a case, you need to manually delete the 7.3.x subfolder from the 2810 
.../IC73/ICServicePacks folder. 2811 
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Updating IC help 2812 

The IC help in HTML format is integrated with the IC application. When you install IC on a system, the 2813 
installer updates the help files only for Avaya Agent and Avaya Agent Web Client components.  For other IC 2814 

components, the installer provides the help.zip file containing the required HTML help files. You need to 2815 

manually extract these help files on the respective IC systems.  2816 

Note: In addition to the help.zip file available in the IC installer package, you can also download the latest 2817 

help.zip file from the Avaya support site at http://support.avaya.com.  The help.zip file on the Avaya 2818 

support site will be regularly updated for any major changes in the help. For more information about updating 2819 
the help by downloading the help.zip, see Updating the IC help by downloading the help.zip from the Avaya 2820 
support site. 2821 

This section provides the procedures to update the help files for various IC components installed on Windows, 2822 
Solaris, and AIX platforms. 2823 

The help.zip file contains the help files for the following IC components: 2824 

 Business Advocate 2825 

 Template Manager (RL Manager) 2826 

 Webservice 2827 

 Config Accelerator (CA) 2828 

 Database Designer 2829 

 IC Manager 2830 

 Report Wizard 2831 

 Workflow Designer 2832 

On the Solaris, and AIX system you need to update the help files for the following IC components: 2833 

 Template Manager (RL Manager) 2834 

Note: For all the above mentioned components, you must update the help files at the location where you 2835 
installed these components. 2836 

In the IC installer you can find the following packages that contain the changed help.zip files. 2837 

 IC732WinServer.zip 2838 

This package contains the changed help files for the following IC server components: 2839 

 Business advocate 2840 

 Templatemanager 2841 

 Webservices 2842 

 IC732WinAdmin.zip 2843 

This package contains the changed help files for IC Admin components:  2844 

 Config accelerator (CA) 2845 

 Database designer 2846 

 IC Manager 2847 

http://support.avaya.com/
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 Report Wizard 2848 

 Workflowdesigner 2849 

 IC732SolServer.zip 2850 

This package contains the changed help files for the following IC server components: 2851 

 Templatemanager 2852 

 webservices.html 2853 

 IC732AixServer.zip 2854 

This package contains the changed help files for the following IC server components: 2855 

 Templatemanager 2856 

 webservices.html 2857 

Updating help for IC Admin components 2858 

Installed on Windows platform: 2859 

1. On the system where you installed IC Admin components, go to the IC_INSTALL_HOME\IC73\help 2860 

directory. 2861 

2. (Optional) Backup all the files and folders from the help directory. 2862 

3. (Optional) From the IC installer, extract the IC732WinAdmin package. 2863 

4. From the extracted IC732Admin folder, open the help.zip file. 2864 

5. From the help.zip file, extract the help folder to the IC_INSTALL_HOME\IC73\ directory on the 2865 

system where you installed the IC Admin components. 2866 

Updating help for IC server components 2867 

Installed on Windows platform: 2868 

1. On the system where you installed IC server components, go to the IC_INSTALL_HOME\IC73\help 2869 

directory. 2870 

2. (Optional) Backup all the files and folders from the help directory. 2871 

3. (Optional) From the IC installer, extract the IC732WinServer package. 2872 

4. From the extracted IC732WinServer folder, open the help.zip file. 2873 

5. From the help.zip file, extract help folder to the IC_INSTALL_HOME\IC73\ directory. 2874 

Installed on Solaris platform: 2875 

1. On the Solaris server where you installed IC server components, go to the 2876 

IC_INSTALL_HOME\IC73\help directory. 2877 
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2. (Optional) Backup all the files and folders from the help directory. 2878 

3. (Optional) From the IC installer, extract the IC732SolServer package. 2879 

4. From the extracted IC732SolServer folder, open the help.zip file. 2880 

5. In the help.zip file, open the help folder. 2881 

6. From the help folder, extract the templatemgrhelp folder and the webservices.html file to the 2882 

IC_INSTALL_HOME\IC73\help directory. 2883 

Installed on AIX platform: 2884 

1. On the AIX server where you installed IC server components, go to the IC_INSTALL_HOME\IC73\help 2885 

directory. 2886 

2. (Optional) Backup all the files and folders from the help directory. 2887 

3. (Optional) From the IC installer, extract the IC732AIXServer package. 2888 

4. From the extracted IC732AIXServer folder, open the help.zip file. 2889 

5. In the help.zip file, open the help folder. 2890 

6. From the help folder, extract the templatemgrhelp folder and the webservices.html file to the 2891 

IC_INSTALL_HOME\IC73\help directory. 2892 

Updating the IC help by downloading the help.zip 2893 

from the Avaya support site 2894 

1. Download the help.zip file from the Avaya support site: http://support.avaya.com. 2895 

2. Extract the help.zip file as explained in the following table: 2896 

Components Operating 

System 

Location where to update the 

help 

Files and Folders that needs to 

be updated 

Admin Windows IC_INSTALL_HOME\IC73\help CA 

Database designer 

IC Manager 

Report Wizard 

Workflowdesigner 

Server Windows IC_INSTALL_HOME\IC73\help Business advocate 

Templatemanager 

Webservices 

Solaris IC_INSTALL_HOME\IC73\help Templatemanager 

webservices.html 

http://support.avaya.com/
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AIX IC_INSTALL_HOME\IC73\help Templatemanager 

webservices.html 
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Technical Support 2897 

If you experience trouble with IC 7.3.2, you must: 2898 

1. Retry the action. Carefully follow the instructions in written or online documentation. 2899 

2. Check the documentation that was provided with your hardware for maintenance or hardware-related 2900 
problems. 2901 

3. Note the sequence of events that led to the problem and the exact messages displayed. Have the 2902 
Avaya documentation available. 2903 

4. If you continue to experience problem, contact Avaya Technical Support by one of the following 2904 
ways:: 2905 

 Logging in to the Avaya Technical Support Web site http://support.avaya.com/.  2906 

 Calling or faxing Avaya Technical Support at one of the telephone numbers in the Avaya Support 2907 
Dashboard listings on the Avaya support Web site. 2908 

You might be asked to email one or more files to Technical Support for analysis of your application and its 2909 
environment. 2910 

Note: If you have difficulty reaching Avaya Technical Support through the above URL or email address, visit 2911 
the http://www.avaya.com for further information. 2912 

Avaya Global Services Escalation Management provides the means to escalate urgent service issues. For 2913 
more information, see the Escalation Contacts listings on the Avaya Web site. 2914 

For information about patches and product updates, see the Avaya Technical Support Web site 2915 
http://support.avaya.com/. 2916 

http://support.avaya.com/
https://support.avaya.com/support/dashboard.action
https://support.avaya.com/support/dashboard.action
http://www.avaya.com/
https://support.avaya.com/public/index?page=content&id=PRCS100006
http://support.avaya.com/
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Feature Pack files list  2917 

For information on the time stamp and version number of various service pack files for Avaya 2918 
Interaction Center 7.3.x, see the Service Pack file list with modification time stamp and version 2919 
numbers for Avaya Interaction Center 7.3.x document on the Avaya Support site: 2920 

http://support.avaya.com/. 2921 

http://support.avaya.com/
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Customer found defects, known issues and 2922 

workarounds, troubleshooting, and 2923 

improvements 2924 

For information on issues and improvements included in Avaya Interaction Center 7.3.2 release, see 2925 
the List of Fixed Issues, Improvements, Known Issues and Workarounds, and Troubleshooting for 2926 

Avaya Interaction Center 7.3.2 document on the Avaya Support site: http://support.avaya.com/ 2927 

 2928 

http://support.avaya.com/
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Avaya Technical Support contact information 2929 

You can contact Avaya Interaction Center Technical Support through Internet, e-mail, or telephone. To 2930 
contact Avaya Interaction Center support by telephone, call at one of the following numbers: 2931 

 Global Support Services (GSS) +1 800 242 2121 2932 

 Canada Customer Care Center +1 800 387 4268 2933 

 Remote Service Center Hungary +36 1238 8807 2934 

 Caribbean and Latin America +1 786 331 0860 2935 

 EMEA Services - Post Sales Technical Support +31 70 414 8720 2936 

 Asia/Pacific Regional Support Center +800 2 28292 78 / +65 6872 5141 and 2937 

 +0080066501243 (India) 2938 

For details on contact information, visit http://support.avaya.com/ 2939 

  2940 

http://support.avaya.com/

